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Notes and cautions

The following notes and cautions apply to Elixir
AppBuilder for AFP version 4.00.

Using AppBuilder with Elixir Desktop and Converters for AFP
The following changes affect the noted AppBuilder
versions.
AppBuilder version 3.11
Due to a database structure change, versions of
AppBuilder prior to 3.11 are no longer supported in the
Elixir Desktop.
If you are using an older AppBuilder version, you must
start the product from the Program Manager icon or
Windows 95 shortcut and perform conversions to and
from Elixir format from there.
AppBuilder version 3.20
Beginning with the 3.20 release, AppBuilder and the
Elixir Desktop share the same formdef/pagedef design database, so you must install the same version of
each product. The database format differs from that
of previous releases. Using a pre-3.20 AppBuilder
version with a 3.20 Desktop version changes the database format such that your pagedefs/formdefs are no
longer accessible in AppBuilder.
AppBuilder version 4.00
The version 4.00 design database differs from the version 3.20 database. When you launch AppBuilder

4.00 for the first time the following message may
display:
"Design Database Backed up! New version requires update of database format. Do you want
to convert existing designs into new database?"
Click on <Yes> to back up your existing AppBuilder
jobs
database
in
the
\ELIXIR\JOBS\ELIXIR\D9601SAV directory.
All of
your pagedefs/formdefs are loaded into the new database for use and the back-up directory remains until
you delete it.
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1.

Introduction

This chapter provides an introduction to the Elixir
AppBuilder, describes the contents of this user guide
and explains the installation process, as well as how
to start and exit AppBuilder.
This version of AppBuilder incorporates Elixir's ElixirForm for AFP and provides form editing and application building capabilities. Both ElixirForm for AFP and
AppBuilder functionality are covered in this manual.

AppBuilder overview
In this guide, a job is defined as a print operation that
merges variable data from a host data file with fixed
resources (such as overlays and page segments) to
produce a print run.
One of the most common methods of producing a
print job is to use AFP printers running the Print Services Facility (PSF) subsystem. With this configuration,
you can specify a print job as follows:
Use the Page Printer Formatting Aid (PPFA) language to create source form definitions
(FORMDEFs) that specify how to control the
physical sheets of paper.
Use PPFA to create source page definitions
(PAGEDEFs) that specify the printing characteristics (such as print direction or line spacing) in the
print area of a sheet.
Compile the above on a host computer to create
FORMDEF and PAGEDEF object files.
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Run the print job, in which you specify the data
file you want printed, and the resources required
for the print job (such as fonts, page segments, or
overlays).
Typically, generating source PAGEDEF and
FORMDEF statements is a task performed by skilled
data processing personnel or systems programmers.
This procedure is costly and time consuming
because:
detailed knowledge of print data streams and
PPFA is required
a trial and error method is normally used to calculate data positions on forms to be printed
generating or modifying host-resident fonts, overlays, and page segments requires complex
procedures.
With AppBuilder, instead of manually creating
PAGEDEFs and FORMDEFs, you can define a job
that includes all formatting and data extraction information (required for printing in an AFP environment)
on your PC screen using simple point-and-click
mouse operations in a WYSIWYG environment.
After you define a job, AppBuilder automates the generation of PAGEDEF and FORMDEF PPFA for use on
a variety of printing and PSF host environments.
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Customer support
If you have purchased your Elixir product directly from
Elixir Technologies then contact the support center for
your region at the number listed below.
North and South America:
+1 805 641 5900 ext. 3
Asia Pacific
+92 (0) 51 206182
Europe
+420 2 2431 13877
The U.S.A. Elixir Customer Support Center provides
telephone technical assistance for Elixir users Monday
through Friday from 6:30 a.m. to 5:00 p.m. Pacific
Standard Time.
If you have any problems running or using Elixir PrintDriver or associated Elixir applications, contact the
support center in your region for help. An Elixir product specialist will answer your call and ask for the following information:
your name, organization, telephone number and
address.
the name and version number of the Elixir
application.
a complete description of the problem, including
any error messages displayed on your monitor or
printed at your printer.
You can contact Elixir support by accessing the Elixir
World Wide Web page (and selecting [Contact Support]) at http://www.elixir.com. Please complete the
question form.
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Elixir Web site support
The Elixir Web site at http://www.elixir.com offers the
following resources:
Raise a question for Elixir Support.
Find answers in the list of Frequently Asked
Questions.
Review the latest Tips and Techniques for increasing productivity using Elixir software.
Download new releases and the latest patches.
View Release Notes for the latest available
features.
Learn in the user newsgroup how others are using Elixir products.
Sign up for an Elixir Learning Program.

Elixir training
Elixir Technologies Corporation offers training for the
full-range of Windows-based products. For more information, contact:
Elixir Learning
(805) 641-5900 ext. 6

Who should use this guide
This guide is intended for users familiar with Windows, ElixirForm for AFP, Elixir Desktop and Converters for AFP, ElixirImage for AFP, AFP page printing
resources, and AFP PPFA source and formats.
Users should also have access to IBM's Page Printer
Formatting Aid/370: User's Guide and Reference.
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Hardware and software requirements
The following section describes hardware and software requirements for running AppBuilder.
Hardware
Recommended PC configuration: Pentium (or
100% compatible), with at least 133 MHz processor
(or the fastest commercially available processor); 32
MB RAM, 500+ MB hard drive, one CD-ROM drive.
Additional requirements:
any monitor with driver software supporting Windows in VGA or SVGA.
any Windows-compatible mouse
Optional requirements
HP LaserJet IV or compatible PCL 4 printer(s)
(HP PCL 4 is the format supported) or PostScript
compatible
Elixir Desktop and Converters for AFP is recommended if you want to convert and then edit
overlays.
Software requirements
Software requirements: Microsoft Windows 95, Windows 98, or Windows NT 4.0 or later.
While we make every effort to ensure the proper operation of our software, some problems cannot be resolved due to differences in the operating systems.

Conventions
Most of the following conventions are the same or
similar to Windows conventions.
ELIXIR APPBUILDER FOR AFP USER GUIDE

1-5

INTRODUCTION

display conventions
typographical conventions
mouse operations
Display conventions
The Elixir Desktop, ElixirForm, ElixirFont and ElixirImage all adhere to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and mouse. See your Windows manual for more information.
Typographical conventions
The following typographical conventions are used
throughout this guide and other Elixir product guides.
Keystrokes are shown enclosed in < > (angle
brackets). For example:
<Enter>
Key combinations are denoted by a plus sign between keys. For example:
<Shift> + <F1> indicates to simultaneously press
the <Shift> and the <F1> keys
Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:
Select [New] from the File menu.
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Commands, options, actions, and parameters
that require description are shown in bold followed on the next line by the description. For example:
Delete
Deletes the selected files.
Steps in a procedure are shown in numbered bold
paragraphs. For example:
1.

At the prompt, enter the file name and
extension.
Comments relating to a step (such as this paragraph) are shown in regular text following the bold
paragraph.
Commands you enter at the DOS prompt are
shown in larger text. Within DOS commands,
variable names and keys you press are shown in
italics. For example:

CD \ELIXIR <Enter>
Mouse operations
You can perform most operations in Elixir applications
by using the mouse. The terminology is similar to
other Windows based applications.
Mouse operations are performed using the left or right
mouse buttons, depending on the specific task.
The following mouse related terms are used in this
guide:
click
to momentarily press and release the left mouse button once. A right mouse button click is specified
where necessary. For example,
Click on the right mouse button to finish entering text.
double-click
to click the left mouse button twice in rapid
succession.
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drag
to click and hold the mouse on an item and move the
item with the mouse.
drag and drop
to drag an item as above, then release the mouse button, once the item is positioned over a the area. If the
selected object is a file and the destination is a directory, the file copies to the directory.
object
a selectable item on the screen.
open
to point and double-click on an icon -- the effect of this
operation depends on the icon.
point
to move the mouse to position the screen pointer on
an area of the screen.
select
to point to an object and click the mouse -- this usually
highlights the object.
<Alt>click
to hold down the <Alt> key while pressing the left
mouse button -- this allows you to select a range of
files in a window.
<Ctrl>click
to hold down the <Ctrl> key while pressing the left
mouse button -- this allows you to select individual
files from a group in a window.
<Shift>click
to hold down the <Shift> key while clicking the mouse
-- this allows you to select more than one object at a
time.
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On-line Help
Elixir software uses the Microsoft Windows Help program to provide on-line Help for all functions.
For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.
The Help files included with your Elixir software include graphics created using screen drivers with large
fonts. If you use a screen driver with small fonts, the
Help file graphics may not display clearly. For optimum graphics display, use a screen driver with large
fonts.
You can display on-line Help in the following ways:
Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.
Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box. When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen. During certain operations a message
about the function you are performing also displays in
the message area. To see these operational messages, disable quick help.
Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays. If no
specific topic is available, the Help table of contents
displays.
Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.
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Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Windows NT, right-click on a dialog box option to display
an associated Help topic.
Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.
Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots". Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).
Move the cursor over a hypergraphic until a hand displays, then click on this hot spot to display a pop-up
topic, or a "jump". To close a pop-up topic, click the
mouse button. To return to the original Help topic
from a jump, click on <Back> in the Help file menu.

Using Online documentation
This section describes how to use PDF online documentation, including navigating through the online
guides and printing the guides. Acrobat Reader is
provided with the online documentation. Information
about using the Acrobat Exchange program is included for users who have licenses for that program.
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Accessing online guides
The PDF online documentation is copied to the
drive:\Elixir\help\pdf directory during the installation of
Elixir Suite for AFP. If you didn't choose to copy the
PDF online documentation during the installation, you
can view a complete list of the files by clicking on the
Windows [Start] button and selecting Programs>Elixir
Applications>Elixir Suite for AFP. Once the application
is launched, click on the Help menu and select Release Notes. Wordpad displays a current list of supporting documents and the directories where they can
be found on CD-ROM.
When the appropriate PDF file is accessed the Acrobat Reader program is launched and the List of Online
Guides is displayed. Click on a guide to view its table
of contents and jump to individual chapters.
The following list of PDF files and associated document names are installed in the drive:\Elixir\help\pdf
directory.
StartAFP.pdf - Getting Started User Guide
DeskAFP.pdf - Elixir Desktop and Converters
for AFP User Guide
FormAFP.pdf - ElixirForm User Guide
FontAFP.pdf - ElixirFont User Guide
ImageAFP.pdf - ElixirImage User Guide
PdAFP.pdf - Elixir PrintDriver for AFP User
Guide
PdNT.pdf - Elixir PrintDriver for NT User
Guide
AppAFP.pdf - Elixir AppBuilder for AFP User
Guide
Transfmr.pdf - Elixir Transformer Suite User
Guide
Viewer.pdf - ElixirViewer User Guide
Elxscan.pdf - ElixiScan User Guide
ELIXIR APPBUILDER FOR AFP USER GUIDE
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Navigating in online guides
After loading a PDF document in Acrobat Reader or
Exchange program (as described above), you can
navigate through the online guide by clicking on the
following:
TOC chapter titles - jumps to the beginning of the
chapter indicated.
[Next Page] or [Previous Page] in the Toolbar - jumps
to the next or previous page of the online guide (alternatively, you can use the <Page Up> and <Page
Down> keys).
[Go Back] in the Toolbar - returns to your previous
location.
[First Page] in the Toolbar - returns to the opening
screen of the online guide.
Word find
This option finds a key word or phrase in the current
document.
To use Word Find in a document:
1.

Click on the [Find] icon in the Toolbar.

2.

Enter the desired search text and click on
[Find].
The Acrobat Find dialog box closes and the first
occurrence of the text is highlighted.

3.

To find more occurrences of the same text,
click on the [Find] icon in the Toolbar and
then click on [Find Again] in the Find dialog
box.

Page scrolling
You can move a document on the screen to view portions of it not visible in the window, or read a document which contains article threads by clicking the
mouse to scroll through the document without using
the scroll bar.
1-12
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To move a document on the screen for viewing (functional only when the document displays wider than the
document window):
1.

Click on the [Hand] icon in the Toolbar.

2.

Hold down the mouse button and drag the
cursor in the desired direction.

To follow the flow of text in a document that contains
article threads (automatic text flows):
1.

Click on the [Hand] icon in the Toolbar.

2.

If the document contains article threads, a
“down” arrow displays on the Hand icon.

3.

Position the hand-shaped cursor over a
paragraph and click on the paragraph to begin
reading.

4.

Continue clicking to follow the flow of text.

Zoom in/out
To magnify the size of the page display, click on the
Zoom icon in the Toolbar, then click in the Work area.
Each click resizes the view by a factor of two.
To reduce the size of the page display, click on the
Zoom icon in the Toolbar, then hold down the <Ctrl>
key and click in the Work area.
You can also click on the [%] button at the bottom of
the screen and select a zoom percentage from the
pop-up list.
Printing online guides
You can print individual chapters or an entire book to
PostScript or HP printers:
1.

Open the file.

2.

Select File>Print.
The Print dialog box displays.
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3.

Select your printing options and click on [OK].

Organization of this guide
This user guide contains the following chapters:
Chapter 1, "Introduction," provides an introduction to
the Elixir AppBuilder, describes the contents of this
user guide and explains the installation process, as
well as how to start and exit AppBuilder.
Chapter 2, "AppBuilder basics," provides overviews of
AFP, AppBuilder and ElixirForm, as well as features
you can access from AppBuilder's main screen. The
basic operations for creating a form are also covered.
Chapter 3, "Toolbar and Toolbox", gives detailed descriptions of the Toolbar and Toolbox.
Chapter 4, "Menu bars", provides information on
AppBuilder's menus and sub-menus, and the options
they contain.
Chapters 5 through 8 "Lines," "Shapes," "Text operations," and "Images," are reference sections that describe in detail how to create and edit form elements.
Chapter 9, "PageDef window", provides a detailed description of the PageDef window and its features.
Chapter 10, "FormDef window", gives a detailed description of the FormDef window and its features.
Chapter 11, "Importing and Exporting", provides information on importing existing PPFA and exporting
PPFA, object PageDefs and FormDefs.

1-14

ELIXIR TECHNOLOGIES CORPORATION

INTRODUCTION

Before installing
Complete the software licensing process (See the
"Product Registration" section).
If you plan to use AppBuilder with any other Elixir
products, make sure you know the drive on which
they are installed. This is the drive where you
must install the AppBuilder program.
To avoid any possible conflicts, exit all other applications while installing the Elixir AppBuilder.
You may want to make a backup copy of your
diskettes prior to installation.
AppBuilder and the Elixir Desktop share the same
PageDef/FormDef design database. PageDef
and FormDef resources are managed within the
Elixir Data Jobs folder in the Jobs folder. The default path for the folder and resources is \ELIXIR\JOBS\ELIXIR directory.

Product Registration
Elixir products no longer require ElixiKey hardware devices attached to your parallel port. Elixir products
now utilize soft key technology. This new licensing
process validates your license agreement with Elixir
and places a file (password.epw if an Elixir customer,
or License.dat if a Xerox customer) on your
workstation.
Version 4.00 implements Elixir's new licensing process and discontinues use of the current hard keys. All
customers must register/re-register software license(s) by using the Elixir registration program provided
with the software.
Each product installed is assigned to a specific pc.
This pc number, your customer number, and password are required. This information is provided when
you purchase Elixir software or when you upgrade to
version 4.00 of Elixir products.
ELIXIR APPBUILDER FOR AFP USER GUIDE
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If you are an Elixir customer, registration can be completed automatically if you have an internet connection
on your workstation. If you are a Xerox customer you
must contact Xerox to register your products.
This section describes the registration process for
those customers who have purchased their Elixir
products form Elixir Technologies.
The following scenarios describe the registration
process for Elixir customers. Xerox Corporation will
provide a separate document that describes registering your products with Xerox.
you are a new customer and will use Soft Key
registration
you are an existing customer and will change to
Soft Key registration
Elixir Product Registration screen
Make your selections according to your needs and go
to the appropriate section for further procedures.

Figure 2-1. Elixir Product Registration screen
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Using the internet
You can register and download all registration files via
the Elixir Product Registration program. There are
two ways to register your products using the Internet:
down load the product registration file directly to
the Elixir PC via the Internet (see "Registering as
a new customer via the internet")
download the product registration file to another
machine and move it to the Elixir PC (see "Downloading via the internet to a non-Elixir PC")
Registering as a new customer via the internet
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.

To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.

2.

Enter your customer number (from Activation
Letter), then click on [Next].
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3.

Enter your password and the PC number you
want to register, then click on [Next].

4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[Yes].
The system displays your customer information
and you must verify that it is correct.

6.

When the screen displays the registration
information, click on [Save]. You may also
print this screen for reference or to send to
Elixir.

The application installation process will begin, see the
"Installation" section.
Downloading via the internet to a non-Elixir PC
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.
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To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.

2.

Enter your customer number (from Activation
Letter), then click on [Next].

3.

Enter your password and the PC number you
want to register, then click on [Next].

4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[No].

6.

In the How to Contact Elixir screen, click on
[Print] and take the printout to the pc
connected to the internet.

7.

Access
the
Elixir
Web
site
at
http:\\www.elixir.com. and click on [Product
Registration].

8.

In the Customer Information screen, enter
your Customer Number and Password, then
click on [Submit Form].

9.

In the Elixir Customer Menu,
[Download a New License File].

click

on

10. In the Customer Information screen, enter
your PC Number and Machine Serial Number,
then click on [Submit Form].
11. In the Elixir Technologies screen, click on
[Click here to download your password].
12. Save the password.epw file to diskette and
copy it to your Elixir PC in the \ELIXIR
directory.
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The application installation process will begin, see the
"Installation" section.
Contacting Elixir (no internet connection)
If you have no internet access at your site you must
contact Elixir and provide the serial number of the pc
where you will install the Elixir software. Elixir will provide a registration file (password.epw) that you must
copy to the Elixir pc.
Copy the password.epw file to \Elixir and start the
installation.
Select [Prepare my initial product license registration.
This workstation is not connected to the Internet] from
the Registration Option menu, then click on [Next].
The application installation process will begin, see the
"Installation" section.
Soft key customers running Windows for Workgroups 3.1 or 3.11
Since Windows 3.1/3.11 does not have internet capability, you must contact Elixir to obtain your password
file. After installation of Elixir software, the installation
program verifies that the operating system is 3.1 or
3.11, runs passwd16.exe, and provides your machine
serial number.
To complete registration:
1.

Enter your customer number, password and
PC number, then print out a copy of this
screen.

2.

Fax, email, or mail Elixir the display printout.
Elixir will generate a password.epw file and
send it to you on diskette.

3.

Load the password.epw file in the \ELIXIR
directory.

The application installation process will begin, see the
"Installation" section.
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Installation
This section describes how to install Elixir software
using the [Full] and [Custom] options. Installing additional Elixir applications to an existing version is also
explained.
Note: The software registration process must be completed (See the "Product Registration" section).
For information about starting Elixir applications after
installation, refer to the "Introduction" chapter.
During installation, the log file, XWIN.log, is created in
the drive:\Elixir directory. XWIN.log contains a list of
all directories and files copied or created, including information pertinent to the installation. It can be accessed, using Notepad or Wordpad.
If you have any problems running Elixir software after
installation, refer to the "Troubleshooting" section of
the Elixir Getting Started Guide for more information.
Installing Elixir applications
Elixir provides a simple, interactive procedure for installing Elixir applications.
During installation you can select [Full] or [Custom]
installation.
Selecting a [Full] installs all Elixir applications and
demonstration files on the same drive. If you
have a previous version of Elixir software, this option overwrites the existing version.
Selecting a [Custom] installation allows you to
choose the Elixir applications and options (such
as Elixir demonstration files) you want installed,
as well as where you want certain options installed. For example, You may want the PDF
documentation in a different directory than the application.
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You can also install Elixir program files (required
to run Elixir), and data files (files that you create
or files such as the Elixir demonstration files), in
separate drives and directories.
Full installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
1.

Close all active applications.

2.

Insert the CD in your CD-ROM drive.

3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.

4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.

5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.
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6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.

7.

Verify your user information and click on
[Next].

8.

In the Select Install Type screen, select [Full]
and click on [Next].

9.

Select the drive on which you want Elixir
software installed, then click on [Next].
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10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].
12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
Custom installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
1.

Close all active applications.

2.

Insert the CD in your CD-ROM drive.

3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.

4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.

5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.

6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.
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7.

Verify your user information and click on
[Next].

8.

In the Select Install Type screen, select
[Custom] and click on [Next].

9.

In the Configuration Only? screen:
Selecting [Yes] allows you to load Configuration, Program, and Data files into any resident directory.
Selecting [No] allows you to deselect options
you do not wish installed.

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].
12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
Adding applications
If you did not install all of the Elixir options while performing the Custom installation procedure, you can do
so at any time by following the steps described in the
"Custom installation" section of this chapter.
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Adding newly licensed applications
If you purchase additional Elixir products, Elixir will
update your password file. You can access the Product Registration program from your program group
and re-download your initial product registration password file to activate your new products.

Starting AppBuilder
Depending on your operating system, you can start
AppBuilder as follows:
In Windows 3.11, in the Elixir Applications program group in Program Manager, double-click on
the Elixir AppBuilder for AFP icon.
In Windows 95 or Windows NT, click on the
[Start] button in the Taskbar and then select the
Elixir AppBuilder for AFP shortcut.
In any operating system, from the Elixir Desktop
(if installed), double-click on the Elixir AppBuilder
for AFP icon, or double-click on an Elixir PageDef
or FormDef resource file in the Jobs folder, Elixir
Data Jobs folder.
The AppBuilder window displays.
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Figure 1-1. AppBuilder window

Exiting AppBuilder
You can exit AppBuilder using any of the following
methods:
Double-click on the Close button at the top left of
any Elixir application.
Press <Alt> + <F4>.
Press <Alt> + <X>.
From the File menu and select [Exit]
Click on the [X] at the top right corner of the application window.
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AppBuilder basics

This chapter provides overviews of AFP and
AppBuilder, as well as features you can access from
AppBuilder's main screen. This chapter also provides
an overview of Elixir's ElixirForm, which is incorporated into this version of AppBuilder, and describes
the basic operations for creating a form.

AFP overview
The Advanced Function Presentation (AFP) print platform consists of data streams for applications, print
resources, and printers. Data streams include:
Intelligent Print Data Stream (IPDS) - the printer
device data stream that allows a two-way dialog
between the printer and the print driver.
Advanced Function Print Data Stream (AFPDS) the device-independent application data stream.
AFPDS is the data stream through which applications
can describe pages composed of text and images.
Structured Records (PAGEDEFS and FORMDEFS)
describe the content, placement, and characteristics
of the objects in the printing process.
Page definitions (PAGEDEFS) specify how you want
data positioned on a logical page. Functions for the
logical page that PAGEDEFS control include dimensions, print directions, conditional processing, line
spacing, and location of individual lines and Fields.
PAGEDEFS also contain commands describing how
variable data is to be extracted from the input data
stream. PAGEDEF specifications are limited to the
layout for one side of a physical page.
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Form definitions (FORMDEFS) specify how the printer
controls the processing of the physical sheets of paper. Examples of FORMDEF attributes are one-sided
(simplex) or two-sided (duplex) printing, paper source
bins, data suppression, and inclusion of overlays.
In a FORMDEF, you can specify modifications that
distinguish formatting one print job from another,
when both are derived from the same data.
FORMDEFS are used for all PSF (Print Services Facility) print files, regardless of data type.
A physical page is the single surface (front or back) of
a form, while a logical page is the area on the surface
of a form that is formatted for printing. A logical page
can also be defined as a collection of data that can be
printed on one side of a sheet of paper.
For more information on AFP systems and terms, see
your IBM reference materials.

AppBuilder overview
Elixir's AppBuilder allows you to easily and quickly define a job that includes all formatting and data extraction information. After job definition, PAGEDEF and
FORMDEF PPFA is generated for use on a variety of
printing and PSF host environments.
AppBuilder provides three modes for laying out a
PageDef and viewing how it interacts with resources
such as forms and FormDefs. AppBuilder automatically switches modes depending on the resources
loaded:
Form building - in this mode a single form is created or edited using ElixirForm functionality within
AppBuilder.
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Template mapping - in this mode only a PageDef
and a form are loaded (no FormDef). PageFormats (logical page) are created or edited individually, and Field and Records are mapped using the
loaded form as a template. In this mode, PageFormats always display with the 0,0 origin in the
top left corner of the Work area. See the
"PageDef window" chapter for more information.
Application proofing - in this mode a representation of the physical sheet is displayed with
PageDef and FormDef formatting applied.
FormDef formatting controls the placement of selected PageFormats, including location and rotation. This mode is automatically activated when a
FormDef is loaded. See the "FormDef window"
chapter for more information.

ElixirForm overview
ElixirForm for AFP is an interactive forms design tool
that allows you to create and edit forms in WYSIWYG
(What You See Is What You Get) mode using an IBM
PC AT, PS/2, or compatible computer, a mouse, a
supported monitor, and an optional proof printer.
A form created with ElixirForm is the static (or boiler
plate) component of a form, and contains elements
such as lines, boxes, text, and images. The static
form is then merged with variable data for printing on
AFP high-speed laser printers.
With ElixirForm, you can see each static form element
as you add or revise the element. With an optional
desktop proof printer, you can generate proofs at your
desk. Using the Converter in the Elixir Desktop, you
can compile your forms on your PC, eliminating the
need for a host compile. See the Elixir Desktop and
Converters for AFP User Guide for more information
on file conversions.
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AppBuilder window
To view the AppBuilder main screen, start the program as described in the "Introductions" chapter or
double-click on the Elixir AppBuilder for AFP icon on
the Elixir Desktop (if installed).
The AppBuilder window displays.
AppBuilder menu bar
(see the "Menu bars" chapter)

Toolbar
(see the "Toolbar and Toolbox" chapter)

Message area

Work area menu bar
(see the "Menu bars" chapter)
Toolbox
(See the "Toolbar and Toolbox" chapter)

Work area

Figure 2-1. AppBuilder window

Creating a form
This section provides information which may be helpful when designing your form. See the "adding form
elements" section for information on form elements.
Designing a new form
Sketching the form on paper before drawing it on the
screen makes placing the elements easier.
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Reproducing an existing form
If you are reproducing an existing form, have the form
in front of you as you are designing it on the screen.
Use a ruler to measure the margins, lines and other
elements of the form, then use the on-screen rulers to
get an exact placement of each element.
You can also use Elixir's ElixirScan product to scan
existing forms for conversion to Elixir format and editing in ElixirForm.
Designing a form to fit in a window envelope
If you are designing a form to fit in a window envelope,
sketch it, fold it and measure it against the envelope
window to ensure proper display.

Loading a form
Only one form can be edited at a time.
Loading a new form <F9 >
To load a new form:
1.

Pull down the File menu, select the Form
sub-menu and select [New Form] or press
<F9>.
The Page Properties dialog box displays. See the
"File menu" section in the "Menu bars" chapter for
more information.

2.

Select the page size, units of measure, color
mode and page offset.

3.

Click on [OK].
The Page Databasing dialog box displays. See
the "Form Databasing" section in the "Menu bars"
chapter for more information.

4.

Enter information for the new form (optional).

ELIXIR APPBUILDER FOR AFP USER GUIDE

2-5

APPBUILDER BASICS

5.

Click on [OK].

Loading a saved form <F8 >
If you are loading a form that was created in a GEM
version of ElixirForm, see "Loading GEM forms" in this
section before loading the form.
To load a previously saved form:
1.

Pull down the File menu, select the Form
sub-menu and select [Load Form] or press
<F8>.

2.

Highlight the name of the form you want to
load.

3.

Click on [OK].

The form is loaded into the Work area.
If the image referenced in a form is missing, a replacement image displays. If you want to delete the
image from the form, select the replacement image
and press <Del>.
Loading GEM forms
If you are using forms that were created in a version
of ElixirForm prior to version 3.00, you can select to
maintain the original boxed text formatting or use the
new Windows method of box text formatting. You can
also select to maintain the original color mode or select a new color mode.
Select the text formatting and color mode options
for all subsequently loaded GEM forms using the
[Text Formatting Compatibility] and [Color Mode]
options in the GEM Forms Load Defaults dialog
box.
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Select the text formatting and color mode options
for the currently loaded GEM form only using the
[Text Formatting Compatibility] option in the Text
and Fonts Options dialog box and the [Color
Mode] option in the Page Properties dialog box.
See the "Menu bars" chapter for more information.
Merging a form group
You can retrieve a form into the current Work area
without replacing the contents of the Work area. You
can thus save portions of a form such as standard
form headers and footers, and use these form pieces
as part of a new form. See the "Grouping elements"
section in this chapter for information about saving a
form group.
To merge a form group:
1.

Pull down the File menu, select the Form
sub-menu and select [Merge Form Group].
The Load Form dialog box displays.

2.

Select the form you want to merge.
Although you can merge the currently loaded
form with the same form, this is not recommended as form elements may overlap.

3.

Click on [OK].

Objects that fit within the form boundaries are the only
ones that can be merged. Since [Merge Form Group]
operations can not be undone, make sure that enough
space is available in the Work area so form elements
do not fall outside the form boundaries or inadvertently
overlap each other.
Loading a form template
A form template is a form that is loaded as an overlay
or visual guide only for the purpose of designing new
form elements around it. A form template does not
become a part of the form when the form is saved;
only the new elements are saved with the form.
ELIXIR APPBUILDER FOR AFP USER GUIDE
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You can load more than one form file template into the
Work area; however, retrieving multiple form templates may use significant memory.
Proof printing a form that includes one or more templates also prints the templates. If you want to proof
print a form without the templates, save and reload
the form without the templates, then proof print the reloaded form.
To load a form template:
1.

Pull down the File menu, select the Form
Group sub-menu and select [Load Form
Template].
The Load Form Template dialog box displays.

2.

Highlight the name of the template you want
to use.

3.

Click on [OK].
You can also double-click on the template name.

4.

Design a new form using the template as a
guide.

Selecting template defaults
To select form template defaults:
1.

Select [Template Options] from the Options
menu.
The Template Options dialog box displays.

2.

Select display defaults, then click on [OK].

The Template Options dialog box contains the following options:
Color
Select a display color for the template from the dropdown list.
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Object Filters
Select an option to display its associated object in the
template, or deselect the option to hide the associated
object.
Disable template object selection
Prevents form template objects from being selected or
modified.
Lock template
Keeps the current template loaded at all times.

Adding form elements
Forms are created using lines, paths, boxes, circles,
text and images - collectively called form elements.
You can easily apply different attributes and properties
to any element by selecting options in the Toolbox.
Elements can be placed anywhere on the form, creating a unique form to fit your needs.
If you need to modify an element that is already on the
form, select the element with the right mouse button
and apply new properties by selecting options in the
Toolbox. See the "Toolbar and Toolbox" chapter for
more information on individual tools and their options.
For detailed information about how to add and modify
an element, see the "Lines", "Shapes", "Text operations" and "Images" chapters.

Using color
Color can be applied to any part of a form. However,
your AFP printer must support color printing to print in
color.
To specify the color mode:
1.

Pull down the Options menu and select [Form
Properties].
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The Form Properties dialog box displays. See
the "File menu" section in the "Menu bars" chapter for more information.
2.

Select [Full Color] and click on [OK].

Saving a form
You may want to periodically save your work as you
are designing a form, and when you finish it. To save
your work automatically, select the [Autosave] option
in the Usage Switches dialog box. See the "Menu
bars" chapter for more information.
To save a form:
1.

Pull down the File menu, select the Form
sub-menu and select [Save Form As] or press
<F7>.
The Save Form As dialog box displays.

2.

Enter a name in the file name box.
not need to type an extension.

You do

If you are saving an existing form under a new
name, backspace over the current file name and
enter the new name. The original file still exists
with the original name.
If you plan to convert your form to other formats
you should save the form with a maximum sixletter file name. Longer file names are truncated
upon conversion and could result in overwriting
existing files.
3.

Click on [OK]

Once you have saved a form, use <Ctrl> + <S> to
quickly save your work.
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Modifying a form
You can update previously-created forms or make a
new one by modifying the form and saving it with a
new name.
Editing elements
You can edit individual elements by moving, copying
or deleting form elements, and by changing element
properties.
To copy, or delete an element, select the
Select/Edit tool, click on the element and then select the [Copy] or [Delete] option in the Toolbox.
To move an element, select the Select/Edit tool
and drag the element to another position.
To change the properties of an element, select
the Select/Edit tool, right click on the element and
then select the applicable option(s) in the
Toolbox.
See the "Lines", "Shapes", "Text operations" and "Images" chapters for more information on editing
elements.
Shifting elements
You can shift all the elements or only selected elements on a form. It is easier to see the elements
shifting when the grid is displayed.
To shift form elements, hold down <Ctrl> and use the
arrow keys to shift elements up, down, left, or right.
You can also use the direction keys (without the
<Ctrl> key) on the numeric keypad if <Num Lock> is
selected.
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If an element or elements are selected, only those elements will shift. To select multiple elements, hold
down the <Shift> key while clicking on the elements.
If an element or elements are excluded, only selected
elements will shift. The Group Filter option allows you
to exclude element types. See the "Toolbar and Toolbox" chapter for more information.
Grouping elements
You can group form elements for editing purposes.
Once a group is defined, you can edit it like a single
form element.
You can undo a group one element at a time. For example, if you delete a group and then click on the
Undo icon, the elements comprising the group redisplay one at a time.
Defining a group
You can define a group by drawing a rectangular outline around the elements you want to group.
To define a group:
1.

Select the Select tool in the Toolbox.

2.

Move the screen pointer near the elements
you want to group.

3.

Click and drag the dotted line that displays
until it encloses all of the elements you want
in the group.
Boxes appear around or inside each element in
the group. Grouped text appears in square
brackets.

4.

Release the mouse button.
You can exclude all occurrences of an element or
any one element from the group:
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To exclude all occurrences of a particular element, select a Group Filter option before
grouping. See the "Toolbar and Toolbox"
chapter for more information on the Group
Filter option.
To exclude any one element from the group,
<Shift>-click on the element after grouping.
To include the element again, <Shift>-click on
the element again.
You can now move, copy or delete the group as if it
were a single element.
If you want to change the properties of the grouped
elements, right-click on an element in the group and
do so using the options in the element Toolbox. The
new property applies to all selected elements in the
group, where applicable.
Saving a form group
You can define a group in an existing form and save it
as a form file. You can then retrieve the file for editing
or use it as a form template.
This feature is useful when standard elements (for example, headers and footers) are used on several
forms. You can also use it to merge parts of one form
with parts of another form. See the "Merging a form
group" section for more information.
To save a form group:
1.

Define the group as described in the above
section.

2.

Pull down the File menu, select the Form
Group sub-menu and select [Save Form
Group].
The Save Form Group dialog box displays.

3.

Enter a file name.

4.

Click on [OK].

ELIXIR APPBUILDER FOR AFP USER GUIDE

2-13

APPBUILDER BASICS

The form group is saved in the specified forms
directory.

Deleting a form
To delete a form:
1.

Pull down the File menu, select the Form
sub-menu and select [Delete Form].
The Delete Form dialog box displays.

2.

Select the name of the form you want to
delete.

3.

Click on [OK]
The form is deleted.

Renaming or moving a form
To rename or move a form:
1.

Pull down the File menu, select the Form
sub-menu and select [Rename/Move form].
The Rename/Move Form dialog box displays.

2.

Select the form you want to rename or move.

3.

Click on [OK]
The Rename/Move Form dialog displays the directory and name of the form.

4.

Enter a new directory to move the file or enter
a new file name to rename the file.
The form must have an .ELX extension if you
want to load it into ElixirForm.

5.
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The file is moved or renamed as specified.

Proof printing a form
To print your file, pull down the File menu, select the
Print sub-menu and select [Using Print Driver]. The
Print dialog box displays.

Figure 2-2. Print dialog box
The Print dialog box contains the following options:
Printer
AppBuilder supports proof printing to HP LaserJet
printers, as well as other printers compatible with the
HP PCL 4 format. AppBuilder also supports Adobe's
PDFWriter printer driver.
PCL 4 printers print a maximum page size of 8 x
10.33-inches. If your page boundaries fill an 8.5 x
11-inch page, the outer margins of your page will not
print on a PCL 4 printer.
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If you have Adobe's PDFWriter printer driver installed
on your PC, you can convert your form to PDF format
by selecting [PDF ON FILE:] from this window. When
you select this option, you are prompted for the directory and file name.
For accurate positioning, shift the print image on the
page using the [Page Shift] option.
Set Elixir HP driver as default printer
Sets the Elixir HP printer driver as your default printer.
See the "Using the Elixir HP print driver" section for
more information.
Orientation
Select the orientation for your page: [Portrait] or
[Landscape].
Page shift
This option shifts your proof printer output horizontally
or vertically by the number of dots specified. [Xshift]
moves your image horizontally and [Yshift] moves
your image vertically.
Use a negative shift value to shift the print output to
the left, or down; and a positive value to shift your
print output right, or up.
For a PCL 4 or compatible printer, the normal or centered image value is [Xshift] = -60.
Copies
Enter the number of copies you want to print.
Print to File
This option allows you to specify the path and file
name in the Print to File dialog box that displays.

Figure 2-3. Print to File dialog box
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Autogen output name
Displays when you select [Print to File]. Automatically
outputs a .PRN file with the same stem name as the
Elixir input file.
Print Fonts as Graphics
Select this option to rasterize fonts as graphics.
Printing fonts as graphics requires less printer memory and can speed up printing time.
Load Fonts
This option may or may not display, depending on
your selected print driver.
Select [Always] to download fonts every time you
print. The downloaded fonts are cleared from the
printer's memory when the printer is turned off.
Select [Once] to download fonts as soft fonts on
the printer. Fonts are identified by an index number, and are managed and accessed through the
[Print Manager] option in Windows.
Select [Never] to use the soft fonts previously
downloaded to your printer. Fonts are referenced
by index numbers and no new fonts are
downloaded.
If you select [Once] or [Never], you should use the
same font list. If you use a different font list, the index
number may represent a different font.
Setup
Allows you to specify (Windows) setup parameters for
your printer.
Printing a disk print file
To print a form that has been written to disk, exit
AppBuilder and display the DOS prompt. Specify the
directory of the print file, and use the DOS COPY
command to copy the .PRN file to your active parallel
port (for example, LPT1).
For example,
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COPY filename.PRN LPT1 <Enter>
where filename is the stem name of the disk file.
Use the COPY/B command when printing HP PCL
files from disk.
Using the Elixir HP print driver
You can use the Elixir HP Driver for optimal proof
printing of Elixir forms. The benefits of using this
driver are:
increased proof-printing speed
ability to print light, medium and dark shaded
boxes using HP printer shading calls
support of storing a form as a macro
ability to call printer resident fonts
produces files requiring substantially less disk
space.
To use the Elixir HP print driver:
1.

Select and drag the file to the Printers icon.
The Print dialog box displays.

2.

Select [Elixir HP Driver] and click on [Setup].
The Elixir HP Driver dialog box displays.
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Figure 2-4. Elixir HP driver dialog box
The Elixir HP Driver dialog box contains the following
options.
Printer Type
Select the type of HP LaserJet printer (II, III, or 4).
Printer Port
Select [LPT1], [LPT2], or [LPT3].
Output Mode
Select [Use PCL commands] or [Use rasterization].
The rasterization option allows you to print some embedded objects (such as circles and paths) that HP
PCL may ignore, or print other objects in their place.
Font Substitution Tables
Select [No] to use printer-resident fonts, or [Selected]
to enable the [Fonts] button and select a font table file
from the Select Font Table dialog box. The font table
name displays in the [Selected Table] option.
User defined shading patterns
Select [No] to use standard shading patterns, or [Selected] to enable the [Shading] button and select a
pattern file from the Select Shading Table dialog box.
The shading table name displays in the [Selected Table] option.
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Inverse Fonts
Select [No] to use standard fonts, or [Selected] to enable the [Inverse] button and select an inverse font table file from the Select Inversion Table dialog box.
The inverse font table name displays in the [Selected
Table] option.
Create as Macro/Macro ID number
Select, then enter a value in [Macro ID number] to
store your form on the printer for future use.
3.

After you select your options, click on [OK].

4.

To print the file, click on [OK] in the Print
dialog box.

Creating PageDefs
Creating a PageDef allows you to map data to a form.
When creating a PageDef, you need to define the
structure of the input data and the page locations for
data placement. You also need to know the layout of
the input data in order to define start and length values for Field mapping.
To create a PageDef:
1.

Open a new or existing form that you want to
use as a template to map data to.
See the "Creating a form" and "Loading a form"
sections for more information.

2.

Pull down the File menu, select the PageDef
sub-menu and select [New PageDef].
The PageDef Properties dialog box displays. See
the "Menu bars" chapter for more information.

3.

Set PageDef options and click on [OK].
The options set are used as default values when
you create new PageFormats.
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4.

Pull down the Options menu and select
[AppBuilder Preferences].
The Preferences dialog box displays. See the
"Menu bars" chapter for more information.

5.

Select PageDef display options and click on
[OK].

6.

Add objects to the PageDef tree.
See the "PageDef window" chapter for more
information.

7.

Map the objects to the PageDef.
See the "PageDef window" chapter for more information. The PageDef is ready for editing.

Creating FormDefs
To create a FormDef with a PageDef loaded:
1.

Pull down the File menu, select the FormDef
sub-menu and select [New FormDef].
The FormDef Properties dialog box displays. See
the "Menu bars" chapter for more information.

2.

Set FormDef options and click on [OK].
AppBuilder switches to Application proofing
mode. Since the FormDef controls sheet formatting (including specifying the active forms), the
form used as a template for PageDef mapping is
cleared from the screen and the options from the
first CopyGroup in the FormDef are applied to the
"sheet" in the Work area.
The current PageFormat displays on the sheet
and any formatting options such as PageFormat
direction or CopyGroup data offset are applied.
The options you set in the FormDef Properties
dialog box are used as default values when you
create new CopyGroups.
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3.

Pull down the Options menu and select
[AppBuilder Preferences].
The Preferences dialog box displays. See the
"Menu bars" chapter for more information.

4.

Select your FormDef display options and click
on [OK].

5.

Pull down the Options menu and select
[Proofing Properties].
The Proofing Properties dialog box displays. See
the "Menu bars" chapter for more information.

6.

Select your display options and click on [OK].
The display options define the physical sheet (in
the display) to which the PageDef and FormDef
are mapped.
Note: The printer type selected may affect the
display, as there are differences in paper handling
and media origins on AFP printers.

7.

Add objects to the FormDef tree.
See the "FormDef window" chapter for more
information.
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Toolbar and Toolbox

This chapter provides detailed descriptions of the
Toolbar and Toolbox tools and options. Where applicable, references to other chapters or sections in this
chapter are given for more detailed information.

Toolbar
The Toolbar displays across the top of the Work area:
Digital
ruler

Shape

Start
Coordinates

Graphic
ruler

Grid

Zoom
in/out

Spell Show/hide Edit
Check PageFormat PageFormat

Dimensions Snap Long
Undo/ Show/hide Show/hide Edit
Toolbox
to Grid Crosshair redo
CopyGroup CopyGroup

Figure 3-1. Toolbar
The Toolbar contains the following options:
Digital ruler
This option displays the horizontal and vertical position
of the screen pointer relative to the top left corner of
the screen (0,0).
Current object - Shape
This option displays the icon that represents the type
of element the cursor is currently closest to.
Current object - Start Coordinates
This option displays the x,y coordinates of the currently selected element.
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Current object - Dimensions
This option displays the width and height of the currently selected element.
Graphic ruler <F3>
Select the Ruler in the Toolbar, press <F3> or pull
down the View menu and select [Ruler] to display the
graphic ruler along the top and left edges of your
Work area. A check mark appears next to the option
in the menu when it is selected. Select this option a
second time to remove the graphic ruler.
Right click on the Ruler in the Toolbar to display the
Ruler Options dialog box.

Figure 3-2. Ruler Options dialog box
The Ruler Options dialog box contains the following
options:
Ruler measure
Select the unit of measure for display: [Inches],
[CM], [MM], [Dots], [Points] or [Pels]. Your selection also changes the [Ruler measure] option in
the Grid Setting and Form Properties dialog
boxes.
Ruler color
Select the color of the ruler: [Light Gray], [Dark
Gray] or [Green].
Graphic ruler
Select this option to display the graphic ruler
along the top and left-hand edge of the Work
area.
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Digital ruler
Select this option to display the position of the
screen pointer relative to the top left corner of the
form (0,0).
in Grid Units
Select this option to have the corresponding ruler
reflect the grid unit values specified in the Grid
Setting dialog box. See the "Grid" section for
more information.
Grid <F4>
The Grid helps you place and align form elements accurately. It displays on the screen, but does not print
as part of the form.
Select the Grid icon in the Toolbar, press <F4> or pull
down the View menu and select [Grid] to display the
grid in your Work area. A check mark appears next to
the option in the menu when it is selected. Select this
option a second time to remove the grid.
Right click on the Grid icon in the Toolbar to display
the Grid Setting dialog box.

Figure 3-3. Grid Setting dialog box
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The Grid Setting dialog box contains the following
options:
Grid units
Enter the number of grid units displayed per unit
of measure. The default setting is 10 x 6 grid
units per inch.
Grid step
Enter a grid step value to define the distance between grid points.
[Grid units] and [Grid step] units of measure are
defined by your selection in the [Ruler measure]
option. The size of the grid units or grid step dimensions you enter above are maintained even
though the value may change based upon the
current unit of measure.
You can enter grid dimensions using either the
[Grid units] or [Grid step] options, but not both.
Ruler measure
Select the unit of measure for display: [Inches],
[CM], [MM], [Dots], [Points] or [Pels]. Your selection also changes the [Ruler measure] option in
the Ruler Options and Form Properties dialog
boxes.
Graphic Ruler in Grid Units
Select this option to have the graphic ruler reflect
the values specified in [Grid units].
For example, if [Grid units] is set to 8.00 per 1
inch for the horizontal setting and 6.00 per 1 inch
for the vertical setting, the horizontal graphic ruler
displays 8 divisions (grid units) per inch and the
vertical graphic ruler displays 6 divisions (grid
units) per inch.
Digital Ruler in Grid Units
Select this option to have the digital ruler reflect
the values specified in [Grid units].
See the [Graphic Ruler in Grid Units] option for an
example.
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Grid Snap to
Select [Full Grid] for form elements to snap to grid
points.
Select [Half Grid] for form elements to snap to
points halfway between grid points. In both instances, all elements resize to fit the grid.
Grid Color
Select the grid color: [Black], [Dark Shade] or
[Green].
Snap mouse speed
Select the snap speed for the mouse: [Slow],
[Moderate] or [Fast].
Show Grid <F4>
Select this option to display the grid in the Work
area. Select this option a second time to remove
the grid.
Snap to Grid
Select this option to have form elements snap to
full grid or half grid points.
Snap to Grid <F5>
Select Snap to Grid in the Toolbar, press <F5> or pull
down the Options menu and select [Snap to Grid] to
place elements accurately on the grid. Select this option a second time to disable this feature.
When [Snap to Grid] is turned off, elements become
free floating and are moveable anywhere on the
screen.
Right click on the Grid icon in the Toolbar to display
the Grid Setting dialog box. See the "Grid" section for
more information.
Long Crosshair <F6>
The long crosshair displays horizontally and vertically
from the cursor on the form, and helps you place elements on the form more precisely.
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Select Long Crosshair in the Toolbar, press <F6> or
View menu and select [Long Crosshair]
next to the option in the menu when it is selected. Secrosshair.

the [+] button on the right side of the Zoom icon in the
To zoom out on (reduce the magnification of) an area
the Zoom icon in the Toolbar. The lowest reduction is
You can also use the <+> and <-> keys on the nuUndo/redo (Ctrl + Z/Shift + Ctrl + Z)
Select Undo in the Toolbar, press <Ctrl> + <Z> or pull
Edit menu and select [Undo] to cancel your
Select Redo in the Toolbar, press <Shift> + <Ctrl> +
Edit menu and select [Redo] to
Spell Check
Select this option to check the spelling in the active
chapters for more information.

tion a second time, press <F10>, or select [Toolbox]
Window menu to redisplay the Toolbox.
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Show/hide PageFormat
Select this option to display PageFormat information
such as mapped Fields and Records in the Work
area. Select this option a second time to hide this
information.
Show/hide CopyGroup
Select this option to display CopyGroup information in
the Work area. Select this option a second time to
hide this information.
Edit PageFormat
Select this option to edit the PageFormat.
Select this option a second time or immediately select
[Undo] from the Edit menu to exclude the PageFormat layer from editing. This locks the PageFormat
objects in position and allows you to modify form elements without disturbing the PageFormat objects.
Edit CopyGroup
Select this option to edit the CopyGroup.
Select this option a second time or immediately select
[Undo] from the Edit menu to exclude the CopyGroup
layer from editing. This locks the CopyGroup objects
in position and allows you to modify PageFormat elements without disturbing the form objects.

Toolbox
The Toolbox displays to the left of the Work area and
contains the following tools:
Select tool
Line tool
Path tool
Box tool
Figure 3-4. Toolbox
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Line tool

Path tool
Box tool
Circle tool
Field tool
Record tool
PageFormat tool

Select tool
Text tool
Image tool
Message
panel

Tool
options

Preview
panel

Circle tool
Text tool
Image tool
PageFormat tool
Record tool
Field tool
Select a tool to display the options for that tool in the
Toolbox. A short description of the tool displays in the
Message panel, and the Preview panel displays your
option selections.
Select tool
The Select toolbox allows you to edit form elements.
See the "Lines", "Shapes" and "Text operations" chapters for information on editing, copying, moving, and
deleting specific element types.
Copy
Select this option to copy a form element on your
form.
Select the option(s) a second time to turn it off.
See the "Lines", "Shapes", "Text operations" and "Images chapters for more information on copying
elements.
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Delete
Select this option to delete the selected form element(s). If you inadvertently delete an element, immediately select [Undo] from the Edit menu or the Toolbar
to restore the deleted element to your form.
Group Filter options
The Group Filter options from left to right are: [Line],
[Path], [Box], [Circle], [Text], [Data tag], [Image], and
[PageFormat].
Select one or more options to exclude the corresponding element from group options such as moving or deleting. Select the option(s) a second time to turn the
filter off. See the "AppBuilder basics" chapter for information on grouping elements.
Copy Count
Specify the number of copies you want to make by
clicking on the up or down arrows, or click in the numeric display box and enter a number.
<Ctrl>-click to increase/decrease the value by 10.
Movement Selection
Select a movement direction for moving or copying
elements.
Select [Horizontal only] for horizontal movement of the
cursor with element(s) attached.
Select [Vertical only] for vertical movement of the cursor with element(s) attached.
Select [Free] to move the cursor in any direction with
element(s) attached.
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Copy Distance
Specify the horizontal and vertical distance between
copies of an element by clicking on the up or down arrows, or click in the numeric display box and enter a
number.
Press and hold <Ctrl> while
increase/decrease the value by 10.

clicking

to

Select the option(s) a second time to turn it off.
Sticky Lines
Enables lines that connect or lines that touch boxes to
remain attached when you move the element the line
is attached to.
Select the option(s) a second time to turn it off.
See the "Lines" chapter for more information on sticky
lines.
Line tool
The Line toolbox allows you to draw horizontal, vertical, and free lines; and specify line properties. See
the "Lines" chapter for more information on the options described below.
Line Direction
Select the direction of the line you want to draw: [Horizontal only], [Vertical only], [Horizontal and Vertical] or
[Free].
Line Width
Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots).
You can also select standard [Thin] 2 dot, [Medium] 4
dot or [Thick] 6 dot line widths.
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Line Style
Select the line style: [Solid], [Dashed] or [Dotted].
Line Color
(Highlight color) Select this option to display the Color
dialog box which displays local palette colors. Select
a box border color from the palette that displays and
click on <Close>. The selected color displays in the
bottom half of the icon.
Path tool
The Path toolbox allows you to draw paths and specify
path properties. See the "Shapes" chapter for more
information on the options described below.
Path Shape
Select [Open] or [Closed] paths.
An open path remains open while a closed path automatically closes when you finish drawing the path.
Path Direction
Select [Snapped] to draw lines that snap to horizontal
and vertical lines.
Select [Free] to draw line segments that run in any
direction.
Path Beginning and End Styles
Select the line beginning and end style you want.
Choose [Square], [Round] or [Mitered] ends for each
end of the path.
Border Width
Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots).
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You can also select standard [2], [4] or [6] border
widths.
Border Style
Select [Dotted], [Dashed] or [Solid] border style.
Draw/Done Mode
When you click in the Work area to add a path, you
are in [Draw] mode. When you complete a path, select [Draw/Done] to toggle to [Done], double-click in
the Work area or right click in the Work area. You
can then draw another path or switch to another drawing tool.
Path Color
(Highlight color/Full color) Select this option to display
the Color dialog box which displays local palette colors. Select a path border color from the palette that
displays and click on <Close>. The selected path
color displays in the bottom half of the icon.
Path Fill Color
(Full color) Select this option to display the Color dialog box which displays local palette colors. Right click
to select a path fill color from the palette that displays
and then click on <Close>. The selected path fill color
displays in the bottom half of the icon.
Path Pattern/Shading
(Black-and-white/Highlight color/Full color) Select this
option to display the Pattern dialog box which allows
you to apply shaded patterns to closed paths. The selected shade pattern applies each time you draw a
new closed path, until you change it using the same
procedure. Select the Hollow pattern for no shading.
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Path Connection Radius
Specify the value of the path connection radius (in
pels) by clicking on the up or down arrows, or click in
the numeric display box and enter a value (maximum
299 pels).
You can also select [Small] 10 pels, [Medium] 20 pels,
[Large] 30 pels, [Square], [Radius Half] or [Radius
Maximum].
Box tool
The Box toolbox allows you to draw boxes and specify
box properties. See the "Shapes" chapter for more
information on the options described below.
Box Corner Style
Select the box corner style: [Square], [Rounded],
[Rounded on the top], [Rounded on the bottom],
[Rounded on the left] or [Rounded on the right ].
Box Positioning
Select the top half of this option to center the top left
corner of the box on grid coordinates or select the bottom half of the option to snap the top left corner of the
box flush to grid coordinates.
Box Shape
Select the top half of this option to draw boxes as rectangles. Select the bottom half of this option to draw
boxes as squares.
Box Diagonals
Select the diagonal line pattern for inside the box:
[None], [Left], [Right] or [Both].
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Box Line Width
Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots). Specify [0] to apply an invisible border to a shaded box. Unshaded boxes
must have a border width of [1] or higher.
You can also select standard [2], [4] or [6] box line
widths.
Box Line Style
Select the style for the [Box Lines] type: [Solid],
[Dashed] or [Dotted].
Box Lines
Select one of the following options to correspond to
the width and style options:
Select the first option [Border Lines] to set the width
and style of the box border.
Select the second option [Horizontal Splits] to set the
width and style of horizontal splits in a box.
Select the third option [Vertical Splits] to set the width
and style of vertical splits in a box.
The [Horizontal Splits] and [Vertical Splits] options are
used when you apply box splits using the [Box Splits]
option.
Box Splits - Horizontal/Vertical
The [Horizontal Splits] and [Vertical Splits] options divide a box horizontally or vertically in up to 40 even
portions. Select the [Horizontal Splits] or [Vertical
Splits] option and specify a value by clicking on the up
or down arrows.
You can also select the [Box Splits] option and enter
the number of portions in the numeric display box next
to each option. The minimum value is 1 (hollow) and
the maximum value is 40.
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Box Color
(Full color) Select this option to display the Color dialog box which displays local palette colors. Select a
box border color from the palette that displays and
click on <Close>. The selected box color displays in
the bottom half of the icon.
Box Fill Color
(Highlight color/Full color) Select this option to display
the Color dialog box which displays local palette colors. Right click to select a box fill color from the palette that displays and then click on <Close>. The
selected box fill color displays in the bottom half of the
icon.
Box Pattern/Shading
(Black-and-white/Highlight color/Full color) Select this
option to display the Pattern dialog box which allows
you to apply shaded patterns to boxes. All the boxes
you draw contain this shading until you change it, using the same procedure. Select the Hollow pattern for
no shading.
Box Corner Radius
Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a value
(maximum 299 pels).
You can also select [Small] 10 pels, [Medium] 20 pels,
[Large] 30 pels or [Maximum]. The [Corner Radius]
option does not apply when all corner styles are 90
degrees.
Circle tool
The Circle toolbox allows you to draw circles and
specify circle properties. See the "Shapes" chapter
for more information on the options described below.
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Circle Radius
Select one or more of the four circle quarters to compose a circle or partial circle.
Select a quarter a second time to deselect it.
Circle Drawing Method
Select the top half of this option to draw a circle from
its center outward, where the anchor point is the circle
center.
Select the bottom half of this option to draw a circle
within an unseen box, where the anchor point is the
box corner nearest the starting point. This method allows you be more precisely place the circle in relation
to another element.
Circle Diagonals
Select the diagonal line pattern for inside the circle:
[None], [Left], [Right] or [Both].
Only 360-degree circles display diagonals.
Circle Border Width
Specify a value (in dots) by clicking on the up or down
arrows or click in the numeric display box and enter a
value (maximum 99 dots). Specify [0] to apply an invisible border to a shaded circle. Unshaded circles
must have a border width of [1] or higher.
You can also select [Thin] 2 pels, [Medium] 4 pels or
[Thick] 6 pels border widths.
Circle Border Style
Select the circle line style: [Solid], [Dashed] or
[Dotted].
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Circle Start and Finish Angle
Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a value
(in degrees) for where you want your circle to begin
and end.
You can also select: [0], [90], [180] or [270] degrees.
Circle Color
(Full color) Select this option to display the Color dialog box which displays local palette colors. Select a
circle border color from the palette that displays and
click on <Close>. The selected circle color displays in
the bottom half of the icon.
Circle Fill Color
(Highlight color/Full color) Select this option to display
the Color dialog box which displays local palette colors. Right click to select a circle fill color from the palette that displays and then click on <Close>. The
selected circle fill color displays in the bottom half of
the icon.
Circle Pattern/Shading
(Black-and-white/Highlight color/Full color) Select this
option to display the Pattern dialog box which allows
you to apply shaded patterns to circles. All the circles
you draw contain this shading until you change it, using the same procedure. Select the Hollow pattern for
no shading.
Circle Axis
Specify an axis through which circles print on an AFP
printer: [None], [Horizontal], [Vertical], or [Both].
Text tool
The Text toolbox allows you to specify text attributes.
See the "Text operations" chapter for more information on the options described below.
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Text Direction
Select [Across] to have the text display from left to
right.
Select [Down] to have the text display from top to
bottom.
Select [Back] to have the text display from right to left.
Select [Up] to have the text display from bottom to top.
Inter-character/Inter-word Spacing
These options are for display purposes only. You can
apply the [Inter-character] or [Inter-word] option to the
form only when you convert the .ELX file and only
when this is a valid option for your conversion. See
your Elixir Desktop and Converters for AFP User
Guide for more information.
The [Inter-character] and [Inter-word] options are
global features. Once you select an option for one
text block, it is applied to all text blocks throughout the
form.
Select [Inter-character] to justify all text blocks by increasing or decreasing the amount of space between
characters. This option makes the form easier to read
when converted to OGL, but takes longer for the form
to print.
Select [Inter-word] to justify all text blocks by increasing or decreasing the amount of space between
words. This option reduces the complexity of your
form so the form prints faster.
Wrap Text
Wrapped text is bound by columns which denote the
boundaries for a line of text. When the text reaches
the defined boundary, it automatically wraps to the
next line.
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When this option is selected, text boundaries are defined by entering a value in the [Column Width] option
or by selecting [Box Text] and drawing a visual box on
your form to contain the text. Select this option when
text is justified.
Remove Redundant Spaces
Removes redundant spaces, relative shifts and carriage returns from wrapped text blocks.
Split Text
Splits a single block of text into two separate text
blocks.
Text Justification
Specify the justification for each text block: [Left Justification], [Center Justification], [Right Justification] or
[Full Justification].
The [Wrap Text] and [Boxed Text] or [Column Width]
options must be selected for text justification.
Text Positioning
When the [Wrap Text] and [Box Text] options are selected, you can specify the vertical positioning of a text
block: [Top], [Center], or [Bottom].
Use this option with [Text Justification] and [Box Text]
to place text in nine positions within the box.
Vertical Text Spacing
The text you type is vertically spaced by a default
value, depending on the font.
Specify a lines per inch value by clicking on the up or
down arrows or click in the numeric display box and
enter a number. Press and hold <Ctrl> while clicking
to increase/decrease the value by 1.0. The value you
enter only affects the current block of text and any
subsequent blocks of text entered using the font.
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To return the lines per inch to the default for the current font, use the down arrow to decrease the LPI
value to [0] or press <Del>.
Text Color
(Highlight color/Full color)Select this option to display
the Color dialog box which displays local palette colors. Select a text color from the palette that displays
and click on <Close>. The selected text displays in
the bottom half of the icon.
Data Tags
This option displays the Data Tagging dialog box
which allows you to add data tags to forms for use
with Elixir's DocuTag or DataMerge products. See
your Elixir DocuTag User Guide or Elixir DataMerge
User Guide for more information on creating data tags
and tag lists.
Column Width and Height
Specify the width and height for a text block by clicking on the up or down arrows or click in the numeric
display boxes and enter a number. Press and hold
<Ctrl> while clicking to increase/decrease the value by
1.0. Values that exceed the form limits are not
accepted.
You must select the [Wrap text] option when using
these options. When these options are set to [0.00],
text entered is bound only by the width and height of
the form.
Select the [Box Text] option along with these options
to display a visual guide box with the width and height
dimensions you specify.
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Draw Text Box
Select this option after selecting [Box Text] to define
column boundaries for text by drawing a visual box in
the Work area. Place the cursor in the Work area and
press and hold down the mouse button. Drag the box
that displays and release the mouse button at the bottom right of the box. This box is used only to provide
a visual width and height guide for text operations,
and does not print with your form.
Select [Wrap Text] to wrap text at the boundary of the
text box defined by this option. Select [Text Positioning] to position text within the text box.
Box Text
Select this option when using the [Draw Text Box] or
[Column Width] and [Column Height] options to enter
text in predefined areas or "boxes." Box boundaries
are defined by entering [Column Width] and [Column
Height] values or by drawing a box manually using the
[Draw Text Box] option.
Deselect this option to enter free text which is bound
only by the width and height of the form.
Font Type
Click on this button until the desired font type displays:
[f] - Elixir-version fonts
[T] - True Type fonts
[a] - ATM fonts
Select a font action. The dialog box that displays depends on the type of font you select.
[+] displays the Add Fonts, Select True Type
fonts, or Select ATM fonts dialog box. Select a
font to add it to the current Font List, then click on
the [OK] or [ADD] button.
You can select either Elixir-generic fonts (.HDR)
or screen fonts (.FNT) when loading Elixir fonts
by selecting .HDR or .FNT from the drop-down list
in the Add Fonts dialog box.
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[-] displays the Replace Font, Select True Type
Fonts, or Select ATM Fonts dialog box. Select a
font to remove it from the current Font List, then
click on the [DEL] button. If the font is in use on
the form you are prompted to select a replacement font from the Replace Font dialog box.
Load Font List/Merge Font List/Save Font List
Click on the [down arrow] to load a Font List from the
Load Font List dialog box that displays.
Click on the [double arrows] to display the Merge Font
List dialog box and add fonts to the current Font List
by loading another Font List.
Click on the [up arrow] to display the Save Font List
dialog box. You can enter a new file name for the current font list, or rename an existing font list.
Soft Keyboard
This option allows you to enter characters that are not
available on a standard keyboard. See the "Text operations" chapter for more information on using the
soft keyboard.
Font Preview Panel
Displays the fonts available in the current Font List.
Click on the up or down arrow or use the scroll bar to
scroll through the list to change the current font.
Fonts in use on a form are denoted by a diamond
character to the left of the font name.
Image tool
The Image toolbox allows you to add Elixir-format images (.LP3) or logos to a form. See the "Images"
chapter for more information on the options described
below.
Image Name
Displays the name of the selected image.
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Image Size
Horizontal/Vertical
This option displays the horizontal and vertical sizes of
the image in the units selected in the Toolbar Ruler.
See the "Toolbar" section for more information.
Image Color
(Highlight color/Full color) Select this option to display
the Color dialog box which displays local palette colors. Select an image border color from the palette
that displays and click on <Close>. The selected image color displays in the bottom half of the icon.
Image Fill Color
(Full color) Select this option to display the Color dialog box which displays local palette colors. Right click
to select an image fill color from the palette that displays and then click on <Close>. The selected image
fill color displays in the bottom half of the icon.
Load image
This option displays the Load Image dialog box which
allows you to select an image to add to your form.
PageFormat tool
The PageFormat toolbox allows you to set PageFormat defaults. The PageFormat toolbox [Direction],
[Horizontal lineone position] and [Vertical lineone position] options are described after the [PageFormat
properties] button, at the end of this section.
PageFormat Properties
Click on this button to display the PageFormat Properties dialog box with options for naming a PageFormat
and specifying defaults.

ELIXIR APPBUILDER FOR AFP USER GUIDE

3-23

TOOLBAR AND TOOLBOX

Figure 3-5. PageFormat Properties dialog box
The PageFormat Properties dialog box contains the
following options:
PageFormat name
Enter a name for the PageFormat.
Short name
Enter a name for the PageFormat (maximum 8
characters). This name displays to the left of the
Properties button in the Toolbox and is written to
the PageDef file during output conversion.
When you copy a PageFormat, AppBuilder automatically changes the [Short name] of the copy to
prevent two PageFormats from having the same
name.
Description
Enter descriptive text here for the job to help you
identify later how the job was created. This text is
written as a comment line in the generated PPFA.
Page Dimensions
Enter the logical page width and height for the
PageFormat outline.
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The PageFormat outline appears in the Work
area outlined in the color set in [AppBuilder Preferences] in the Option menu. See the "Menu
bars" chapter for more information.
Lineone
Enter the horizontal (x) and vertical (y) coordinates for the starting point of the first line of data
inside the logical page. The default values are:
x = 0, the upper left hand corner of the screen
y = 80% of one line space from the top of the
page
For example, if [Linespacing] is 6.00 LPI,
then y = 80% of 1/6 per inch. If [Linespacing]
is 8.00 LPI, then y = 80% of 1/8 per inch.
Date/Time
This option displays the dates and time that the
file was originally created and last opened.
Direction
This option allows you to select the direction that
the logical page will be placed on the physical
sheet.
In template mapping mode (only a PageDef
loaded), logical pages are always displayed with
the x, y origin at the upper left hand corner of the
screen in the [Across] direction, with text displaying from left to right. Changing the PageFormat
direction will not change the orientation of the
logical page on the screen while in template mapping mode.
Select [Across] to print the logical page from left
to right.
Select [Down] to print the logical page from top to
bottom.
Select [Back] to print the logical page from right to
left.
Select [Up] to print the logical page from bottom
to top.
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Display Offset
This option is available when only a PageDef and
an overlay are loaded (no FormDef). Enter the
horizontal and vertical coordinates for the start
points of the PageFormat on the overlay. These
values are the distances from the upper left hand
corner (0,0) of the sheet. This offset applies to
the PageFormat display only and do not affect the
FormDef nor is it exported to the PPFA output.
If a FormDef is loaded and the [Apply offset from
CopyGroup to PageFormat Information] option is
selected in the Preferences dialog box or if the
[Full Preview] option is selected in the Proofing
Properties dialog box, this option is disabled and
the [Data Offset] values set in the CopyGroup
Properties dialog box are used.
See the "Menu bars" chapter for more information
on the Preferences and Proofing Properties dialog boxes. See the "FormDef window" chapter for
more information on the CopyGroup Propertied
dialog box.
TRC Reference
Click on this button to display the TRC Reference
Table dialog box with options for naming a table
reference character list (TRCREF) and specifying
defaults. A TRCREF links a font in the PageDef
with a table reference character (TRC) in the input data.
TRC fonts can only be added from the master
Font List for the PageDef and are referenced by
[User Name]. Similarly, in order to build a TRC
Reference List, you must use fonts in the master
Font List. See the "Record tool" section for more
information on the Font List dialog box.
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Figure 3-6. TRC Reference Table dialog box
The TRC Reference Table dialog box contains
the following options:
TRC Table Name
Enter a name or select one from the list in the
[TRC Reference Table] option.
TRC Reference Definition
TRC
Enter a table reference character (TRC) number
between 0 (default)-126. Values 0-3 are linemode compatible, and values 4-126 are linemode incompatible.
TRC Reference Definition
Font/Select
Enter a font to be associated with the TRC number or choose a font from the Font List dialog
box that displays from the [Select] button.
For the selected font to display in this option,
you must define a [User Name] in the Font List
dialog box. See the "Record tool" section for
more information.
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TRC Reference Definition
Rotation
All rotations below are with respect to the baseline. When rotating characters, the print direction remains the same.
Select [0] (default) to rotate the characters 0o.
Select [90]
clockwise.

to

rotate

the

characters

90o

Select [180] to rotate the characters 180o
clockwise.
Select [270] to rotate the characters 270o
clockwise.
TRC Reference Definition
Direction
Select the print direction for the font, relative to
the upper left hand corner of the logical page.
Select [Across] to add characters from left to
right, and lines from top to bottom.
Select [Down] to add characters from top to bottom, and lines from right to left.
Select [Back] to add characters from right to left
, and lines from bottom to top.
Select [Up] to add characters from bottom to
top, and lines from left to right.
Change
Click on this button to edit the defaults for the
TRC file selected in [TRC Reference Table]
option.
Add
Click on this button to add the font specified in
the [TRC Reference Definition - Font] option to
the TRC Reference Table specified in [TRC Table Name].
Remove
Click on this button to delete the TRC file selected in the [TRC Reference Table] list.
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TRC Reference Table
This option displays a list of the TRC files that
are available for use.
Page Segments
Click on this button to display the Page Segments
dialog box with options for selecting, adding to or
deleting page segments from a list of PageSegments that is loaded to the printer before the active page is printed.
The list does not map page segments to the
printed sheet. Page segment names can include
the 'S1' prefix, although AppBuilder strips off the
prefix when generating PPFA.

Figure 3-7. Page Segments
dialog box
The Page Segments dialog box contains the following options:
Page Segments
Name/Select
Enter a page segment or choose one from the
Select Page Segment dialog box that displays
from the [Select] button.
Page Segments
Add
Click on this button to add the page segment
specified in the [Name] option to the list of segments in the Select Page Segment dialog box.
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Page Segments
Remove
Click on this button to delete the highlighted
page segment from the list of segments in the
Select Page Segment dialog box.
Line Data Ovls
Click on this button to display the Line Data Overlays dialog box which allows you to build a list of
overlays called out via an Include Page Overlay
(IPO) structured field in the input data. Overlay
names can include the '01' prefix, although
AppBuilder strips the prefix off when generating
PPFA.

Figure 3-8. Line Data Overlays
dialog box
The Line Data Overlays dialog box contains the
following options:
Line Data Invoked Overlay
Name/Select
Enter an overlay or choose one from the Select
Overlay dialog box that displays from the [Select] button.
Line Data Invoked Overlay
Add
Click on this button to add the overlay specified
in the [Name] option to the list of overlays in the
Select Overlay dialog box.
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Line Data Invoked Overlay
Remove
Click on this button to delete the highlighted
overlay from the list of overlays in the Select
Overlay dialog box.
PageFormat Direction
Select [Across], [Down], [Back] or [Up] to define the
direction of the logical page.
PageFormat direction applies when a FormDef is
loaded. The PageFormat direction displays relative to
the FormDef media origin.
In template mapping mode (only a PageDef loaded),
logical pages are always displayed with the x, y origin
at the upper left hand corner of the screen in the
[Across] direction, with text displaying from left to
right. Changing the PageFormat direction will not
change the orientation of the logical page on the
screen while in template mapping mode.
PageFormat Horizontal Lineone Position
The horizontal offset shows the horizontal starting
point of the first line of data inside the logical page.
The offset is relative to the upper left hand corner of
the page (0,0).
Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.
PageFormat Vertical Lineone Position
The vertical offset shows the vertical starting point of
the first line of data inside the logical page. The offset
is relative to the upper left hand corner of the page
(0,0).
Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a
number.
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Record tool
The Record toolbox allows you to set Record defaults
and contains the following options:
Record Properties
Click on this button to display the Record Properties
dialog box with options for naming a Record, and
specifying defaults.

Figure 3-9. Record Properties dialog box
The Record Properties dialog box contains the following options:
PageFormat name
Displays the name of the PageFormat that this
Record is tied to.
Record name
Enter a name for the current Record. This name
displays to the left of the Properties button in the
Toolbox.
Channel
Enter a value between 1 and 12. This value corresponds to the carriage-control characters in the
data and is used to specify line spacing, skipping
within a logical page, or skipping to a new page.
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Repeat
Enter a value for the number of consecutive Records to be processed using this formatting.
Linespacing
Enter the linespacing for the printed lines.
If the units selected are inches, the linespacing
value is lines per inch. If the selected units are
CM, MM, points or pels, the linespacing value is
the vertical distance between lines.
Position
Horizontal/ Relative
Select an option from the drop-down list to specify
the horizontal offset from the upper left hand corner of the page:
Select [None] to set the horizontal offset to 0.
This is the same as using absolute position.
Select [Margin] to start the Record at the horizontal position specified in the [Lineone] option in the PageDef Properties dialog box.
See the "Menu bars" chapter for more
information.
Select [Same] to start the Record at the same
horizontal position as the previous Record. If
this is the first Record on a logical page, the
horizontal offset is 0.
Position
Horizontal/Absolute
Enter a value for the horizontal offset from the upper left hand corner of the logical page.
Position
Vertical/ Relative
Select an option from the drop-down list to specify
the vertical offset from the upper left hand corner
of the page:
Select [None] to set the vertical offset to 0.
This is the same as using absolute position.
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Select [Top] to start the Record at the vertical
position specified in the [Lineone] option in
the PageDef Properties dialog box. See the
"Menu bars" chapter for more information.
Select [Same] to start the Record at the same
vertical position as the previous Record.
Select [Next] to start the Record one line
down from the previous Record. This value is
calculated using the linespacing value set in
the currently selected Record. If this is the
first Record on a logical page, the Record
starts one line down from the top of the page.
Position
Vertical/Absolute
Enter a value for the vertical offset from the upper
left hand corner of the page.
Font
Font name
Displays the local or User name of the selected
font. Select a font from the Font List dialog box
that displays from the [Select] button.

Figure 3-10. Font List dialog box
The Font List dialog box contains the following
options:

3-34

ELIXIR TECHNOLOGIES CORPORATION

TOOLBAR AND TOOLBOX

Name
Select a font from the Select Font dialog box
that displays from the [Select] button.
User name

All rotations are with respect to the baseline.
When rotating characters, the print direction
remains the same.
Select [0] (default) to rotate the characters 0o.
Select [90] to rotate the characters 90o

clockwise.
Select [270] to rotate the characters 270o
clockwise.
Add

Select this option to change the name of the
font selected in the [List of used Fonts] option.
Delete
Select this option to delete the font selected in
the [List of used Fonts] option.
Order/Set order

This option displays the fonts used or available
for use in the order defined in the [Order]
option.
Font
User name
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Font
Rotation
Displays the rotation of the font specified in the
[Font name] option. Rotation is set in the Font
List dialog box.
Comment
Enter any Record comments here.
Direction
Select [Across] to print the Record from left to
right.
Select [Down] to print the Record from top to
bottom.
Select [Back] to print the Record from right to left.
Select [Up] to print the Record from bottom to top.
Color
Select a Record display color from the drop-down
list that displays. The color you select here displays in the Color icon in the Record tool.
Repeat type
Select [Field] to position repeated Fields based on
the first instance of the same Field.
Select [Line] to position repeated Fields based on
the position of the Record.
Is Mapped
Select this option if you have already assigned
horizontal and vertical coordinates to the Record.
Once this option is selected, the Record is
mapped and no Fields can be added to it. You
cannot map a Record that contains Fields.
Text/Sample Data
Enter the text for fixed text or sample data in the
Text dialog box that displays.
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Figure 3-11. Text dialog box
The Text dialog box contains the following
options:
Text
Displays the text in the current Record.
Duplication
Enter a value for the number of times the text
sequence is to be repeated.
Length
Enter a value for the length of the text string.
String type
Select [Char] for standard text characters.
Select [Hex] for hexadecimal strings. You must
enter text as character pairs representing hexadecimal values (X'00' to 'FF').
Text Direction
Select [Across] to display the Record from left to right.
Select [Down] to display the Record from top to
bottom.
Select [Back] to display the Record from right to left.
Select [Up] to display the Record from bottom to top.
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Character Rotation
All rotations are with respect to the baseline. When
rotating characters, the print direction remains the
same.
Select [0] (default) to have the characters rotate 0o.
Select [90] to have the characters rotate 90o
clockwise.
Select [180] to have the characters rotate 180o
clockwise.
Select [270] to have the characters rotate 270o
clockwise.
Repeat
This option displays the value for the number of consecutive Records to be processed using this formatting. Specify a value by clicking on the up or down
arrows or click in the numeric display box and enter a
number.
Record formatting defaults are set in the Record Properties dialog box.
Channel Number
This option displays the value for the carriage-control
characters in the data and is used to specify line spacing, skipping within a logical page, or skipping to a
new page.
Specify a value by clicking on the up or down arrows
or click in the numeric display box and enter a value
between 1 and 12.
Linespacing
This option displays the number of lines per inch for
text display. Specify a value by clicking on the up or
down arrows or click in the numeric display box and
enter a number.
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Field/Line
Select [Field] to have the current Field repeated the
number of times set in the [Repeat] option.
Select [Line] to have the current line repeated the
number of times set in the [Repeat] option.
Font
This option displays the Font List dialog box which allows you to select a font. A sample of the selected
font displays in the message area.
Record Color
This option displays the record display color set in the
Record Properties dialog box.
Field tool
The Field tool allows you to set Field defaults and contains the following options:
Field Properties
Select this option to display the Field Properties dialog
box with options for naming a Field and selecting
defaults.
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Figure 3-12. Field Properties dialog box
The Field Properties dialog box contains the following
options:
PageFormat name
Displays the name of the PageFormat that this
Field is tied to.
Record name
Displays the name of the Record that this Field is
tied to.
Field name
Enter a name for the current Field. This name
displays to the left of the Properties button in the
Toolbox.
Data Mapping
Starting Byte
Enter a value for the starting point of the Field.
The value is the number of bytes from the first
data byte in the input data Record.
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Data Mapping
Length
Enter a value for the number of bytes in the Field,
beginning with the position specified in [Starting
Byte].
Data Mapping
Select [Is fixed] to specify that the current Field
will contain fixed text - no variable data is to be
merged at print time.
Select [Is mapped] if you have already assigned
horizontal and vertical coordinates to a Field.
Position
Horizontal/ Relative
Select an option from the drop-down list to specify
the horizontal offset from the related Record's
starting position:
Select [None] to have the horizontal position = 0.
Select [Current] to have the Field start at the end
of the previous Field.
Position
Horizontal/Absolute
Enter a value for the horizontal offset from the related Record's starting position.
Position
Vertical/ Relative
Select an option from the drop-down list to specify
the vertical offset from the related Record's starting position:
Select [None] to have the vertical position = 0.
Select [Current] to have the Field start at the
same vertical position as the previous Field. If
this is the first Field on a logical page, the related
Record's vertical position is used.
Select [Next] to have the Field start one line down
from the previous Field. Linespacing is determines by the linespace value in the associated
Record.
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Position
Vertical/Absolute
Enter a value for the vertical offset from the related Record's starting position.
Font
Font name
Displays the selected font. Select a font from the
Font List dialog box that displays from the [Select]
option. See the "Record tool" section for more information on the Font List dialog box.
Font
User name
Displays the nickname for the font set in the Font
List dialog box.
Font Rotation
Displays the rotation of the font specified in the
[Font name] option. Rotation is set in the Font
List dialog box.
Comment
Enter any comments for the Field here.
Direction
Select the print direction for the Field, relative to
the upper left hand corner of the logical page.
Select [Across] to have the characters added
from left to right and the lines added from top to
bottom.
Select [Down] to have the characters added from
top to bottom and the lines added from right to
left.
Select [Back] to have the characters added from
right to left and the lines added from bottom to
top.
Select [Up] to have the characters added from
bottom to top and the lines added from left to
right.
Color
Select a Field display color from the drop-down
list for this option. The color selected here displays in the Color icon in the Field tool.
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Suppression
Enter the name used to suppress printing of this
Field when suppression is selected in a FormDef.
To activate suppression, this suppression name
must be referenced in a SubGroup in a FormDef.
See the "FormDef window" chapter for more
information.
Field Text/Sample Data
Enter the text for fixed text or sample data in the Text
dialog box that displays. See the "Record tool" section for more information.
Direction
Select the print direction for the Field, relative to the
upper left hand corner of the logical page.
Select [Across] to have the characters added from left
to right and the lines added from top to bottom.
Select [Down] to have the characters added from top
to bottom and the lines added from right to left.
Select [Back] to have the characters added from right
to left and the lines added from bottom to top.
Select [Up] to have the characters added from bottom
to top and the lines added from left to right.
Character Rotation
All rotations below are with respect to the baseline.
When rotating characters, the print direction remains
the same.
Select [0] (default) to have the characters rotate 0o.
Select [90] to have the characters rotate 90o
clockwise.
Select [180] to have the characters rotate 180o
clockwise.
Select [270] to have the characters rotate 270o
clockwise.

ELIXIR APPBUILDER FOR AFP USER GUIDE

3-43

TOOLBAR AND TOOLBOX

Start
This option displays the value for the Field's starting
byte. Specify a value by clicking on the up or down arrows or click in the numeric display box and enter a
value.
Length
This option displays the number of bytes to process,
beginning with the Field's starting byte. Specify a
value by clicking on the up or down arrows or click in
the numeric display box and enter a value.
Variable data/Fixed text
Select [Variable data] for variable data Fields.
Select [Fixed text] for fixed text Fields - no data is
merged during processing.
Suppression
Enter the name to be used to suppress this Field
when suppression is selected in a FormDef. See the
Field Properties dialog box for more information.
Font
This option displays the Font List dialog box which allows you to select a font. A sample of the selected
font displays in the message area. See the "Record
tool" section for more information.
Field Color
This option displays the field display color set in the
Field Properties dialog box.
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Menu bars

This chapter provides information on AppBuilder's
menus and sub-menus. Where applicable, references to other chapters or sections in this chapter are
given for more detailed information.
Select a menu to display its options, then select an
option from the pull-down menu.

AppBuilder menu bar
The AppBuilder menu bar contains the File, System,
Window, and Help menus.
File menu
The File menu contains the following options:
Form
The Form sub-menu contains the following options:
New Form <F9>
This option displays the Form Properties dialog box
which allows you to create a new form and set display
options. See the "Form properties" section for more
information.
Load Form <F8>
This option displays the Load Form dialog box which
allows you to open a previously created form.
Save Form <Ctrl> + <S>
Select this option to save your open form under its
original file name specified in the Form Properties dialog box.
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For a new form being saved for the first time, this option displays the Save Form dialog box which allows
you to specify a form name.
Save Form As <F7>
This option displays the Save Form As dialog box
which allows you to save an open form under a new
file name.
Rename/Move Form
This option displays the Rename/Move Form dialog
box which allows you to renameand/or change the
path of an existing form. See the "AppBuilder basics"
chapter for more information.
Delete Form
This option displays the Delete Form dialog box which
allows you to delete an existing form.
Form Group
The Form Group sub-menu contains the following
options:
Merge Form Group
This option displays the Load Form Group dialog box
which allows you to add a group into the current form.
See the "AppBuilder basics" chapter for more
information.
Save Form Group
This option displays the Save Form Group dialog box
which allows you to define a group in an existing form
and save it as a form file.
Load Form Template
This option displays the Load Form Template dialog
box which allows you to load a form template onto the
current form. The template is only a visual guide for
designing new form elements around. It does not become part of the form when the form is saved.
You can load more than one form file template into the
Work area; however, retrieving multiple form templates uses more memory which may be significant if
your templates contain large images.
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Proof printing a form that includes one or more templates also prints the templates. If you want to proof
print a form without the templates, save and reload
the form without the templates, then proof print the reloaded form.
PageDef
The PageDef sub-menu contains the following
options:
New PageDef
This option displays the PageDef Properties dialog
box which allows you to create a new PageDef and to
set display options. See the "PageDef properties"
section for more information.
Load PageDef
This option displays the Load PageDef dialog box
which allows you to open an existing PageDef.
Save PageDef
Select this option to save your open PageDef under
the file name specified in the PageDef Properties dialog box.
Save PageDef As
This option displays the Save PageDef As dialog box
which allows you to save an open PageDef under a
new file name.
Delete PageDef
This option displays the Delete PageDef dialog box
which allows you to delete an existing PageDef.
FormDef
The FormDef sub-menu contains the following
options:
New FormDef
This option displays the FormDef Properties dialog
box with options for setting FormDef properties. See
the "FormDef properties" section for more information.
Load FormDef
This option displays the Load FormDef dialog box
which allows you to open an existing FormDef.
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Save FormDef
This option allows you to save your open FormDef under the file name specified in the FormDef Properties
dialog box.
Save FormDef As
This option displays the Save FormDef As dialog box
which allows you to save an open FormDef under a
new file name.
Delete FormDef
This option displays the Delete FormDef dialog box
which allows you to delete an existing FormDef.
Convert
The Convert
options:

sub-menu

contains

the

following

Import
This option displays the Import Options dialog box
which allows you to select a source file and specify
prefix options. See the "Importing and Exporting"
chapter for more information.
Export
This option displays the Export Options dialog box
which allows you to select an output file format. See
the "Importing and Exporting" chapter for more
information.
Databasing
This options in this sub-menu allow you to import or
export an AppBuilder PageDef and/or FormDef as a
backup or archived copy. Exporting creates a new set
of database files under the selected subdirectory.
Multiple PageDefs and FormDefs can be exported to
the backup/archived database.
See the "Importing and Exporting" chapter for more
information.
The Databasing sub-menu contains the following
options:
Import PageDef
This option displays the Select Database Path dialog
4-4

ELIXIR TECHNOLOGIES CORPORATION

MENU BARS

box which allows you to select the subdirectory containing the desired database files.
Import FormDef
This option displays the Select Database Path dialog
box which allows you to select the subdirectory containing the desired database files.
Export PageDef
This option displays the Select Database Path dialog
box which allows you to enter the path for the
PageDef to be exported to.
If a set of database files does not exist in the target
subdirectory, AppBuilder creates them for you.
Export FormDef
This option displays the Select Database Path dialog
box which allows you to enter the path for the
FormDef to be exported to.
If a set of database files does not exist in the target
subdirectory, AppBuilder creates them for you.
Pack
For future implementation.
Import Text
This option displays the Import Text dialog box which
allows you to import ASCII text files for use in your
form. See the "Text operations" chapter for more
information.
Print
The options in this sub-menu allow you to perform
various print options. See the "AppBuilder basics"
chapter for more information.
Exit
This option closes the AppBuilder application.
System menu
The System menu contains the following options:
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Usage Switches
This option displays the Usage Switches dialog box
which allows you to set your system defaults.

Figure 4-1. Usage Switches dialog box
The Usage Switches dialog box contains the following
options:
Save State on Exit
Select this option to save the current menu and option
settings when you exit AppBuilder.
Extend Lines by Halfwidth
Select this option to display horizontal and vertical
lines with extensions equal to half the line thickness at
each end. This option allows for a more pleasing appearance of intersecting lines and affects the screen
display only. Lines are printed as drawn.
Show Quick Help
Select this option to display a short description of any
icon that your cursor passes over. The information
displays in the Message area of the screen.
Show Form Dimensions
Select this option to display the dimensions of the current form in the upper right hand corner of the screen.
Show Lines as WYSIWYG
Select [240DPI] to display lines and shape borders as
WYSIWYG on high-resolution monitors. This is the
line and border thickness used for AFP conversions.
Using this setting on low resolution monitors such as
VGA may cause light and medium lines and borders
to display as the same thickness.
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Select [300DPI] to display 300 dpi lines and shape
borders as 240 dpi.
Select [OFF] if you have a low resolution monitor.
Filing Options
This option displays the Filing Options dialog box
which allows you to set saving options and specify the
default directories for forms, fonts, text, tags and jobs.

Figure 4-2. Filing Options dialog box
The Filing Options dialog box contains the following
options:
Autosave
Select this option to automatically save your form at
regular intervals. Enter a time interval from 1 to 9
minutes in [Save interval]. The back-up form is saved
as AUTOBACK.ELX in the default forms directory.
You can also press <Ctrl> + <S> or select [Save
Form] from the File menu to save your changes
manually.
Make Backup File
Select this option to create a back-up copy of the form
which is overwritten only when you select [Save] from
the File menu. The [Autosave] feature does not overwrite this file.
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The back-up file is written to the default forms directory and has the same stem name as the original file
with a .BAK extension.
See the "AppBuilder basics" chapter for information
on retrieving a back-up file.
Load Last Form
Select this option to automatically load the form you
last worked on when start a new AppBuilder session.
When this option is not selected, a new form displays
when you begin the program.
Forms Directory
Specify the directory for Elixir-format form files (.ELX).
The default is
drive:\ELIXIR\FORMS\ELIXIR\DEMO.
Elixir Fonts Directory
Specify the directory for Elixir-format font files (.HDR).
The default is
drive:\ELIXIR\FONTS\ELIXIR.
Screen Fonts Directory
Specify the directory for screen font files (.FNT) and
width tables (.WDT).
The default directory is
drive:\ELIXIR\FONTS\SCREEN\DEMO.
See the "Text operations" chapter for more information on screen and other fonts.
Elixir Images Directory
Specify the directory for Elixir-format image files
(.LP3). The default is drive:\ELIXIR\PICS\PRINTER.
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Screen Images Directory
Specify the directory for screen image files (.LW8).
The default is drive:\ELIXIR\PICS\SCREEN.
Texts Directory
Specify the directory for imported ASCII text files
(.TXT). The default directory is drive:\ELIXIR\TEXTS.
RTF Texts Directory
Specify the directory for imported RTF text files. The
default directory is drive:\ELIXIR\TEXTS\RTF.
Tags Directory
Specify the directory for tag files (.TAG). Tag files are
used with DocuTag when external tag files are called
within a form. The default directory is drive:\ELIXIR.
See your DocuTag for AFP manual for more
information.
Job Directory
Specify the directory for the AppBuilder components
database (.CDX and .DBF). You can copy or move all
.CDX and .DBF files to any drive or directory. The default directory is drive:\ELIXIR\JOBS\ELIXIR.
Reset to Defaults
This option resets all Toolbox options to their default
values.
Save Configuration
This option allows you to save the current configuration for your next AppBuilder session.
The settings for the following options are saved:
[Grid] display on or off
[Snap to Grid] on or off
[Ruler] on or off, and Ruler options
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Window menu
The Window menu contains the following options:
Tile
Select this option to tile the open windows within
AppBuilder.
Form
Select this option to display the form Work area. Select this option a second time to hide the form Work
area.
PageDef
Select this option to display the PageDef window. Select this option a second time to hide the PageDef
window.
FormDef
Select this option to display the FormDef window. Select this option a second time to hide the FormDef
window.
Toolbox <F10>
Select this option to display the Toolbox. Select this
option a second time to hide the Toolbox.
Help menu
For future implementation.
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Work area menu bar
The Work area menu bar contains the Pgfmt, CopyGroup, Edit, Tools, View, and Options menus.
Pgfmt menu
The Pgfmt menu contains the following options:
PageFormat
The PageFormat sub-menu allows you to access
PageDef window components when the Work area is
maximized and the PageDef window is minimized. It
contains the following options:
New PageFormat
Select this option to add new pageformats to the active PageDef tree in the PageDef window.
Add from Library
This option displays the Load PageFormat dialog box
which allows you to add an existing page formats to
the active PageDef tree in the PageDef window.
Set active
This option displays the Set Active PageFormat dialog
box which allows you to set an existing PageFormat
as the active page format.
Save to Library
Select this option to save the current PageFormat to
the database.
TRCREF List
This option displays the TRC Reference Table dialog
box which allows you to create and modify a table reference character list (TRCREF). See the "Toolbar
and Toolbox" chapter for more information.
Segment List
This option displays the Page Segments dialog box
which allows you to build a list of page segments to
download to the printer before a page begins printing.
See the "Menu bars" chapter for more information.
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Overlay List
This option displays the Line Data Overlays dialog box
which allows you to build a list of overlays called out
via an include page overlay (IPO) structured Field in
the input data. See the "Menu bars" chapter for more
information.
New Subpage
Select this option to specify a SubPage in an existing
PageFormat.
Record
The Record sub-menu contains the following options:
New Record
Select this option to add new Records to the active
PageFormat in the PageDef tree in the PageDef
window.
Add from Library
This option displays the Load Record dialog box which
allows you to add previously-saved Records from the
database to the active PageFormat in the PageDef
tree in the PageDef window.
Save to Library
Select this option to save the current Record to the
database.
Add Floating Segment
This option displays the Floating Segment dialog box
which allows you to add a page segment to the page
and is available only when a Record is selected. The
page segment is positioned relative to the location of
the current Record.
Page segment names can include the 'S1' prefix, although AppBuilder strips the prefix off when generating PPFA. See the "PageDef window" chapter for
more information.
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Add Floating Overlay
This option displays the Floating Overlay dialog box
which allows you to add an overlay to the page and is
available only when a Record is selected. The overlay
is positioned relative to the location of the current
Record.
Overlay names can include the '01' prefix, although
AppBuilder strips the prefix off when generating
PPFA.
See the "PageDef
information.

window"

chapter

for

more

Condition
The Condition sub-menu contains the following options. Conditional logic is available only at the Record
level.
New condition
Select this option to add a new condition to the selected Record in the active PageFormat.
Add from Library
This option displays the Load Condition dialog box
which allows you to add existing conditions from the
database to the selected Record in the active
PageFormat.
Save to Library
Select this option to save the current condition to the
database.
New Field
Select this option to add new Fields to the active
PageFormat. Fields are added directly after the currently selected Record or Fields in the PageDef tree in
the PageDef window. See the "PageDef window"
chapter for more information.
Font List
This option displays the Font List dialog box which allows you to create and modify the font list for the current PageDef.
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Every font used in a PageDef must be listed in a master list at the PageDef level. This also applies if fonts
are called out using structured Fields embedded in the
line data. See the "Toolbar and Toolbox" chapter for
more information.
CopyGroup menu
The CopyGroup menu contains the following options:
CopyGroup
The CopyGroup sub-menu contains the following
options:
New CopyGroup
Select this option to add new CopyGroups to the
FormDef tree in the FormDef window.
Add from Library
This option displays the Load CopyGroup dialog box
which allows you to add existing CopyGroups from the
database to the FormDef tree in the FormDef
window.
Set active
This option displays the Select Active CopyGroup dialog box which allows you to select a CopyGroup as
the active CopyGroup. All of the formatting parameters specified in the CopyGroup are applied to the
Work area.
Save to Library
Select this option to save the current CopyGroup to
the database.
SubGroup
The SubGroup sub-menu contains the following
options:
New SubGroup
Select this option to add new SubGroups to the active
CopyGroup in the FormDef tree in the FormDef
window.
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Add from Library
This option displays the Load SubGroup dialog box
which allows you to add existing SubGroups from the
database to the FormDef tree in the FormDef window.
Set active
This option displays the Select Active SubGroup dialog box which allows you to select a SubGroups in the
currently loaded FormDef as the active SubGroup.
Save to Library
Select this option to save the current SubGroup to the
database.
New Overlay
This option displays the Add Overlay dialog box which
allows you to create a new form which is added to the
currently active SubGroup. See the "FormDef window" chapter for more information on adding overlays
using the FormDef Toolbar.
Suppression
The Suppression sub-menu contains the following
options:
Apply
Select this option to apply suppression to a selected
Field in the Work area.
Remove
Select this option to remove the Field displayed in the
SubGroup Properties dialog box from the group to be
suppressed.
Add
Select this option to add the Field displayed in the
SubGroup Properties dialog box to the group of Fields
to be suppressed. You can use up to 8 unique suppression names per SubGroup, with a maximum of
128 names per FormDef.
See the "FormDef window" chapter for more information on setting Field suppression in the SubGroup
Properties dialog box.
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Edit menu
The Edit menu contains the following options:
Undo <Ctrl> + <Z>
Select this option to cancel the most recent action
performed.
Redo <Shift> + <Ctrl> + <Z>
Select this option to cancel your most recent [Undo]
operation.
Cut <Ctrl> + <X>
Select this option to remove the selected element(s)
to the Clipboard.
Copy <Ctrl> + <C>
Select this option to copy the selected element(s) to
the Clipboard.
Paste <Ctrl> + <V>
Select this option to insert cut or copied elements
from the Clipboard.
Select All <Ctrl> + <A>
Select this option to select all form elements on the
current form. This allows you to delete, copy, or move
the elements.
Unselect All <Ctrl> + <A>
Select this option to deselect all previously selected
elements.
Delete <Del>
Select this option to permanently delete the selected
element(s) from a form.
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Delete All <Ctrl> + <Del>
Select this option to permanently delete all selected
elements from a form.
Find <Alt> + <F3>
Displays the Find text dialog box. Enter the text you
want to find.
See the "Text operations" chapter for more information on the Find text dialog box.
Find Next <F3>
Finds the next occurrence of the text string entered in
the Find text dialog box.
See the "Text operations" chapter for more information on the Find text dialog box.
Find Previous <Shift> + <F3>
Finds the previous occurrence of the text string entered in the Find text dialog box.
See the "Text operations" chapter for more information on the Find text dialog box.
Replace
Displays the Replace Text dialog box. Enter the text
you want to find, and the text you want to replace it
with.
See the "Text operations" chapter for more information on the Replace text dialog box.
Tools menu
The options in this menu provide an alternate way to
activate the Toolbox or Toolbar for the tool selected.
See the "Toolbar and Toolbox" chapter for more information on the tools activated by selecting these
options.
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Spell Check
Select this option to check the spelling in the open
form. See the "Menu bars" and "Text operations"
chapters for more information.
View menu
The options in this menu allow an alternate way to activate the Toolbar options. See the "Toolbar and Toolbox" chapter for more information on the [Ruler],
[Grid] and [Long Crosshair] options.
The [PageDef] and [FormDef] options display the
PageDef and FormDef windows below the Work area,
respectively.
See the "PageDef window" and
"FormDef window" chapters, respectively, for more
information.
Options menu
The Options menu contains the following options:
Snap to Grid <F5>
Select this option to place lines, paths and boxes accurately on the grid. See the "Toolbar and Toolbox"
chapter for more information.
PageDef Properties
This option displays the PageDef Properties dialog
box with options for setting PageDef properties and is
available only when a PageDef is loaded.
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Figure 4-3. PageDef Properties dialog box
The PageDef Properties dialog box contains the following options:
PageDef name
Enter a name for your PageDef file. This is the
long name (max. 32 characters) that is used to
identify the PageDef in the database.
Short name
Enter a name (max. 6 characters) for the
PageDef to be created from.
For PPFA, a P1 prefix is added to the short name
when the file is converted. If the object out is
generated from the PageDef, a P1 prefix is automatically added to the PageDef.
PageDef Description
Enter descriptive text here for the job to help you
identify later how the job was created. This text is
written as a comment line in the generated PPFA.
Page Dimensions
Enter the page width and height.
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Lineone
Enter the horizontal (x) and vertical (y) coordinates for the starting point of the first line of data
inside the logical page. The default values are:
x = 0, the upper left hand corner of the screen
y = 80% of one line space from the top of the
page
For example, if [Linespacing] is 6.00 LPI, then y
= 80% of 1/6 per inch. If [Linespacing] is 8.00
LPI, then y = 80% of 1/8 per inch.
Date/Time
This option displays the dates and times that the
file was originally created and last opened.
Direction
Select [Across] to display the text from left to
right.
Select [Down] to display the text from top to
bottom.
Select [Back] to display the text from right to left.
Select [Up] to display the text from bottom to top.
Linespacing
Enter the number of lines per inch for the text
display.
FormDef Properties
This option displays the FormDef Properties dialog
box with options for setting FormDef properties and is
available only when a FormDef is loaded.
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Figure 4-4. FormDef Properties dialog box
The FormDef Properties dialog box contains the following options:
FormDef name
Enter a name for your FormDef file. This is the
long name (max. 32 characters) that is used to
identify the FormDef in the database.
Short name
Enter a name (max. 6 characters) for the
FormDef to be created from.
For PPFA, a F1 prefix is added to the short name
when the file is converted. If the object out is
generated from the FormDef, a F1 prefix is automatically added to the FormDef.
FormDef Description
Enter descriptive text here for the FormDef to
help you later identify how it was created. This
text is written as a comment line in the generated
PPFA.
Direction
Select [Across] to format the pages in the Across
in-line direction.
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Select [Down] to format the pages in the Down inline direction.
Duplex printing
Select [Simplex] to print on one side of the paper.
Select [Normal] to print on both sides of the paper
in portrait orientation, with the top of the logical
page on each side toward the same edge of the
sheet.
Select [Tumble] to print the reverse side of the
duplex page in portrait orientation, with the top of
the logical page on the front side towards the
same edge of the sheet as the location of the logical page on the back side.
Select [RTumble] to print the reverse side of the
duplex page in landscape orientation, with the top
of the logical page on the front side towards the
same edge of the sheet as the location of the logical page on the back side.
Select [RNormal] to print on both sides of the paper in landscape orientation, with the top of the
logical page on each side toward the same edge
of the sheet.
Constant Form
Select [No] to turn the constant form function off.
Select [Front] to print a constant form on the front
side without variable data.
Select [Back] to print a constant form on the back
side without variable data.
Select [Both] to print a constant form on both
sides without variable data.
Presentation
Select [Portrait] to print the pages with the short
edges at the top and bottom and the long edges
along the sides.
Select [Landscape] to print the pages with the
long edges at the top and bottom and the short
edges along the sides.
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Use N_UP
This option allows you to specify whether or not
you want to print more than one logical page on
the same side of a physical sheet.
Select [None] to deactivate this option.
Select [Basic] to activate this option.
N_UP_Type
This option is available only when [Basic] is selected under [Use N_Up] and allows you to specify the number of logical pages to be placed on
one side of a physical sheet. Select a value from
1-4 from the drop-down list that displays.
The value selected causes the sheet to be equally
divided into the number of logical pages specified.
The [Preview] option displays, showing the logical
page placement on the physical sheet. This layout is based on the [Printer Type selection] and
[Physical Sheet dimension] options set in the
Proofing Properties dialog box. See the "Proofing
Properties" section for more information.
Next Page place on
For future implementation.
Overlays
Select this option to display the Overlays for Basic
N_UP dialog box with options for selecting an
overlay. This option is available only when [Basic]
is selected under [Use N_UP].
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Figure 4-5. Overlays for Basic N_Up
dialog box
The Overlays for Basic N_UP dialog box contains
the following options:
Overlay name
Enter an overlay name or select one from the
Select Overlay dialog box that displays from the
[Select] button.
Data Offset
Horizontal/Vertical
Enter the horizontal and vertical offsets for the
overlay. These values are the distances from
the origin of the logical page.
Use origin of
Select [Page] to use the upper left hand corner
of the page as the origin (0,0) for the overlay
offsets.
Select [Partition] to use the N_UP partitions set
in the [N_UP_Type] option in the FormDef Properties dialog box as the origin (0,0) for the
overlay.
Add
Select this option to add the overlay specified in
[Overlay name] to the [List of Overlays].
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Change
Select this option to edit the defaults for the
overlay selected in the [List of Overlays].
Delete
Select this option to delete the overlay selected
in the [List of Overlays].
List of Overlays
This option displays the overlays that are available for use.
Preview
This option is available only when [Basic] is selected in [Use N_Up] and displays the [Direction]
and the [N_UP_Type] selected, showing the logical page placement on the physical sheet.
This layout is based on the [Printer Type selection] and [Physical Sheet dimension] options set
in the Proofing Properties dialog box. See the
"Proofing
Properties"
section
for
more
information.
Date/Time
This option displays the dates and times the file
was originally created and last opened.
Data Offset
Horizontal/Vertical
Front/Back
Enter the horizontal and vertical coordinates for
the print starting points of the first line of data, on
both the front and back sides of the paper. These
values are the distances from the upper left hand
corner (0,0) of the sheet.
PostProcessing
This button displays the FormDef PostProcessing
Options dialog box which allows you to set post
processing defaults.
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Figure 4-6. FormDef PostProcessing Options
dialog box
The FormDef PostProcessing Options dialog box
contains the following options:
Media Info
Select [Select a particular fixed medium local
ID's] and specify one or more ID's from the
scrollable list to select a particular fixed medium
local ID for the printer to apply to a sheet, or select [Use all the current fixed medium local ID's]
.
Perforation Cut at Fixed Locations
Select this option to specify a perforation cut at
one or more fixed locations on the sheet.
Separation Cut at Fixed Locations
Select this option to specify a separation cut at
one or more fixed locations on the sheet.
Bin
Enter the bin number for the paper source or click
on the button to the right of the Bin text box to select a bin from the drop-down list that displays:
Select [1] to use the primary paper source.
Select [2-10] to use another paper source. If the
specified bin does not exist, the default paper
source for the printer is used.
Select [Man] to manually feed the paper. For
more
information,
see
your
printer's
documentation.
4-26

ELIXIR TECHNOLOGIES CORPORATION

MENU BARS

Quality
Enter the number for print quality or click on the
button to the right of the Quality text box to select
a number from the drop-down list that displays.
Higher numbers correspond to higher levels of
print quality.
This option is valid only on printers that recognize
more than one level of print quality; the default is
determined by the printer model. For more information, see your printer's documentation.
Adjust
Enter a number (from 0 to 20 L-units) that specifies the range of horizontal adjustment for the
print area. After you set a value, it is the maximum amount available in both directions, plus
and minus.
The maximum logical page size (in the horizontal
direction) is reduced by the amount specified in
this option.
Jog
Select this option to offset stacking between
CopyGroups on cut-sheet page printers. For
continuous-form printers, printing marks are
placed on the sheets to indicate breaks between
CopyGroups.
Proofing Properties
This option displays the Proofing Properties dialog box
with options for configuring AppBuilder's job proofing
mode.
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Figure 4-7. Proofing Properties dialog box
The Proofing Properties dialog box contains the following options:
Printer Type selection
Select [Cutsheet] for cut sheet printers.
Select [Continuous form 3800] for IBM 3800 printers.
Select [Continuous form 3900] for IBM 3900 and similar Group 3 printers.
Select [Show perforation] to display the perforated
edges of the paper. This option is available only when
[Continuous form 3800] or [Continuous form 3900] is
selected.
Physical Sheet dimension
Enter the page width and height, including tractor-feed
strips, if any. If [Continuous form 3800] or [Continuous form 3900] is selected in the [Printer Type selection] option, this dimension must include an extra inch
in the width of the paper.
For example, for continuous form paper with an 8.5
inch x 11 inch printable area, the Physical Sheet dimension must be 9.5 inch x 11 inch.
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Full Preview
Select this option to preview the exact layout of the
page as it will print. This option displays only when
[Basic] is selected as the [Use N_Up] option in the
FormDef Properties dialog box. See the "FormDef
properties" section for more information.
AppBuilder Preferences
This option displays the Preferences dialog box with
options for setting display preferences.

Figure 4-8. Preferences dialog box
The Preferences dialog box contains the following
options:
PageDef Display Options
Show Field/Record as
Select [Name] to display the Field/Record by name in
the Work area.
Select [Replacement characters] to display the
Field/Record using the characters specified in the
[Use character] text box. The length of the displayed
string is equal to the Field/Record length.
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PageDef Display Options
Display PageFormat Boundaries in Color
Select this option to display the PageFormat's outline
in the color selected from the drop-down list. This
color is for display purposes only and does not print.
FormDef Display Options
Apply offset from CopyGroup to PageFormat Information
Select this option to apply the data offset values specified in the [Data Offset] option of the CopyGroup
Properties dialog box to the active PageFormat in the
Work area. See the "FormDef window" chapter and
the "FormDef properties" section, respectively, for
more information.
FormDef Display Options
Visible Suppressions
Select this option display the suppressed Fields as
outline boxes, instead of using the Field names or replacement characters.
FormDef Display Options
Display Overlays from SubGroup
Select this option to display the overlays associated
with the active SubGroup.
FormDef Display Options
Active Form Color
Select the display color for the selected overlay in a
SubGroup from the drop-down list. This option makes
it easy to see which overlay is being edited, when multiple overlays are used in a SubGroup.
FormDef Display Options
Inactive Form Color
Select the display color for the overlays not currently
active for editing.
Default Font
Font name
Enter the name of the font you want to use as default
or select a font from the Select Font dialog box that
displays from the [Select] button. This font is used for
Fields/Records when no font is specified.
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Default Font
Rotation
All rotations below are with respect to the baseline.
When rotating characters, the print direction remains
the same.
Select [0] (default) to have the characters rotate 0o.
Select [90] to rotate the characters 90o clockwise.
Select [180] to rotate the characters 180o clockwise.
Select [270] to rotate the characters 270o clockwise.
GEM Forms Load Defaults
This option displays the GEM Forms Load Defaults
dialog box, used for forms created in versions of ElixirForm prior to version 3.0. These settings apply to all
subsequently loaded GEM forms, but not to the current form.

Figure 4-9. GEM Forms Load Defaults dialog box
The GEM Forms Load Defaults dialog box contains
the following options:
Extend Lines by Halfwidth
Displays horizontal and vertical lines with extensions
equal to half the line thickness at each end. Affects
printed output only.
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Text Formatting Compatibility
This option allows you to select the text for loaded
GEM forms.
Select [GEM] to maintain the original boxed text formatting of a GEM form.
Select [Windows] to use the Windows version of
boxed text formatting.
Your selection is written to the Elixir SYSTEM.INI file.
This formatting applies only to GEM forms loaded after this operation is performed.
Color Mode
This option allows you to select the display color for
loaded GEM forms.
Select [Black & White] to display loaded GEM forms in
black and white.
Select [Full Color] to display the loaded GEM forms
with the full color palette.
Form Properties
This option displays the Form Properties dialog box
which allows you to specify page settings for your new
form or change the properties of an existing form.

Figure 4-10. Form Properties dialog box
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The Form Properties dialog box contains the following
options:
Page size
Select the size and the orientation of the page.
The width and length of the page displays in the
unit of measure specified for the ruler.
Select [8.5 x 11] for U.S. letter size.
Select [8.5 x 14] for U.S. legal size.
Select [11 x 17] for 11 x 17 inches.
Select [A4] for 8.27 x 11.69 inches.
Select [A3] for 11.69 x 16.54 inches.
Select [Custom] to specify a non-standard size.
Enter a width and height. AppBuilder supports
sizes up to 17 x 17 inches.
If you change the page size of an existing form,
some form elements may extend beyond the
page boundary. If this happens, the Objects Off
Page dialog box displays when you click on [OK].
The Objects Off Page dialog box lists all objects
which are off the page, by type. Select one of the
following options for each object type:
Delete
Select this option to delete the object(s) that is
off the page.
Ignore
Select this option to adjust the page size without
adjusting the object(s). If you adjust the page
size back to the original size, the object(s) displays in the original position.
Move in
Select this option to move the object(s) inside
the new page boundaries. Note that the object(s) may overlap other objects already on the
page.
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Clip
Select this option to clip the object(s) that is off
the page. Only the object portion which lies
within the new page boundaries is preserved.
Switch
Click on this button to change the page orientation by reversing the width and height of the page.
Units of measure
Select the unit of measurement for the graphic
and digital rulers and the selected page size:
[Inches], [CM], [MM], [Dots], [Points], or [Pels].
Your selection also changes the [Ruler measure]
options in the Ruler Options and Grid Settings
dialog boxes. See the "Toolbar and Toolbox"
chapter for more information on these dialog
boxes.
Color mode
Select the color mode for the currently loaded
form: [Black and White] or [Full color]. [Full color]
allows you to use border colors and fill colors if
supported by your printer. If you select [Black
and White], the color option is not shown in the
Toolbox.
Hybrid users: If you want to select HighLight
Color, make sure the [OGL 2.0 Patterns] selection in the Usage Switches dialog box is deselected. To access the Usage Switches dialog
box, pull down the System menu and select [Usage Switches].
Page Offset
Specify the page offset:
[Xoffset] shifts output right for portrait orientations
and down for landscape orientations by the units
specified in [Unit of measure].
[Yoffset] shifts output down for portrait orientations and right for landscape orientations.
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Offset values are stored in the form file for application when the form is converted to .OGL or
.OVE format in the Elixir Desktop. They are also
applied when a FormDef referencing this form is
loaded. The offset is not applied to the form in
form building mode. See your Elixir Desktop and
Converters for AFP User Guide for more
information.
Form Databasing
This option displays the Form Databasing dialog box
which allows you to specify databasing information for
your new form.

Figure 4-11. Form Databasing dialog box
The Form Databasing dialog box contains the following options:
Short Page Description
Enter a short description (up to 60 characters) for the
form.
Page Author
Enter the user ID (up to 8 characters).
Made for
Enter the name of the customer (up to 13 characters).
Page Version
Enter the version number (up to two characters).
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Page Revision
Enter the form revision or modification identifier (one
character only).
Local ID
Enter a local identifier (up to 8 characters).
Long Page Comments
Enter comments regarding the form (up to four lines
with 60 characters per line). Use the mouse to move
to another line or any place within the comments box.
Comments are saved with each form until they are
changed or deleted.
Store Date/Time Stamp
Select this option to assign a date or time stamp to the
form when generated to a printer file format.
Date Format
Select the month/day/year/ format for the date when
[Store Date/Time Stamp] is selected.
sc:
The default separator character is /. To enter a new
separator character, backspace over the old character
and enter a new one.
Time Format
Select 12 or 24 hour time format.
sc:
The default separator character is : . To enter a new
separator character, backspace over the old character
and enter a new one.
Form databasing information is stored with the form
until it is changed or deleted. It is not printed.
Text/Font Options
This option displays the Text and Font Options dialog
box which allows you to specify settings for text and
fonts.
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Figure 4-12. Text and Font Options dialog box
The Text and Font Options dialog box contains the following options:
Text Display Options
Text Tab Length
Enter the text tab length. The default setting is 5. The
tab length setting applies to all tabs on the current
form (including those previously entered).
Text Display Options
Text Formatting Compatibility and Grid Step Precision
Allows you to select the boxed text format when loading GEM forms.
Select [GEM] to maintain the original boxed text formatting of a GEM form.
Select [Windows] to use the Windows version of
boxed text formatting.
Your selection affects only the currently loaded form.
Tag Display
Prints the data tags included in Elixir forms.
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[None] does not print the data tags.
[Replace Chars] prints the data tag field length and replacement characters.
[Tag Name] prints the data tag's field name.
See your Elixir DataMerge User Guide or Elixir DocuTag User Guide for more information.
Font Options
Font Preference
Select the default font type: [Screen] or [Elixir].
Font Options
Sort Font List
Alphabetically sorts the font list.
Text Import Options
Lock position
When importing from an ASCII file, locks text in its initial position in the Work area. Subsequent text blocks
are positioned directly beneath the first text block.
Text Import Options
Separate paragraphs
Places imported text blocks at different locations on
the form. Paragraphs separated by two carriage returns create separate blocks that you can place separately if the [Lock position] option is not selected.
See the "Text operations" chapter for more information on importing text.
Join Text Using
This option allows you to group blocks of text into a
single paragraph.
Select [Spaces] to display each text block under the
previous text block. The original line beginnings and
endings are retained.
Select [Justify] to display the joined text as one continuous paragraph. The width of the joined text is determined by the position of the left-most and
right-most characters in the text blocks.
Select [Relatives] to have each text block retains dotto-dot correspondence with the first text block.
4-38

ELIXIR TECHNOLOGIES CORPORATION

MENU BARS

To take out unwanted spaces or perform paragraph
formatting operations, select the [Wrap Text] option in
the Text toolbox. See the "Toolbar and Toolbox"
chapter for more information.
For information on how to join text, see the "Text operations" chapter.
Keyboard Input Options
Filter control codes on input
Prevents entry of control codes from the keyboard.
RTF Paste Options
Select RTF import options:
[Paste Fonts] - maintains font(s) specified in the
imported text file.
[Paste Colors] - maintains color(s) specified in the
imported text file.
Character Mapping Options
This option displays the Character Mapping Options
dialog box with options for specifying non-standard
mapping. Most TrueType or ATM font users should
use the default [None] setting.
Keyboard Mapping
Select [None] to use Windows ANSI mapping (you
must have screen fonts mapped to Windows ANSI
mappings.)
Select [OEM] to remap ANSI keystrokes to DOS
mappings.
Select [OEM/ISO] to remap ANSI character strokes to
DOS ISO mappings. (This option is the same as the
[Map IBM to ISO fonts] option in previous software
versions.
Select [ISO] to remap ANSI keystrokes to DOS ISO
mappings.
Select [KMP] (default) to translate keystrokes using
customized tables. When you select [KMP], the [Windows] and [Elixir] options display:
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Windows
Select a map from the drop-down list. Most users
should select T100ANSI. For Eastern European
versions of Windows, select T10EEURO.
Elixir
Select the setting that matches your DOS code
page from the drop-down list. To check your
DOS code page, at the DOS prompt, type:

CHCP <Enter>
The active code page displays.
Text Import Mapping / Text Paste Mapping
The default setting for text import mapping is [NONE].
Most TrueType or ATM font users should use the default [None] setting.
Select [NONE] when importing a DOS text file.
Select [OEM] when importing a Windows text file.
Select [OEM/ISO] when importing a Windows text file
that has European characters mapped.
Select [ISO] when importing or pasting a DOS text file
that has European characters mapped.
Select [KMP] when importing or pasting a Windows
text file that has international characters mapped.
When you select [KMP], the [Text File] and [Elixir] options display:
Text File
Select a text file from the drop-down list. Most users
should select T100ANSI. For Eastern European versions of Windows, select T10EEURO.
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Elixir
Select the setting that matches your DOS code page
from the drop-down list. To check your DOS code
page, at the DOS prompt, type:

CHCP <Enter>
The active code page displays.
Spell Checker Mapping
Select [None] to use Windows ANSI mapping (you
must have screen fonts mapped to Windows ANSI
mappings.)
Select [OEM] to remap ANSI keystrokes to DOS
mappings.
Select [OEM/ISO] to remap ANSI character strokes to
DOS ISO mappings. (This option is the same as the
[Map IBM to ISO fonts] option in previous software
versions.
Select [KMP] (default) to translate keystrokes using
customized tables. When you select [KMP], the [Windows] and [Elixir] options display:
Windows
Select a map from the drop-down list. Most users
should select T100ANSI. For Eastern European
versions of Windows, select T10EEURO.
Elixir
Select the setting that matches your DOS code
page from the drop-down list. To check your
DOS code page, at the DOS prompt, type:

CHCP <Enter>
The active code page displays.
Spell Check Options
This option displays the Spell Check Options dialog
box which allows you to set spell checking options.
See the "Text operations" chapter for more information on using this option.
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Figure 4-13. Spell Check Options
dialog box
The Spell Check Options dialog box contains the following options:
Language
Select the language you want to use from the dropdown list that displays.
Dialect/mode
Select the dialect/mode for the selected language
from the drop-down list that displays.
Ligature
This option may or may not display, depending on the
language selected.
Select [Open] to have two-letter character combinations print side-by-side.
Select [Closed] to have two-letter character combinations print together.
Lexicon Supplements
This option is available only when English standard is
selected in the [Language] option.

4-42

ELIXIR TECHNOLOGIES CORPORATION

MENU BARS

Select [Business/Insurance/Finance] to use a dictionary that contains business, insurance, or financial
terminology.
Select [Medical] to use a dictionary that contains
medical terminology.
Select [Legal] to use a dictionary that contains legal
terminology.
Select [Science] to use a dictionary that contains scientific terminology.
Processing Correction Defaults
These options are used only when errors are found.
Select [Provide Alternatives If Not Found] to have alternative words provided if a word is not found in the
database.
Select [Provide Alterns. From Personal Dictionary] to
have alternative words provided from active personal
dictionaries after alternatives from the active database
are retrieved.
Select [Perform Space Insertion] to have spaces inserted between incorrectly spaced words. For example, the string "andthe" is corrected to "and the".
Select [Remove Final Period] to strip the final period
from a word before it is submitted for correction.
Personal Dictionaries
This option displays the dictionary files (*.RD) that are
available for use.
Select [New] to create a personal dictionary. Enter a
name for the new dictionary in the Create Personal
Dictionary dialog box that displays.
Select [Add] to add an existing personal dictionary
(*.?D) to the list. Select the dictionary from the Add
Personal Dictionary dialog box that displays.
Select [Remove] to remove the selected dictionary.
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Select [Edit] to edit entries in the selected dictionary.
Select [Add], [Delete], or [Replace] to perform the appropriate action for the word displayed in the [Edit
word] option in the Edit Personal Dictionary dialog box
that displays.
Spell Check Typing
Select this option to activate the spell check option after a work is typed. Once a word is entered and the
space bar is depressed, the word is spell checked.
Template Options
Select form template defaults in the Template Options
dialog box. See the "AppBuilder basics" chapter for
more information on the Template Options dialog box.
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Lines

This chapter describes how to draw and edit lines.
In the following sections, references are made to options in the Line toolbox. See the "Toolbar and Toolbox" chapter for more information.

Line display
The following section provides information on line
display.
Setting the screen display
If you are using a low resolution monitor, such as
VGA, you should select [OFF] in the Usage Switches
dialog box [Show Lines as WYSIWYG] option because thin lines and borders may display as the same
thickness as medium lines and borders when in
WYSIWYG mode.
See the "Menu bars" chapter for more information.
Screen refresh
After a screen refresh, lines and boxes that overlap
may not display or print in the "front to back" order in
which they were drawn. For example, a shaded box
drawn on top of an existing line may display with the
line on top of the box after a screen refresh. This is
due to the method of resorting a page (from top left to
bottom right) that is required by certain printers.
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To prevent elements refreshing to an incorrect "front
to back" order, avoid drawing elements that overlap.
For example, to draw a box with lines extending from
its borders, connect individual lines to the border of
the box instead of drawing the box on top of a line that
extends beneath and beyond its borders.

Drawing lines
Apply line properties by selecting options in the Line
toolbox. If you want the line to start and end at grid
points, select [Grid] and [Snap to Grid] in the Toolbar.
If you want the line to snap to grid mid-points as well
as to grid points, set the [Grid Snap to] option in the
Grid Setting dialog box to [Half Grid].
Lines attached to the outside of a box may not line up
exactly with box splits. If you want attached lines to
line up exactly with box splits, move the box to line up
with the attached line or draw the box splits as lines
extending outside the box.
To draw a line:
1.

Select line attributes in the Line toolbox.

2.

Position the screen pointer in the Work area
where you want the line to begin and press
and hold the left mouse button.

3.

Drag the screen pointer across the Work area.
A line displays.

4.

Release the mouse button to end the line.

Applying color to a line
To apply color to a line:
1.
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Select [Color] in the Line toolbox.
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If you cannot see the color option, make sure [Full
Color] is selected in the Form Properties dialog
box.
The color palette displays.
2.

Select a color.

3.

Place the cursor in the Work area and draw a
line.
The selected color is applied to the line.

Editing lines
To change the properties of a line, you must first select it.
To select a line:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Place the cursor on the line you want to edit.
Arrows display around the line.

3.

Click the right mouse button.
The Line toolbox displays. Boxes appear at each
end of the line (in the Work area) to show the line
is selected.
You can now change the line length or the line
attributes.

Changing line length
You can change the length of a selected line by typing
in new dimension coordinates or by stretching it on the
form.
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Changing dimension coordinates
To change the line dimension coordinates:
1.

Select [Current object Dimensions] in the
Toolbar.
If you cannot click on the current values, make
sure the line is selected and click the right mouse
button.

2.

Backspace over the current value or press the
<Del> key to delete the whole number.

3.

Enter new coordinate values.
Use the <-> key to enter a negative value, if
allowed.

4.

Click the left mouse button or press <Enter>.
The line adjusts to the new coordinates.

Stretching a line
To change the line dimension coordinates manually:
1.

Place the cursor at the end of the selected
line.
The cursor changes to a four-way arrow.

2.

Drag the end of the line until the line reaches
the new length.

3.

Release the mouse button.

Sticky lines <Ctrl> + <L>
When you select the [Sticky Lines] option in the
Select/Edit toolbox, lines that touch remained attached to one another when either line is moved.
Lines attached to box sides also remain connected
when you resize the box. When the [Sticky Lines] option is not active, moving a line or resizing a box may
separate it from a previously connected line.
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You must have the [Horizontal only] or [Vertical only]
movement restriction option selected in the Toolbox
when moving sticky lines connected to other lines.
These movement restrictions do not apply when resizing boxes with Sticky Lines attached, however.
Click on the [Sticky Lines] option to turn it on.
After selecting the line you want to move, or the box
you want to resize:
Select the [Horizontal only] movement restriction
option to move a vertical line left or right. Horizontal lines connected to the vertical line remain
connected, and increase or decrease in length as
you move the vertical line.
Select the [Vertical only] movement restriction option to move a horizontal line up or down. Vertical
lines connected to the horizontal line remain connected, and increase or decrease in length as you
move the horizontal line.
Resize a box horizontally by moving its left or right
side. Horizontal lines attached to that side increase or decrease in length as you move the
side.
Resize a box vertically by moving its top or bottom side. Vertical lines attached to that side increase or decrease in length as you move the
side.
Changing line attributes
To change line width, style or color:
1.

Select a line.
To change the attributes of multiple lines, <Shift>click on each line or use the group feature described in the "AppBuilder basics" chapter.

2.

Select the desired option(s) from the Line
toolbox.
The properties apply to the line(s) you selected.
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Copying lines
To copy a line:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Select the [Copy] option in the Toolbox.

3.

Select the direction for copying: [Horizontal
only], [Vertical only], or [Free].

4.

Select the line you want to copy.
Boxes appear on the line to show it is selected.

5.

Select the number of copies (between 1 and
99) by clicking on the up or down arrows, or
click in the numeric display box and enter a
number.
Press the <Ctrl> key while clicking on the up or
down arrows to increase or decrease the value by
10. You can also backspace over the value and
enter a new value from the keyboard.

6.

Click on the selected line and drag it in the
direction you want to place the duplicate
line(s).

Specifying a fixed distance between multiple copies
To specify a fixed horizontal and/or vertical distance
between multiple element copies:
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1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Select a group of objects in the Work area.

3.

Select [Copy] and your copy options as
above.

4.

Select [Horizontal Copy Distance] or [Vertical
Copy Distance] and enter a value for the
distance between copies.
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5.

Click on the group of objects.
The objects separate by the distance specified in
the [Horizontal Copy Distance] or [Vertical Copy
Distance] option.

Moving lines
You can move a line by entering new coordinates or
by manually moving it on the form.
Changing coordinates manually
To move a line manually:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Select the direction for moving: [Horizontal
only], [Vertical only], or [Free].

3.

Select the line you want to move.
Boxes appear on the line to show it is selected.
and the screen pointer changes to a hand.
If the screen pointer does not change to a hand,
press and hold the <Ctrl> key as you move the
cursor over the line. When the screen pointer
turns into a hand, you can move the line.

4.

Drag the line to a new position.

5.

Release the mouse button.
The line locks in the new position.

Changing position coordinates
To move a line:
1.

Select [Current object Start Coordinates] in
the Toolbar.

ELIXIR APPBUILDER FOR AFP USER GUIDE

5-7

LINES

If you cannot click on this area, make sure the
line is selected and right-click.
2.

Backspace over the current values or press
the <Del> key to delete the whole number.

3.

Enter new coordinate values.

4.

Click the left mouse button or press <Enter>.
The line adjusts to the new coordinates.

When the Sticky lines option is selected, perpendicular lines with ends that connect, and lines attached to
the sides of boxes remain attached when one of the
lines is moved or the box is resized. See the "Sticky
Lines" section for more information.

Deleting lines <Del>
To delete a line:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Select the line you want to delete.
Boxes appear on the line to show it is selected.

3.

Pull down the Edit menu and select [Delete],
or press <Del>.
The line is deleted.

To restore a deleted line, immediately pull down the
Edit menu and select [Undo], press <Ctrl> + <Z>, or
select [Undo] in the Toolbar.
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Shapes

This chapter describes how to draw and edit shapes.
Shapes include boxes, circles, and open and closed
paths.
In the following sections, references are made to options in the Box, Circle, and Path toolboxes. See the
"Toolbar and Toolbox" chapter for more information.

Drawing shapes
To draw a shape, click on the appropriate shape tool
in the Toolbox and select the options for the shape.
If you want a box or path to start and end at grid
points, select [Grid] and [Snap to Grid] in the Toolbar.
If you want a box or path to snap to grid mid-points, as
well as to grid points, set the [Grid Snap to] option to
[Half Grid Units] in the Grid Setting dialog box.
Drawing paths
Apply path properties by selecting options in the Path
toolbox.
To draw a path:
1.

Move the screen pointer into the Work area.

2.

Click the left mouse button and drag the
screen pointer to draw one segment of the
path.

3.

Release the mouse button to finish the
segment.
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4.

To draw the next segment, repeat the above
procedure.
The next segment begins where the last segment
ended.

5.

To end a path, double-click the left mouse
button or select the [Finish Drawing] option in
the Path toolbox.

Drawing boxes
Apply box properties by selecting options in the Box
toolbox.
To draw a box:
1.

Position the screen pointer where you want a
box corner in the Work area.

2.

Press and hold the left mouse button.

3.

Drag the screen pointer to form the shape of a
box.

4.

Release the mouse button to finish the box.

Use the arrow keys to pan around the screen when
drawing a box that extends beyond the Work area.
Drawing circles
Apply properties to a circle by selecting options in the
Circle toolbox.
To draw a circle:
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1.

Move the screen pointer into the Work area.

2.

Click the left mouse button and drag the
screen pointer to form a circle.

3.

Release the mouse button to finish the circle.
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Editing shapes
To change the properties of a shape, you must first
select it.
To select a shape:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Place the cursor on the shape you want to
edit.
Arrows display around the shape.

3.

Click the right mouse button.
The Toolbox displays the options for that shape.
Boxes appear around or inside the shape to show
it is selected.

Changing shape size
You can change the size of a selected shape by typing
in new dimension coordinates or by stretching the
shape on the form.
Changing dimension coordinates
To change the shape dimension coordinates:
1.

Select [Current object Dimensions] in the
Toolbar.
If you cannot click on the current values, make
sure the shape is selected and click the right
mouse button.

2.

Backspace over the current values or press
the <Del> key to delete the whole number.

3.

Enter new coordinate values.
Use the <-> key to enter a negative value if
allowed.
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4.

Click the left mouse button or press <Enter>.
The shape adjusts to the new coordinates.

Stretching a shape
To change
manually:
1.

the

shape

dimension

coordinates

Place the cursor on one of the boxes around
the shape.
The cursor changes to a double-ended arrow.

2.

Drag the cursor until the shape reaches the
new size.

3.

Release the mouse button.

When the Sticky Lines option is on, lines attached to
the sides of a box remain attached when the box size
is changed. See the "Sticky Lines" section for more
information.
Changing shape attributes
To change an attribute of a shape:
1.

Select a shape.

2.

Select an option from the shape's toolbox.
If the shape's toolbox does not display, reselect
the shape, then right-click.

3.

To change the attributes of multiple shapes,
shift-click on each shape.
The selected properties apply to all the selected
shapes, if available.

See the "AppBuilder basics" chapter for more information on grouping elements.
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Copying shapes
To copy a shape:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Select the [Copy] option in the Toolbox.

3.

Select the direction for copying: [Horizontal
only], [Vertical only], or [Free].

4.

Select the shape you want to copy.
Boxes appear on the shape to show it is selected.

5.

Select the number of copies (between 1 and
99) by clicking on the up or down arrows, or
click in the numeric display box and enter a
number.
Press the <Ctrl> key while clicking on the up or
down arrows to increase or decrease the value by
10. You can also backspace over the value and
enter a new value from the keyboard.

6.

Select the selected shape and drag it in the
direction you want to place the duplicate
shapes.

Specifying a fixed distance between multiple copies
To specify a fixed horizontal and/or vertical distance
between multiple element copies:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Select a group of objects in the Work area.

3.

Select [Copy] and your copy options as
above.

4.

Select [Horizontal Copy Distance] or [Vertical
Copy Distance] and enter a value for the
distance between copies.
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5.

Click on the group of objects.
The objects separate by the distance specified in
the [Horizontal Copy Distance] or [Vertical Copy
Distance] option.

Moving shapes
You can move a shape in the Work area manually or
by changing its dimension coordinates.
Manually
To move a shape manually:
1.

Select the Toolbox Select/Edit tool.

2.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3.

Select the shape to move.
Boxes display around the shape to show it is
selected.

4.

Click and drag the selected shape to a new
position, then release the mouse button.
The screen pointer changes to a hand when you
select the shape. If it does not, the shape may be
too small. If this happens, press and hold <Ctrl>
you move the cursor over the shape.
The shape locks in the new position.

Changing dimension coordinates
To move a shape using dimension coordinates:
1.

Select the Toolbar Current Object - Start
Coordinates area.
If you cannot click on this area, select the shape
again, then right-click.
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2.

Backspace over the current values or press
the <Del> key to delete the current values,
enter new coordinate values, then press
<Enter>.
The shape moves to the new coordinates.

Deleting shapes <Del>
To delete a shape:
1.

Select the Select tool from the Toolbox or pull
down the Tools menu and select [Select].

2.

Select the shape you want to delete.
Boxes appear around the shape to show it is
selected.

3.

Pull down the Edit menu and select [Delete],
or press the <Del> key.
The shape is deleted.

To restore a deleted shape, immediately pull down the
Edit menu and select [Undo], press <Ctrl> + <Z>, or
select [Undo] in the Toolbar.
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Text operations

This chapter describes the available text operations.
In the following sections, references are made to options in the Text toolbox. See the "Toolbar and Toolbox" chapter for more information.

Creating text
You can create text using either Elixir-generic or
screen fonts, TrueType fonts, or ATM fonts. You can
insert text either by entering text directly from the keyboard or by importing text from an ASCII file.
Apply text properties by selecting options from the
Text toolbox.
Entering text from the keyboard
To enter text directly from the keyboard:
1.

Select the text attributes from the Text
toolbox.

2.

Select the [Load Font List] (down arrow)
option.
The Load Font List dialog box displays.

3.

Select a font list, then click on [OK].
The selected font list displays in the Font Preview
Panel.

4.

Select a font, then click in the Work area
where you want the text to appear.
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You can change the font as you type, to apply the
new font to subsequent text.
5.

Type your text, then right-click when done.
Entered text displays in the Work area.

Moving a block before finished entering text
To move a text block before you finish entering text:
1.

Press and hold down the <Ctrl> key.

2.

Place the cursor on the text block.

3.

Click and drag the text block to a new
location.

4.

Release the mouse button to place the text.

To move a text block after you finish entering text, see
the "Moving text" section in this chapter.

Importing text
AppBuilder allows you to import ASCII text as a complete file or as separate text blocks (separated by two
carriage returns) from the directory specified in the Filing
Options
dialog
box.
The
default
is
drive:\ELIXIR\TEXTS.
You can apply attributes to an imported text block by
selecting the attributes from the Text tool before importing each block.
Before you import text, you must:
Copy the ASCII file to the text directory specified
in the Filing Options dialog box
Assign the ASCII file a .TXT extension
Separate paragraphs (or text blocks) with two carriage returns
7-2
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Importing text blocks
1.

Select the Text tool in the Toolbox.
The Text toolbox displays.

2.

Select text attributes in the Text toolbox.

3.

Select [Text/Font Options] from the Options
menu.
The Text and Font Options dialog box displays.

4.

In the Text Import Options field:
Select [Lock position] to load each text block
directly below the previous block.
or
Select [Separate paragraphs] to load subsequent text blocks wherever you click in the
Work area.
You can also press <F11> to toggle between the
two text placement modes. The Message area
displays the current setting.

5.

Select [Import Text] from the File menu.
The Import Text dialog displays the files in the
drive:\ELIXIR\TEXTS or assigned directory.

6.

Select the file you want to load, then click on
[OK].

7.

Press and hold the screen pointer to display
the first text block.
To scroll through the text blocks, continue
holding down the mouse button.
To scroll to the previous text block, press
<F3>.
To scroll to the next text block, press <F4>.

8.

Drag the text and release the mouse button to
place the first text block on the form.
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9.

Click to display and place the next text block.

10. Click on [OK] when done.
When you import an ASCII file, the complete file
attaches to the cursor for positioning unless you
select the [Lock position] option in the Text and
Font Options dialog box. When text is locked, the
text file attaches to the previous cursor position in
the Work area.
The selected font size and the amount of loaded
text determines whether or not the whole ASCII
file can fit on a form.
Importing text into a box
When importing text into a text box, you must define
the text box size first. See the "Specifying text attributes" section in this chapter for information about
boxed text.
Text imported into a box does not respect original carriage returns. To maintain the carriage returns from
the original text, make sure [Box Text] and [Wrap
Text] are deselected.

Specifying column boundaries
You can specify column boundaries by entering coordinates or by drawing a box manually, or you can enter free text.
When you enter text with specified column boundaries, make sure you select [Wrap Text] and select the
text positioning to [Top], [Center] or [Bottom]. Press
<Enter> to insert carriage returns and begin new paragraphs. Click the right mouse button to finish entering
text in the box.
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Entering coordinates
To enter values for column boundaries:
1.

Select [Box Text] in the Text toolbox.

2.

Enter [Column Width] and [Column Height]
values.

3.

Click in the Work area.
A temporary text box with the specified boundaries displays.

Drawing a text box
To draw a text box manually:
1.

Select [Box Text] in the Text toolbox.

2.

Select [Draw Text Box].

3.

Place the cursor in the Work area and press
and hold down the left mouse button.

4.

Drag the box and release the button at the
bottom right of the box.
This box is not the same as a box you draw using
the Box tool. It is used only as a visual aid for defining the column width and height for a text
block.
You can now enter text in the box.

Entering free text
When the [Box Text] option is deselected, you can enter free text. Free text is bound by the width and
height of the form or by the width and height specified
in the [Column Width] and [Column Height] options. If
you use the [Column Width] and [Column Height options, make sure you select [Wrap Text]. When entering free text, press <Enter> to move to a new line.
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Selecting a font
You can select a font from either the current Font List
or a new font list you load. You can also merge, modify, and save font lists.
The current Font List displays in the Toolbox Preview
panel with the font in use highlighted. You can normally recognize the font family and the size, style, and
orientation of a font from the file name.
The Font List displays one or more of the following
fonts:
Elixir-generic format .(HDR) or screen font files
(.FNT)
ATM fonts
TrueType fonts
You can use contour fonts to generate additional fonts
for use in AppBuilder. See the Elixir Desktop and
Converters for AFP User Guide for more information.
You can also create or edit fonts using the ElixirFont
application. See the ElixirFont for AFP User Guide for
more information.
Selecting a font from the current Font List
To select a font from the current list, click on a font
name in the Preview panel. Use the up or down arrow
keys or the scroll bar on the right of the display window to scroll through the list.
You can use multiple fonts (of the same orientation
only) in any text block by selecting different fonts as
you enter text. The font changes from the cursor forward, until you select another font.
Loading a new Font List
The [Font List] option in the Text toolbox allows you to
load a new font list.
To load a different Font List:
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1.

Click on the down arrow under the [Font List]
option.
The Load Font List dialog box displays.

2.

Select a font list file (.LST) and click on [OK].
The selected Font List displays in the Toolbox
preview panel.

3.

Select a font.

Merging font lists
The [Font List] option in the Text toolbox allows you to
merge two or more font lists.
To merge a font list with the current Font List:
1.

Click on the double arrows under the [Font
List] option.
The Merge Font List dialog box displays.

2.

Select the font list file (.LST) you want to
merge into the current Font List.

3.

Click on [OK].
The fonts in the file you merge are added to the
current Font List.

Adding fonts to the Font List
AppBuilder allows you to add Elixir, TrueType, or ATM
fonts individually or in groups to the Font List.
To add one or more fonts to the Font List:
1.

Click on the [Font Type] option until the
desired
font
type
displays
(a=ATM,
T=TrueType, f=Elixir).

2.

Select the [Add Font] ([+]) option.
Depending on the [Font Type] selected, either the
Select ATM Fonts, Select TrueType Fonts, or Add
Fonts dialog box displays.
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3.

Select the font to add (and font
characteristics, if applicable), then click on
[OK]. To multi-select fonts, <Ctrl>-click on
subsequent fonts.
The font(s) is added to the current Font List.
Repeat these steps for each font type you want to
add.

Removing fonts from the Font List
To remove a font from the current Font List:
1.

Select the font name in the Preview panel.

2.

Click on the [Delete Font] ([-]) option.
The font is removed from the Font List. You cannot remove a font that is in use on your form.
You can also <Ctrl>-click on the [-] button to delete all unused fonts from the Font List.

Saving custom Font Lists
You can change an existing Font List and save it with
a new name, or overwrite the existing Font List.
To save a custom font list:
1.

Click on the up arrow under the [Font List]
option.
The Save Font List dialog box displays.

2.

Enter a new file name to save a custom Font
List with a unique name, or enter an existing
file name to overwrite the existing Font List.

The Font List saves with the new fonts.
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Soft keyboard
The soft keyboard allows you to enter characters that
are not available on a standard keyboard.
Typing extended characters
To type an extended character:
1.

Place the cursor in the Work area where you
want the character to display.

2.

Select [Soft Keyboard] in the Text toolbox.
The soft keyboard displays.
Figure 7-1. Soft Keyboard

3.

Select a character from the soft keyboard.
The character displays in the selected position.

4.

Deselect the [Soft Keyboard] option when
complete.

The soft keyboard displays characters in the current
font size, so small fonts may be difficult to read. You
can change the current font to a larger point size, edit
using the soft keyboard, then change the text block
back to the smaller font after completing the edit.
You can also access non-standard keyboard characters by typing the decimal value of the character.
Press <Alt> and enter the decimal value using the numeric keypad.

Inserting data tags
AppBuilder allows you to add data tags for use with
DocuTag or DataMerge, if installed. See your DocuTag User Guide or DataMerge User Guide for more
information.
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Editing text
When editing text, the name of the font used to create
the text is highlighted in the Font List window. You
must select a text block before you can edit it.
To select a text block:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].
You can also change to select mode by clicking
on the text with the right mouse button. However,
if you are still in add text mode, the right mouse
click ends text entry and a second click is necessary to change to select mode.

2.

Place the cursor on the text block you want to
edit and right-click.
The Text toolbox displays.

Changing text attributes
To change the attributes of a selected text block, select options in the Text toolbox. The new attribute(s)
is applied to the selected text block.
Applying color to text
You can apply color to new text you type, or to existing
text.
New text
1.

Select the Text tool.
The Text toolbox displays.

2.

Select a font.

3.

Select the [Color] option.
The Color dialog box displays.

4.
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Select a color.
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5.

Click in the Work area and begin to type.
Text displays in the color you selected, and continues for all subsequent text blocks until you select another color.

6.

Right-click to end text entry.

Existing text
You can add color to existing text; partial blocks or full
blocks.
1.

Select the text or text block and right-click.
The Text toolbox displays.

2.

Select the [Color] option.
The Color dialog box displays.

3.

Select a color.
The color is applied to the selected text.

Changing the font in an entire text block
To change the font throughout a text block:
1.

Select the text block and right-click.
The Text toolbox displays.

2.

Place the cursor at the beginning of the text
block.

3.

Select a font in the Font List.
The new font applies to all text in the text block.
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Changing the font within a text block
To change the font of a word or phrase in a text block:
1.

Select the text block and right-click.
The Text toolbox displays.

2.

Click in front of the word or phrase you want
to change and drag the mouse to highlight the
text.

3.

Select a new font from the Font List.
The font is applied to the selected text.

Multiple fonts in a text block
When editing text, the name of the font used to create
the text is highlighted in the Font List window. If multiple fonts exist within a text block, the font highlighted
changes as you place the cursor on the different fonts.
All fonts in the text block must have the same orientation. If you want to use a font with a different orientation, place the cursor at the beginning of the text block
and apply the orientation to all fonts in the text block.
Changing the font from a specific location forward
To change the font from a specific location in a text
block to the end of the block:
1.

Select the text block and then right-click.
The Text toolbox displays.

2.

Click in the location where you want the new
font to start.

3.

Select a font from the Font List.
All text following the cursor changes to the font
you select.

When changing the font in this manner, AppBuilder
adds a hidden control character just before the
changed text. The character contains font information,
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and you can delete it by placing the cursor at the beginning of the changed text and pressing <Del>. Deleting the control character changes the text back to
its original font.
Replacing fonts in a text block
You can replace every occurrence of a particular font
with a new font.
To replace every occurrence of a font:
1.

In the Font List, select the font you want to
replace.

2.

Select the [Delete Font] ([-]) option.
If the font is in use in the document, the Replace
Font dialog box displays.

3.

Select a replacement font.
You cannot replace a font with a font that is already used on the form. If the replacement font is
not currently in use on the form, all occurrences
of the font are replaced by the replacement font.

If the font you try to replace is not used on the form, it
is removed from the Font List. See the "Removing
fonts from the Font List" section for more information.
Joining text
AppBuilder allows you to rejoin text separated during
form conversion to Elixir format.
To join text:
1.

Select [Text/Font Options] from the Options
menu.
The Text and Font Options dialog box displays.

2.

Select an option in the Join Text Using field:
[Spaces], [Justify] or [Relative], then click on
[OK].
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See the "Menu bars" chapter for information on
the Text and Fonts Options dialog box.
3.

Group the text you want to join.
The [Join Text] option displays in the Select/Edit
toolbox.
See the "AppBuilder basics" chapter for information about defining a group.

4.

Select the [Join Text] option.
The text in the group joins.

Splitting text
To split a text block into two separate blocks:
1.

Select the text block to split, then right-click.
The Text toolbox displays.

2.

Place the cursor where you want to split the
text.

3.

Select the [Split String] option in the Text
toolbox.
The text splits and the cursor displays in the upper left corner of the new text block.

See the "Moving text" section for information on repositioning the text block.
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Moving existing text
You can move a text block by dragging it on a form or
by changing its position coordinates.
Moving text manually
To move an existing text block manually:
1.

Select the Toolbox Select/Edit tool.

2.

Select the direction for moving: [Horizontal
only], [Vertical only] or [Free].

3.

Select the text block to move.
The cursor changes to a hand.

4.

Click and drag the text block to where you
want it on the form.

5.

Release the mouse button to accept the text
position.

Moving text by changing position coordinates
To move the text block by changing its position
coordinates:
1.

Select the Toolbar Current Object - Start
Coordinates area.
If you cannot click on this area, select the text
again, then right-click.

2.

Backspace over the current values or press
the <Del> key to delete the current values and
enter new values, then press <Enter>.
The text moves in relation to the new coordinates.
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Copying text
You can copy a text block using the Toolbox [Copy]
option or the Edit menu options.
To copy a text block using the Toolbox:
1.

Select the Toolbox Select/Edit tool.

2.

Select the [Copy] option.

3.

Select the direction for copying: [Horizontal
only], [Vertical only] or [Free].

4.

Select the text block to copy.
Brackets appear around the text to show it is
selected.

5.

Enter a value or click on the up or down
arrows to select the number of copies
between 1 and 99.
<Ctrl>-click on the arrows to increase or decrease
the value by 10. You can also backspace over
the value and enter a new value.

6.

Drag the text block in the direction you want
to place the copies.

7.

Release the mouse button at the desired location.
The copies lock into position in the Work area.

To cut, copy, and paste text using the Edit menu:
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1.

Select the Toolbox Select/Edit tool.

2.

Right-click on the text block.

3.

Select the text to be cut or copied.

4.

Select [Cut] or [Copy] from the Edit menu.
Alternatively, press <Ctrl>+<X> to cut text, or
<Ctrl> + <C> to copy text.

5.

Right-click to end text selection.
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6.

Select the Toolbox Text tool.

7.

Click at the new location.

8.

Select [Paste] from the Edit menu.
Alternatively, press <Ctrl> + <V> to paste text.

Specifying a fixed distance between multiple copies
To specify a fixed horizontal and/or vertical distance
between multiple element copies:
1.

Select the Toolbox Select/Edit tool.

2.

Select a group of objects in the Work area.

3.

Select [Copy] and your copy options.

4.

Select [Horizontal Copy Distance] or [Vertical
Copy Distance] and enter a value for the
distance between copies.

5.

Click on the group of objects.
The objects separate by the distance specified in
the [Horizontal Copy Distance] or [Vertical Copy
Distance] option.

Deleting text
To delete text:
1.

Select the text to delete.

2.

Press <Del>.
The selected text deletes.

To restore deleted text, immediately select [Undo]
from the Edit menu, click on the Toolbar Undo icon or
press <Ctrl> + <Z>.
Finding/replacing text
AppBuilder allows you to find text and non-standard
keyboard characters, and to replace occurrences of
word(s) on a form.
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Finding text
To find text:
1.

Select [Find] from the Edit menu.
The Find Text dialog box displays.

2.

In the [Find Text] option, enter the text you
want to find , then click on the [Find] button.

To find non-standard keyboard characters:
1.

Select [Find] from the Edit menu.
The Find Text dialog box displays.

2.

In the [Find Text] option, enter the character's
decimal value (from the Windows character
mapping table), then click on the [Find]
button.

The Find Text dialog box contains the following
options:
Find Text
Enter a search text string or select one from the dropdown list.
Case Sensitive
Searches for text with the same capitalization as the
text in the [Find Text] option.
Whole Words
Searches for complete words that match the text in
the [Find Text] option.
For example, searching for “the” returns only “the” and
not words containing “the”, such as ”there”.
Find
Searches the open form for the text selected/entered
in the [Find Text] option.
Cancel
Closes the Find Text dialog box.
Help
For future implementation.
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Once you start a Find session, you can press <Ctrl> +
<F3> to find the next occurrence of the target text;
and <Ctrl> + <Shift> + <F3> to find the previous occurrence of the target text.
Replacing text
To replace occurrences of a word:
1.

Select [Replace] from the Edit menu.
The Replace Text dialog box displays.

2.

Select/enter search and replace options, then
click on the [Replace] or [Replace All] button.

The Replace Text dialog box contains the following
options:
Find text
Enter a search text string or select one from the dropdown list.
Replace by
Enter a replacement text string or select one from the
drop-down list.
Case Sensitive
Searches for text with the same capitalization as the
text in the [Find text] option.
Whole Words
Searches for complete words that match the text in
the [Find text] option.
For example, searching for “the” returns only “the”,
and not words containing “the”, such as ”there”.
Replace
Replaces the current instance of text in the [Find text]
option text with the text in the [Replace by] option.
Replace All
Replaces all instances of text in the [Find text] option
with the text in the [Replace by] option.
Cancel
Closes the Replace Text dialog box.
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Help
For future implementation.

Spell checking
If installed, the AppBuilder Spell Checker option allows you to identify misspelled words in your form.
Setting defaults
To set spell check defaults:
1.

Select [Spell Check Options] from the Options
menu.
The Spell Check Options dialog box displays.

Figure 7-2. Spell Check Options dialog box
2.
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Select spell check options, then click on [OK].
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The Spell Check Options dialog box contains the following options:
Language
Select the language to use from the drop-down list.
Dialect/mode
Select the dialect/mode for the selected language
from the drop-down list.
Lexicon Supplements
Select a terminology dictionary:
[Business/Insurance/Finance] - contains business, insurance, or financial terminology
[Medical] - contains medical terminology
[Legal] - contains legal terminology
[Science] - contains scientific terminology
Processing Correction Defaults
These options are used only when errors are found:
[Provide Alternatives If Not Found] - provides alternative words if a word is not found in the
database
[Provide Alterns. From Personal Dictionary] - provides alternative words from active personal dictionaries after alternatives from the active
database are retrieved
[Perform Space Insertion] - inserts spaces between incorrectly spaced words; For example, the
string "andthe" is corrected to "and the".
[Remove Final Period] - strips the final period
from a word before it is submitted for correction
Personal Dictionaries
Displays the dictionary files (*.RD) available for use.
New
Enter a name for the new personal dictionary in the
Create Personal Dictionary dialog box.
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Add
Select an existing personal dictionary (*.?D) to add to
the Personal Dictionaries list in the Add Personal Dictionary dialog box.
Remove
Removes the selected dictionary from the Personal
Dictionaries list.
Edit
Edits entries in the dictionary selected in the Personal
Dictionaries list.
Click on the [Add], [Delete], or [Replace] button to perform the appropriate action for the word that displays
in the Edit word field in the Edit Personal Dictionary
dialog box.
Spell Check Typing
Activates the spell check option after you type a word.
Once you enter a word and press the space bar, the
word is spell checked.
Using the Spell Checker
To use the Spell Checker:
1.

Click on the Toolbar Spell Check icon or
select [Spell Check] from the Tools menu.
The Spell Checker checks all text in the current
form for misspelled words.
If Spell Checker does not recognize a word, the
Spell Check dialog box displays. The unrecognized word displays in the [Edit] option, and if applicable, an alternate word displays in the [Guess]
option.
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2.

If the word displayed in the [Guess] option is
not correct, select an alternate word from the
drop-down list.

3.

If the word is not found in the drop-down list,
backspace over the misspelled word in the
[Edit] option, then enter the correct spelling.

4.

Select one of the following options:
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Replace
Replaces the misspelled word with the the word in
the [Edit] option.
Replace All
Replaces all instances of the misspelled word
with the word in the [Edit] option.
Ignore
Ignores the first occurrence of the word in the
[Edit] option.
Ignore All
Ignores all occurrences of the word in the [Edit]
option.
Stop
Stops spell checking and closes the Spell Check
dialog box.
A 'beep' indicates when the spell check operation
is complete.

Keyboard shortcuts
The following fast keys are used for text operations:
<Left arrow>

Move cursor left one
character

<Up arrow>

Move cursor up one line

<Right arrow>

Move cursor right one
character

<Down arrow>

Move cursor down one line

<Home>

Move cursor to start of line

<End>

Move cursor to end of line

<Ctrl> + <Left arrow>

Move cursor left one word

<Ctrl> + <Right arrow

Move cursor right one word
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<Ins>

Insert/Overwrite toggle

<Del>

Delete character right

<Backspace>

Delete character left

<Ctrl> + <Del> Delete next word
<Ctrl> + <Bksp>

Delete previous word

<Ctrl> + <K>

Delete to end of line

<Ctrl> + <E>

Delete to end of text block

<Ctrl> + <Home>

Move cursor to start of text
block

<Ctrl> + <End>

Move cursor to end of text
block

<F11>

Lock/free text

<Ctrl> + <T>

Show/hide data tags

<Ctrl> + <X>

Cut text

<Ctrl> + <C>

Copy text

<Ctrl> + <V>

Paste text

<Alt> + <F3>

Find

<F3>

Find Next

<Shift> + <F3> Find Previous
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<Ctrl> + <F3>

Find Selected (forward)

<Ctrl>+<Shift>+<F3>

Find Selected (reverse)
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Images

AppBuilder uses Elixir-format black-and-white or fullcolor images, or .BMP images. You can use the Elixir
Desktop to convert black-and-white .PCX and .TIF
files to Elixir format.
The available size of an image depends on the
amount of memory available in Windows and any
printer limitations. See your Elixir Desktop and Converters for AFP User Guide for more information.
The screen version of an image has a .LW8 extension
and is in the drive:\ELIXIR\PICS\SCREEN directory.
The printer version of an image has an .LP3 extension
and is in the drive:\ELIXIR\PICS\PRINTER directory.
See your ElixirImage for AFP User Guide for more
information.
In the following sections, references are made to options in the Image toolbox. See the "Toolbar and
Toolbox" chapter for more information.

Loading an image
To add an image to your form:
1.

Select the Image tool in the Toolbox.
The Image toolbox displays.

2.

Select [Load Image].
The Load Image dialog box displays.

3.

At the bottom of the dialog box, select the
extension for the file type you want to load.

4.

Select an image and click on [OK].
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5.

Press and hold the left mouse button.
The image attaches to the screen pointer.

6.

Position the image on the form and release
the left mouse button to fix it in place.

Editing images
You can only edit Elixir images using ElixirImage software. See your ElixirImage for AFP User Guide for
more information.

Moving an image
You can move an image by entering new coordinates
or by manually moving it on the form.
Moving an image manually
To move an image manually:
1.

Select the Select tool in the Toolbox.

2.

Select the direction for moving: [Horizontal
only], [Vertical only], or [Free].

3.

Click on the image you want to move.
Boxes appear around the image to show it is
selected.

4.

8-2

Drag the image to the new location. Release
the mouse button to lock the image on the
form.
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Moving an image by changing position coordinates
To move an
coordinates:
1.

image

by

changing

its

position

Click in the [Toolbar Current Object - Start
Coordinates] area.
If you cannot click on this area, select the image
again, then right-click.

2.

Backspace over the current values or press
the <Del> key to delete the current values and
enter new values, then press <Enter>.
The image moves in relation to the new
coordinates.

Copying an image
To copy an image:
1.

Select the Select tool in the Toolbox.

2.

Select the image you want to copy.
Boxes appear around the image to show it is
selected.

3.

Select the [Copy] option in the Toolbox.

4.

Select the number of copies (between 1 and
99) by clicking on the up or down arrows, or
click in the numeric display box and enter a
number.
<Ctrl>-click on the up or down arrows to increase
or decrease the value by 10. You can also backspace over the value and enter a new value.

5.

Select the direction for copying: [Horizontal
only], [Vertical only], or [Free].

6.

Select the image and drag it in the direction
you want the duplicate images to display,
then release the mouse button.
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The image displays in the new positions.
Specifying a fixed distance between multiple copies
To specify a fixed horizontal and/or vertical distance
between multiple element copies:
1.

Select the Select tool in the Toolbox or pull
down the Tools menu and select [Select].

2.

Select a group of objects in the Work area.

3.

Select [Copy] and your copy options as
above.

4.

Select [Horizontal Copy Distance] or [Vertical
Copy Distance] and enter a value for the
distance between copies.

5.

Click on the group of objects.
The objects separate by the distance specified in
the [Horizontal Copy Distance] or [Vertical Copy
Distance] option.

Deleting an image
To delete an image:
1.

Select the image you want to delete.
Boxes appear around the image to show it is
selected.

2.

Press <Del>.
The image is deleted.

To restore a deleted image, immediately pull down the
Edit menu and select [Undo], press <Ctrl> + <Z>, or
select [Undo] in the Toolbar.
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PageDef window

This chapter provides a detailed description of the
PageDef window and its features. Where applicable,
references to other chapters or sections in this chapter are given for more detailed information.
Select a menu or sub-menu to display its options, then
select an option from the pull-down menu.

PageDef window
To open the PageDef window, pull down the File
menu and select the PageDef sub-menu, then select
[New PageDef] or [Load PageDef]. You can also pull
down the Window menu and select [PageDef] if a
PageDef is already open.
When only a PageDef is loaded (no FormDef), PageFormats display with the 0,0 origin in the top left corner of the Work area. The PageDef window displays
below the Work area and displays the PageDef tree.
See the "Adding objects to the PageDef tree" section
for more information.
PageDef
menu bar

PageDef
Toolbar
PageDef
tree

Figure 9-1. PageDef window
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Overview of the features
The following is an overview of the PageDef window
features. This section refers you to other sections in
this chapter where the features are explained in detail.
Menu bar
AppBuilder provides menus and sub-menus to access
PageDef options. PageDef menu bar options are described in the "PageDef menu bar" section and the
"Menu bars" chapter.
Toolbar
The PageDef Toolbar displays across the top of the
PageDef window and includes +P, +S. +R, +F, Conditional Logic, Floating Page Segment, Floating Overlay, Properties and Delete options. PageDef Toolbar
options are described in the "PageDef Toolbar" "
section.
PageDef tree
The PageDef tree displays below the PageDef Toolbar and provides a hierarchical breakdown of the elements in the current PageDef. See the "Adding
objects to the PageDef tree" section for more
information.

PageDef menu bar
The PageDef menu bar contains the Pgfmt, Edit, and
View menus.
Pgfmt
The options in this menu allow you to set the PageFormat properties and options. See the "Menu bars"
chapter for more information.
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Edit
The options in this menu allow you to cut, copy, paste,
and delete PageDef window contents. See the "Menu
bars" chapter for more information.
When you copy a PageFormat, AppBuilder automatically changes the [Short name] of the copy to prevent
two PageFormats from having the same name.
View
The options in this menu allow you to control the column headings in the PageDef window.
PageFormats
Select this option to set the column headings to display PageFormat information.
Records
Select this option to set the column headings to display Record information.
Fields
Select this option to set the column headings to display Field information.
None
Select this option to display no column headings.
Expand All <Shift> + <*>
Select this option to expand the PageDef tree.
Collapse All <Shift> + </>
Select this option to display the PageDef tree with only
the PageFormat names visible.
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Window on Top
Select this option to keep the PageDef window on top
in the display.

PageDef Toolbar
The PageDef Toolbar displays across the top of the
PageDef window :
Add
PageFormat

Add
SubPage

Add
Field

Add
Record

Conditional
Logic

Add
Floating Overlay Delete

Add
Floating
Segment

View
Properties

Figure 9-2. PageDef Toolbar
The PageDef Toolbar contains the following options:
+P
Select this option to add a page format to the
PageDef. See the "Adding objects to the PageDef
tree" section for more information.
+S
Select this option to define a SubPage in the PageDef.
A SubPage icon is added that defines the extent of
the SubPage. You can only add SubPages when
there are two or more consecutive Records defined
under a PageFormat.
+R
Select this option to add a Record to the PageFormat.
See the "Adding objects to the PageDef tree" section
for more information.
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+F
Select this option to add a Field to the PageFormat.
See the "Adding objects to the PageDef tree" section
for more information.
Conditional Logic
Select this option to add conditional logic to a selected
Record. In PPFA, conditional testing is performed at
the Record level. Consequently, AppBuilder displays
the condition object below its associated Record.
To edit a condition, select the condition and right click
or select the [Properties] option from the PageDef
Toolbar. The condition option is available only when a
Record is selected. See the "Conditional Logic" section in this chapter for more information.
Floating Page Segment
Select this option to display the Floating Segment dialog box which allows you to add a floating page segment to the currently selected Record.

Figure 9-2. Floating Segment dialog box
The Floating Segment dialog box contains the following options:
Segment name
Enter a segment name or select one from the Select
Page Segment dialog box that displays from the [Select] button.
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Position Horizontal/Vertical
Enter the horizontal and vertical offset values. Values
are offset from the location of the related Record.
Floating Overlay
Select this option to display the Floating Overlay dialog box which allows you to add a floating overlay to
the currently selected Record.

Figure 9-3. Floating Overlay dialog box
The Floating Overlay dialog box contains the following
options:
Overlay name
Enter an overlay name or select one from the Select
Overlay dialog box that displays from the [Select]
button.
Position Horizontal/Vertical
Enter the horizontal and vertical offset values. Values
are offset from the location of the related Record.
Properties
Select this option to display the properties of a selected object in the PageDef window.
The following objects/properties are available for viewing:
PageDef
Font List
PageFormat
Segment List
Overlay List
Record
9-6

ELIXIR TECHNOLOGIES CORPORATION

PAGEDEF WINDOW

Conditional Logic
Field
See the "Viewing element properties" section for more
information.
PageDef
Select this option to display the PageDef Properties
dialog box with options for naming a PageDef and
specifying defaults. See the "Menu bars" chapter for
more information.
Font List
Select this option to display the Font List dialog box
with options for specifying font settings. See the
"Toolbar and Toolbox" chapter for more information.
PageFormat
Select this option to display the PageFormat Properties dialog box with options for naming a PageFormat
and specifying settings. The PageFormat name displays to the left of the Properties button in the Toolbox. See the "Toolbar and Toolbox" chapter for more
information.
Segment List
Select this option to display the Page Segments dialog
box with options for selecting, adding to or deleting
page segments from a list of PageSegments that is
loaded to the printer before the active page is printed.
See the "Menu bars" chapter for more information.
Overlay List
Select this option to display the Line Data Overlays
dialog box which allows you to call overlays from the
print data stream. See the "Menu bars" chapter for
more information.
Record
Select this option to display the Record Properties dialog box with options for naming a Record and
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specifying defaults. The Record name displays to the
left of the Properties button in the Toolbox. See the
"Toolbar and Toolbox" chapter for more information.
Conditional Logic
Select this option to display the Conditional Logic dialog box with options for naming a condition and specifying settings.

Figure 9-4. Conditional Logic dialog box
The Conditional Logic dialog box contains the following options:
Condition
Enter a reference name for the condition. This
name displays in the PageDef window.
Short name
Enter a name with 1-8 alphanumeric characters.
This name is written to the output file at conversion time.
ANSI CC
Select this option to enable ANSI carriage controls for spacing ("SPACE_THEN_PRINT").
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Start
Enter the number of bytes from the first data byte
in the Record to the starting point of the comparison Field within the data Record where the comparison is to be made.
Length
Enter the number of bytes (1-8000) in the data
Record to be compared. This value must match
the [Actual Length] value.
List of Whens
This option displays the Logic window which lists
logical tests and actions that occur when the current condition is accessed.
Cut
Select this option to cut selected Whens from the
[List of Whens] to the Clipboard.
Copy
Select this option to copy selected Whens from
the [List of Whens] to the Clipboard.
Paste
Select this option to insert cut or copied Whens
from the Clipboard to the [List of Whens].
Current When
Add
Select this option to add a duplicate entry of the
selected When in the [List of Whens].
Current When
Change
Select this option to post changes to the selected
When in the [List of Whens].
Current When
Delete
Select this option to delete the selected When in
the [List of Whens].
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This is
This option displays the total number of Whens,
as well as the position number of the current
When.
Select [When] for all conditional comparison parameters except the last one (if the last is an Otherwise). To set the last When to Otherwise,
select the last When and select [Otherwise].
Change/=/!=/>/>=/</<=
This option allows you to specify the type of comparison to be performed by the data in the comparison Field (specified in [Start] and [Length])
and the text displayed in the [Comparison Text]
box below this option.
Select [Change] to compare the contents of the
comparison Field with the contents of the same
Field the last time this test was performed.
Select [=] for an 'equal to' comparison.
Select [!=] for a 'not equal to' comparison.
Select [>] for a 'greater than' comparison.
Select [>=] for a 'greater than or equal to'
comparison.
Select [<] for a 'less than' comparison.
Select [<=] for a 'less than or equal to'
comparison.
Comparison Text
Displays the text string for comparison to the data
in the comparison Field.
Duplicate
Enter the number of times the text string in the
[Comparison Text] box is to be repeated. The default value is 1.
For example, if the text string is 'AB' and the duplication number is 3, the string for comparison is
'ABABAB'.
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Length
Enter the number of bytes for the length of text.
This number automatically increases as you add
text to the [Comparison Text] box.
Type
Specify the type of text from the drop-down list
that displays. Select [Char] for single-byte code
characters (default) or [Hex] for text with hexadecimal codes. For hexadecimal text, you must
enter character pairs with values ranging from '00'
to 'FF' in the [Comparison Text] box. The
[Length] value increases by 1 each time you enter
a pair.
Actual Length
Displays the actual length of the text string, including hexadecimal codes and duplication. This
value must match the [Length] value.
Process/current
This option allows you to specify when processing
will occur and what will trigger processing.
Select [BEFORE] for processing to occur before
the current line or SubPage is processed
(default).
Select [AFTER] for processing to occur after the
current line or SubPage is processed.
Select [LINE] for processing to occur before or after the current line.
Select [SUBPAGE] for processing to occur before
or after the current SubPage (default).
CopyGroup action
Specify a CopyGroup to be invoked from the
drop-down list that displays.
Select [CURRENT] to invoke the current CopyGroup again (default). This causes printing to
end on the current sheet and resume on the front
side of a new sheet.
Select [FIRST] to invoke the first CopyGroup in
the current FormDef.
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Select [NEXT] to invoke the next CopyGroup in
the current FormDef.
Select [NULL] to take no action.
Following [NULL], the short names for all CopyGroups in the currently loaded FormDef display,
for example [NG #1]. CopyGroups are defined in
the CopyGroup Properties dialog box. See the
"FormDef window" chapter for more information.
PageFormat action
Specify a PageFormat to be invoked from the
drop-down list that displays.
Select [CURRENT] to invoke the current PageFormat again. This causes printing to end on the
current sheet and resume on the front side of a
new sheet.
Select [FIRST] to invoke the first PageFormat in
the current PageDef.
Select [NEXT] to invoke the next PageFormat in
the current PageDef.
Select [NULL] to take no action (default).
Following [NULL], the short names for all PageFormats in the currently loaded PageDef display,
for example [NP #1]. PageFormats are defined in
the PageFormat Properties dialog box. See the
"Toolbar and Toolbox" chapter for more
information.
New Form
Select this option to have the printing skip to the
front of a new form and restart the PageFormat.
This option is equivalent to selecting [CURRENT]
from [CopyGroup action] and [NULL] from [PageFormat action].
New Side
Select this option to have the printing skip to a
new side (the front of a new sheet or the back of
the current sheet) and restart the PageFormat.
This option is equivalent to selecting [NULL] from
[CopyGroup action] and [CURRENT] from [PageFormat action].
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Field
Select this option to display the Field Properties dialog
box with options for naming a Field and specifying defaults. The Field name displays to the left of the Properties button in the Toolbox. See the "Toolbar and
Toolbox" chapter for more information.
Delete
Select this option to remove the selected object from
the PageDef tree.

Adding objects to the PageDef tree
Objects are added to the PageDef tree by selecting a
Toolbar option. For example, selecting [+P] adds a
PageFormat to the PageDef that contains the currently selected object.
The following is a hierarchical breakdown of a
PageDef:
PageDef
Font List
PageFormat
TRC Reference List
Segment List
Overlay List
Record*
Floating Segment
Floating Overlay
Field
SubPage
*Conditional logic available
You can easily add PageDef elements by selecting
the appropriate option in the PageDef window Toolbar. For example, selecting [+R] adds a Record to the
PageFormat that contains the currently selected
object.
You can add the following elements:
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PageFormats
There are two ways to add a PageFormat. You can
click on [+P] in the PageDef window Toolbar to add a
new PageFormat after the currently selected PageFormat or you can manually add a new PageFormat.
To add a new PageFormat manually:
1.

Select an existing PageFormat.

2.

Place the cursor in the Work area, and press
and hold down <Ctrl> and click.

3.

Drag the box and release the mouse button
when you reach the desired PageFormat
outline.
This procedure adds an active PageFormat to the
PageDef window. Any objects in the Work area
prior to this addition are cleared from the screen,
as they belong to the previously selected
PageFormat.

Record
There are two ways to add a Record. You can click
on [+R] in the PageDef window Toolbar to add a Record to the PageFormat. To map the Record, drag
and drop the Record onto the Work area. You can
also manually add a new Record.
To add a new Record manually:
1.

Select a PageFormat or a Record within an
existing PageFormat.
The new Record is added after the selected
object.

9-14

2.

Place the cursor in the Work area, and press
and hold down <Ctrl>.

3.

Click to add a new Record in the cursor
locations.
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This procedure adds an active Record to the current PageFormat in the Work area. You cannot
add Fields to mapped Records.
Field
There are two ways to add a Field. You can click on
[+F] in the PageDef window Toolbar to add a Field to
the selected Record. You must then map the Field.
You can also manually add a new Field.
To add a new Field manually:
1.

Select an existing Field in a Record.
If no Fields exist (and the Record is not mapped),
you can add one by clicking on [+F].

2.

Place the cursor in the Work area, and press
and hold down <Ctrl>.

3.

Click to add a new Field in the cursor location.
This procedure adds an active Field to the current
Record in the Work area.

Viewing element properties
To view the properties of an element in the PageDef
tree, select the item you want and right click or select
[i] from the PageDef Toolbar. Elements available for
viewing include PageDefs, PageFormats, Records,
and Fields. You cannot view SubPage properties in
this manner.

Locating selected Records or Fields
This option works on Fields and on Records without
mapped Fields, and allows you to visually locate an
object in the main Work area.
To locate a Record or Field:
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1.

Place the cursor on the Record or Field you
want to locate in the PageDef.

2.

Press <Shift> and click to select the Record or
Field.
The screen display reformats and the selected
object is displayed and highlighted with arrows.
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FormDef window

This chapter provides a detailed description of the
FormDef window and its features. Where applicable,
references to other chapters or sections in this chapter are given for more detailed information.
Select a menu or sub-menu to display its options, then
select an option from the pull-down menu. Note that
the terms form and overlay are used interchangeably.

FormDef window
To open the FormDef window, pull down the File
menu and select the FormDef sub-menu, then select
[New FormDef] or [Load FormDef]. You can also pull
down the Window menu and select [FormDef] if a
FormDef is already open.
When a FormDef is loaded (Application proofing
mode), the FormDef formatting is applied to the Work
area and displays exactly as the physical sheet is laid
out. The display switches from template mapping
mode (PageDef only) to a representation of the physical sheet. Any form used as a template for a PageDef
is cleared from the screen, with the option to save any
changes made.
The FormDef window displays below the Work area.
and displays the FormDef tree. See the "Adding objects to the FormDef tree" section for more
information.
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FormDef
menu bar

FormDef
Toolbar
FormDef
tree

Figure 10-1. FormDef window
Overview of the features
The following is an overview of the FormDef window
features. This section refers you to other sections in
this chapter where the features are explained in detail.
Menu bar
AppBuilder provides menus and sub-menus to access
FormDef options. FormDef menu bar options are described in the "FormDef menu bar" section and the
"Menu bars" chapter.
Toolbar
The FormDef Toolbar displays across the top of the
FormDef Work area and includes +C, +S, Overlays,
Properties, and Delete. FormDef Toolbar options are
described in the "FormDef Toolbar" section.
FormDef tree
The FormDef tree displays below the FormDef Toolbar and provides a hierarchical breakdown of the elements in the current FormDef. See the "Adding
objects to the FormDef tree" section for more
information.

FormDef menu bar
The FormDef menu bar contains the CopyGroup,
Edit, and View menus.
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CopyGroup
The options in this menu allow you to set the CopyGroup properties and options. See the "Menu bars"
chapter for more information.
Edit
The options in this menu allow you to cut, copy, paste,
and delete FormDef window contents. See the "Menu
bars" chapter for more information.
When you copy a Copygroup, AppBuilder automatically changes the [Short name] of the copy to prevent
two Copygroups from having the same name.
View
The options in this menu allow you to control the column headings in the FormDef window.
CopyGroups
Select this option to set the column headings to display CopyGroup information.
SubGroups
Select this option to set the column headings to display SubGroup information.
Overlays
Select this option to set the column headings to display Overlay information.
None
Select this option to display no column headings.
Expand All <Shift> + <*>
Select this option to expand the FormDef tree.
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Collapse All <Shift> + </>
Select this option to display the FormDef tree with only
the FormDef and CopyGroup names visible.
Window on Top
Select this option to keep the FormDef window on top
in the display.

FormDef Toolbar
The FormDef Toolbar displays across the top of the
FormDef window.

Add
CopyGroup

Add
Overlay

Delete

Figure 10-2.FormDef Toolbar
View

Properties
The FormDefAdd
Toolbar contains
the following options:
SubGroup

+C
Select this option to add a CopyGroup to the
FormDef. All of the formatting parameters specified in
the CopyGroup are applied to the Work area. Whenever you add a CopyGroup, a SubGroup is automatically placed below it.
+S
Select this option to add a SubGroup to the FormDef.

10-4

ELIXIR TECHNOLOGIES CORPORATION

FORMDEF WINDOW

Overlay
Select this option to add an overlay to the current SubGroup from the Add Overlay dialog box that displays.
You must select a SubGroup before you can use this
option. There is a maximum of eight overlays per
SubGroup.

Figure 10-3. Add Overlay dialog box
The Add Overlay dialog box contains the following
options:
Overlay name
Enter an overlay name or select one from the Select
Overlay dialog box that displays from the [Select]
button.
Offset
Horizontal/Vertical
Enter the horizontal and vertical starting points for the
overlay on the physical sheet.
If the overlay already has an offset set in the Form
Properties dialog box, the value displays and is applied to the overlay displayed in the Work area. See
the "Menu bars" chapter for more information.
Offset values specified in the SubGroup Properties
dialog box only affect the overlay display. Offset values for the actual overlays must be applied when the
you convert overlays from Elixir format (.ELX) to .OGL
or .OVE formats. See the Elixir Desktop and Converters for AFP User Guide for more information on converting overlays.
Keep as Raster data
Select this option to store the overlay in the printer as
raster data. This eliminates the need for the printer to
reload the overlay every time it is used.
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Properties
Select this option to display the properties of a selected object in the FormDef tree.
The following objects are available for viewing:
FormDef
CopyGroup
SubGroup
Overlay
See the "Viewing element properties" section for more
information.
FormDef
Select this option to display the FormDef Properties
dialog box with options for naming a FormDef and
specifying defaults. See the "Menu bars" chapter for
more information.
CopyGroup
Select this option to display the CopyGroup Properties
dialog box with options for naming a CopyGroup and
specifying defaults.

Figure 10-4. CopyGroup Properties dialog box
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The CopyGroup Properties dialog box contains the
following options:
CopyGroup name
Enter a reference name for your CopyGroup.
This name displays in the FormDef tree.
Short name
Enter a name having 1-8 alphanumeric characters. This is the CopyGroup name that is written
to the PPFA/FormDef object at conversion time.
When you copy a CopyGroup, AppBuilder automatically changes the short name of the copy to
prevent two CopyGroups from having the same
name.
CopyGroup Description
Enter descriptive text here for the job to help you
identify later how the job was created. This text is
written as a comment line in the generated PPFA.
Duplex printing
Select [Simplex] to print on one side of the paper.
Select [Normal] to print on both sides of the paper
in portrait orientation, with the top of the logical
page on each side toward the same edge of the
sheet.
Select [Tumble] to print the reverse side of the
duplex page in portrait orientation, with the top of
the logical page on the front side towards the
same edge of the sheet as the location of the logical page on the back side.
Select [RTumble] to print the reverse side of the
duplex page in landscape orientation, with the top
of the logical page on the front side towards the
same edge of the sheet as the location of the logical page on the back side.
Select [RNormal] to print on both sides of the paper in landscape orientation, with the top of the
logical page on each side toward the same edge
of the sheet.
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Constant Form
Select [No] to turn the constant form function off.
Select [Front] to print a constant form on the front
side without variable data.
Select [Back] to print a constant form on the back
side without variable data.
Select [Both] to print a constant form on both
sides without variable data.
Presentation
Select [Portrait] to have the pages printed with the
short edges at the top and bottom and the long
edges along the sides.
Select [Landscape] to have the pages printed with
the long edges at the top and bottom and the
short edges along the sides.
Use N_UP
This option allows you to specify whether or not
you want to print more than one logical page on
the same side of a physical sheet.
Select [Default] to deactivate this option.
Select [Basic] to activate this option.
N_UP_Type
This option is available only when [Basic] is selected under [Use N_Up] and allows you to specify the number of logical pages to be placed on
one side of a physical sheet. Select a value from
1-4 from the drop-down list that displays.
The value selected causes the sheet to be equally
divided into the number of logical pages specified.
The [Preview] option displays, showing the logical
page placement on the physical sheet. This layout is based on the [Printer Type selection] and
[Physical Sheet dimension] options set in the
Proofing Properties dialog box. See the "Menu
bars" chapter for more information.
Next Page place on
For future implementation.
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Overlays
Select this button to display the Overlays for Basic N_UP dialog box with options for selecting an
overlay. This option is available only when [Basic]
is selected in [Use N_UP]. See the "Menu bars"
chapter for more information.
Preview
This option is available only when [Basic] is selected in [Use N_UP] and displays the [Direction]
and the [N_UP_Type] selected.
This layout is based on the [Printer Type selection] and [Physical Sheet dimension] options set
in the Proofing Properties dialog box. See the
"Menu bars" chapter for more information.
Date/Time
This option displays the dates and times that the
file was originally created and last opened.
Data Offset
Horizontal/Vertical
Enter the horizontal and vertical coordinates for
the printing start points of the first line of data on
both the front and back sides of the paper. These
values are the distances from the upper left hand
corner (0,0) of the sheet.
PostProcessing
Select [Default] to process the CopyGroup with
the defaults set in the FormDef Properties dialog
box. See the "Menu bars" chapter for more
information.
Select [Set] to display the CopyGroup PostProcessing Options dialog box which allows you
to set post processing defaults for the current
CopyGroup.
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Figure 10-5. CopyGroup PostProcessing Options
dialog box
The CopyGroup PostProcessing Options dialog box
contains the following options:
Media Info
Select [Select a particular fixed medium local
ID's] and specify one or more ID's from the
scrollable list to select a particular fixed medium
local ID for the printer to apply to a sheet, or select [Use all the current fixed medium local
ID's].
Media Info
Select [Select a particular fixed medium local
ID's] and specify one or more ID's from the
scrollable list to select a particular fixed medium
local ID for the printer to apply to a sheet, or select [Use all the current fixed medium local
ID's].
Perforation Cut at Fixed Locations
Select this option to specify a perforation cut at
one or more fixed locations on the sheet.
Separation Cut at Fixed Locations
Select this option to specify a separation cut at
one or more fixed locations on the sheet.
Bin
Enter the bin number for the paper source or
click on the button to the right of the Bin text
box to select a bin from the drop-down list:
Select [1] to use the primary paper source.
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Select [2-10] to use another paper source. If the
specified bin does not exist, the default paper
source for the printer is used.
Select [Man] to manually feed the paper. For
more
information,
see
your
printer
documentation.
Quality
Enter the number for print quality or click on the
button to the right of the Quality text box to select
a number from the drop-down list that displays.
Higher numbers correspond to higher levels of
print quality.
more than one level of print quality; the default is
determined by the printer model. For more information, see your printer's documentation.
Adjust
Enter a number (from 0-20 L-units) that specifies
the range of horizontal adjustment for the print
area. After you set a value, it is the maximum
amount available in both directions, plus and
minus.
The maximum logical page size (in the horizontal
direction) is reduced by the amount specified in
this option.
Jog
Select [Jog] to offset stack between CopyGroups
on cut-sheet page printers. For continuous-form
printers, printing marks are placed on the sheets
to indicate breaks between CopyGroups.
SubGroup
Select this option to display the SubGroup Properties
dialog box with options for naming a SubGroup and
specifying defaults.
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Figure 10-6. SubGroup Properties dialog box
The SubGroup Properties dialog box contains the following options:
CopyGroup name
Displays the name of the associated CopyGroup.
SubGroup name
Enter a name for the SubGroup.
Suppressions
Suppression name
Enter the suppression name for the Field(s) to be
suppressed. Suppression names are defined in
the Field Properties dialog box. See the "Toolbar
and Toolbox" chapter for more information.
Suppressions
Add
Select this option to add the Field to the group of
Fields to be suppressed.
You can add up to
eight Fields per SubGroup.
Suppressions
Remove
Select this option to remove the name displayed
in [Suppression name] from the group to be
suppressed.
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Sheet side
This option allows you to specify to which side(s)
of a sheet of paper to apply the SubGroup.
Select [Front] for the front side of the sheet.
Select [Back] for the back side of the sheet.
Select [Both] for both sided of the sheet.
You must specify [Front] or [Back] if an overlay,
suppression, or flash appears on one side, but
not the other. [Front] and [Back] SubGroups
must occur in pairs and have the same number of
copies.
Copies
Enter the number of copies of each page to be
printed (maximum = 255).
Flash
Select this option to use forms flash. When using
forms flash, the forms flash name must be specified in the JCL for the print job.
Bin
Enter the bin number for the paper source or click
on the button to the right of the Bin text box to select a bin from the drop-down list:
Select [1] to use the primary paper source.
Select [2-10] to use another paper source. If the
specified bin does not exist, the default paper
source for the printer is used.
Select [Man] to manually feed the paper. For
more
information,
see
your
printer
documentation.
Overlay
Select this option to display the Overlay Properties
dialog box with options for naming an overlay and
specifying defaults.
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Figure 10-7. Overlay Properties dialog box
The Overlay Properties dialog box contains the following options:
Overlay name
Enter an overlay name or select one from the Select Overlay dialog box that displays from the [Select] button.
Offset
Horizontal/Vertical
Enter the horizontal and vertical starting points for
the overlay on the physical sheet.
Keep as Raster data
Select this option to store the overlay in the
printer as raster data. This eliminates the need
for the printer to reload the overlay every time it is
used.
Delete
Select this option to remove the selected object from
the FormDef tree.

Adding objects to the FormDef tree
Objects are added to the FormDef tree by selecting a
Toolbar option. For example, selecting [+C] adds a
CopyGroup to the FormDef that contains the currently
selected object.
The following is a hierarchical breakdown of a
FormDef:
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FormDef
CopyGroup
SubGroup
Overlays
You can easily add FormDef elements by selecting
the appropriate option in the FormDef window Toolbar. For example, selecting [+S] adds a SubGroup to
the currently selected CopyGroup.
You can add the following elements:
CopyGroup
To add a CopyGroup, click on [+C] in the FormDef
window Toolbar. This adds an active CopyGroup to
the FormDef window with the defaults set in the
FormDef Properties dialog box. Any formatting applied by a previously-selected CopyGroup (for example, overlays, data offsets) is cleared from the Work
Area and settings for the new CopyGroup are applied.
See the "Menu bars" chapter for more information.
SubGroup
To add a SubGroup, click on [+S] in the FormDef window Toolbar. This adds an active SubGroup to the
current CopyGroup in the Work area.
Overlay
To add an overlay to the currently selected SubGroup:
1.

Click on [Overlay] in the FormDef window
Toolbar.
The Add Overlay dialog box displays. See the
"FormDef Toolbar" section for more information.

2.

Enter the name of the overlay to add.

3.

Click on [OK].
The overlay is added.
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Creating new overlays
To create a new overlay:
1.

Select a SubGroup in the FormDef window.

2.

<Shift>-click on [Overlay] in the FormDef
window Toolbar.
The Create new Overlay dialog box displays.

Figure 10-8. Create new Overlay dialog box
The Create new Overlay dialog box contains the
following options:
Overlay name
Enter a name for the new overlay (maximum 6
characters).
Offset
Horizontal/Vertical
Enter the horizontal and vertical starting points for
the overlay on the physical sheet.
If the overlay already has an offset set in the
Form Properties dialog box, the value displays
here and is applied to the overlay displayed in the
Work area. See the "Menu bars" chapter for
more information.
Offset values specified in the SubGroup Properties dialog box only affect the overlay display.
Offset values for the actual overlays must be applied when you convert the overlay from Elixir format (.ELX) to .OGL or .OVE formats. See the
Elixir Desktop and Converters for AFP User
Guide for more information on converting
overlays.
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Keep as Raster data
Select this option to store the overlay in the
printer as raster data. This eliminates the need
for the printer to reload the overlay every time it is
used.
3.

Set the appropriate options in the Create
Overlay dialog box and click on [OK].
The Form Properties dialog box displays. See
the "Menu bars" chapter for more information.

4.

Select the appropriate options in the Form
Properties dialog box and click on [OK].
The Form Databasing dialog box displays. See
the "Menu bars" chapter for more information.

5.

Set the appropriate options in the Form
Databasing dialog box and click on [OK].
The new overlay is added to the selected SubGroup in the FormDef tree.

Viewing element properties
To view the properties of an element in the FormDef
window, select the item you want and right click or select [i] from the FormDef Toolbar. Elements available
for viewing include FormDefs, CopyGroups, SubGroups, and overlays.
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11. Importing and Exporting

This chapter provides information on importing and
exporting PPFA and object PageDefs and FormDefs.
AppBuilder's databasing feature is also explained.

Overview
AppBuilder provides facilities for importing and exporting PPFA and object PageDefs and FormDefs (compiled resources).
Elixir-format PageDefs and FormDefs can also be
saved to and loaded from a set of database files
separate from the working AppBuilder database, for
backup or archival purposes.

Importing PPFA
When coming from an IBM S/370 host
(MVS/VM/DOS-VSE), the files must be transferred as
text files (EBCDIC to ASCII translation), with CRLF
embedded.
To import existing PPFA files into AppBuilder:
1.

Remove any JCL or other non-PPFA
statements from the file before importing it.
You do not have to remove PPFA comments and
sequence numbers in the last 8 columns (typically
72-80). You can include PageDef and FormDef
source in a single file or in separate files.

2.

Download the PPFA source files to the PC
with the file transfer capabilities of a terminal
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emulation package, or via network file transfer
facilities (in a LAN environment).
AppBuilder
searches
for
files
in
drive:\ELIXIR\JOBS\PPFAIN, by default. Downloading your files to this directory with .SRC extensions is recommended. However, you can
download the files to any directory, with any
name, and with or without an extension.
3.

Pull down the File menu, select the Convert
sub-menu and select [Import].
The Import Options dialog box displays. See the
"Import Options dialog box" section for more
information.

4.

Select your options and click on [OK].
A window(s) displays the available resource(s).

Saving converted resources
To save the converted resources to the AppBuilder
database, pull down the File menu, select the
PageDef or FormDef sub-menu and select [Save] or
[Save As].
Select [Save] to save the resource using the long
name and short name specified in the PageDef or
FormDef Properties dialog boxes. See the "Menu
bars" chapter for more information.
Select [Save As] to change the long name the file is
saved under. The short name remains as specified in
the PageDef or FormDef Properties dialog boxes.
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Exporting PPFA and PageDef/FormDef objects
To create PPFA
PageDef/FormDefs
PageDef/FormDef:

source
from

code
an

or object
AppBuilder

1.

Load the resources into the active AppBuilder
session.

2.

Pull down the File menu, select the Convert
sub-menu and select [Export].
The Export Options dialog box displays. See the
"Export Options dialog box" section for more
information.

3.

Transfer the files to the host or server
containing the PageDef and FormDef libraries.
You must upload PPFA files to an S/370 host using ASCII-to-EBCDIC translation. See your Elixir
Desktop and Converters for AFP User Guide for
more information on file transfer procedures for
several terminal emulation packages.

For uploading object PageDef/FormDef files to an
S/370 host:
For VBM, upload the file as a BINARY file with
CRLF.
For IRMA, OS/2, or DOS/VSE, upload the file as
a BINARY file (no CRLF).
Import Options dialog box
Import
This option displays the Import Options dialog box
which allows you to select a source file and specify
prefix options.
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Figure 11-1. Import Options dialog box
The Import Options dialog box contains the following
options:
Source Format
Select [PPFA] to import a PPFA source file, or
[AFPDS] to import object PageDefs/FormDefs
(compiled resources).
Source File Path
Displays the path for the source file specified in
[Source File Name].
Source File Type
This option allows you to selectively import
PageDefs and/or FormDefs from a file containing
both types of resources. This option does not apply to files containing a single resource.
Select [PageDef] to only import the PageDef.
Select [FormDef] to only import the FormDef.
Select [Both] to import both the PageDef and
FormDef.
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Overlay Name Prefix Option
This option allows you to specify the naming convention to use for form/overlay references when
you import the source into AppBuilder.
Select [01 Prefix] to reference forms/overlays using an 01 prefix.
Select
[No
AFP
Prefix]
to
forms/overlays without an 01 prefix.

reference

Font Name Prefix Option
This option allows you to specify the naming convention for font callout(s) when you import the
source into AppBuilder.
Select [Universal X0 Prefix] to add an X0 AFP
prefix to the font callout(s) in your AppBuilder
components.
Select [Separate Prefixes (X1 to X4)] to add X1,
X2, X3, or X4 prefixes to the font callout(s). The
prefix added depends on the text direction.
Select [No AFP Prefix] to have no prefix preceding your font callout(s).
(AFPDS only) Select [Create TRC table] to create
a table reference character list (TRCREF).
(AFPDS only) Select [Use Default Font] to use the
default font for records/fields in imported AFPDS
when no font is specified.
Segment Name Prefix Option
This option allows you to specify the naming convention for page segment callout(s) in the
AppBuilder components.
Select [S1 Prefix] to reference page segments
with an S1 prefix.
Select [No AFP Prefix] to create references without an S1 prefix.
Source File Format
Sequence Numbers
Select this option if the last eight characters of the
source file are sequence numbers.
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Source File Format
Record Format
Select [Fixed] for source files that contain fixedlength records.
Select [Variable] for source files that contain
variable-length records. The variable length records must have CRLF (carriage return line feed)
at the end of each record.
Source File Format
Record Length
Enter the source file record length. The default is
80.
Export Options dialog box
Export
This option displays the Export Options dialog box
which allows you to select an output file format.

Figure 11-2. Export Options dialog box
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Note: The grid setting measurement unit default is in
inches. Select [CM] if you want to use a metric grid
setting.
The Export Options dialog box contains the following
options:
Output Format
This option allows you to specify the output format
type.
Select [PPFA] for PPFA source code output.
Select [AFPDS] to create the object (compiled)
PageDef/FormDef file type selected in the dropdown list:
Select [VBM] to format the file for uploading to
S/370 hosts using IBM 3270-compatible terminal emulation packages.
Select [IRMA] to format the file for uploading to
S/370 hosts using IRMA FT/TSO and compatible emulation packages.
Select [AS/400] to format the file for transfer to
an AS/400. Files contain fixed length 1024-byte
records with padding.
Select [OS/2] to format the file for use in a
PSF/2 or RS/6000 environment.
Select [MO:DCA] to format the file for
MO:DCA-compatible receivers.
This option
eliminates the x'5A' carriage control prefix required for S/370 spooled environments.
See your Elixir Desktop and Converters for AFP
User Guide for more information on file transfer.
Output File Format
Record Format
Select [Fixed] to create fixed-length PPFA source
files.
Select [Variable] for variable length PPFA source
files.
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Output File Format
Record Length
Enter the output file record length for the PPFA
source file.
Make FormDef
Output File Name/Internal Name
This option is only available when a FormDef is
loaded. Select this option to create a new
FormDef with the parameters specified in this dialog box.
Enter the name of the DOS file to be created in
the conversion in the [Output File Name] text box.
Enter the name of the FormDef that is generated
when the PPFA source is compiled in the [Internal
Name] text box.
The [Internal Name] is the actual host FormDef
name (maximum 6 characters). An F1 prefix is
added to the FormDef during compilation.
Make PageDef
Output File Name/Internal Name
This option is only available when a PageDef is
loaded. Select this option to create a new
PageDef with the parameters specified in this dialog box.
Enter the name of the DOS file to be created in
the conversion in the [Output File Name] text box.
Enter the name of the PageDef that is generated
when the PPFA source is compiled in the [Internal
Name] text box.
The [Internal Name] is the actual host PageDef
name (maximum 6 characters). A P1 prefix is
added to the PageDef during compilation.
Options
The availability of the following options is dependent upon whether [Make FormDef], [Make
PageDef] or both options are selected.
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Replace Host Version
Select this option to place the REPLACE=YES
option in the PPFA. This tells the host PPFA
compiler to replace an existing PageDef/FormDef
member with the newly compiled member.
Append PageDef to FormDef
(PPFA only) Select this option to place PageDef
and FormDef source code into a single DOS file
(.SRC).
Generate Comments
Select this option to place comments in the
PPFA source code. Comments include record
and field names, as well as descriptive
information.
Generate Sequence Numbers
Select this option to place sequence numbers in
columns 72-80 of the PPFA source file.
ANSI Carriage Control
Select this option to include the ANSI CC setting
from a CONDITION in the output file. For
PPFA, a SPACE_THEN_PRINT command is
written. For object PageDef, a flag is set in the
parameters for conditional logic.
This selection is included for backward compatibility. Activating this option requires your host to
have a minimum of IBM PPFA Version 1 Release 1 and a compatible version of PSF. See
your IBM licensed program documentation for
more information.
PPFA Color Support
Select this option to enable color printing. This
option is recognized only by printers that support
color printing. See your printer documentation
for more information.
Repeat Field Support
Select this option to include the FIELD/LINE parameter of the record (PRINTLINE) in the output
file.
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Suppress Font References
Select this option to suppress callouts to the
master font list set in the Font List dialog box.
See the "Toolbar and Toolbox" chapter for more
information.
Use Coded Font Name
Uses the coded font name to reference fonts
during a conversion to PPFA.
When unselected, fonts are referenced using
their character set/code page. When using
Elixir fonts or when the coded font (.CDF) file is
not found, AppBuilder generates the character
set name using the font name, and uses the
current system default code page.
Presentation Support
Select this option to include the PRESENT and
DIRECTION subcommand information in the
This selection is included for backward compatibility. Activating this option requires your host to
have a minimum of IBM PPFA Version 1 Release 1 and a compatible version of PSF. See
your IBM licensed program documentation for
more information.
Adjust Support
Select
this
option
to
include
the
FORMDEF/COPYGROUP ADJUST parameter
in the output file.
Processing Support
Select this option to enable the PostProcessing
options set in the FormDef Properties dialog
box. See the "Menu bars" chapter for more
information.
This selection is included for backward compatibility. Activating this option requires your host to
have a minimum of IBM PPFA Version 1 Release 1 and a compatible version of PSF. See
your IBM licensed program documentation for
more information.
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Quality Support
Select
this
option
to
include
the
FORMDEF/COPYGROUP QUALITY parameter
in the output file. See the "FormDef properties"
section in the "Menu bars" chapter for more information on this option.
Flash Support
Select
this
option
to
include
the
FORMDEF/COPYGROUP FLASH parameter in
the output file. When using forms flash, you
must specify the forms flash file name in the
JCL for the print job.
Invoke Support
Select
this
option
to
include
the
FORMDEF/COPYGROUP INVOKE parameter
(used in N_Up processing) in the output file.
This selection is for backward compatibility. Activating this option requires your host to have a
minimum of IBM PPFA Version 1 Release 1 and
a compatible version of PSF. See your IBM licensed program documentation for more
information.
N_Up Support
Select this option to include N_Up parameters in
the output file.
Select [Default] to use the N_Up parameters set
in the FormDef Properties dialog box. See the
"Menu bars" chapter for more information.
Select [Basic] to activate this option.
This selection is included for backward compatibility. Activating this option requires your host to
have a minimum of IBM PPFA Version 1 Release 1 and a compatible version of PSF. See
your IBM licensed program documentation for
more information.
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IMPORTING AND EXPORTING

Databasing
AppBuilder's databasing feature allows you to store
Elixir-format PageDefs and FormDefs in a database
separate from the working database AppBuilder uses.
This allows you to create backup or archival copies of
resources and simplifies the moving of resources from
one machine to another. This option automatically
creates the new database in any directory you choose.
To simplify moving or copying an alternate AppBuilder
database,
you
should
use
a
unique
directory/subdirectory for the new database. By doing
so, only those files that you create in the new subdirectory need to be moved/copied to the target location. Database files you create have .DBF and .CDX
extensions.
Importing a PageDef/FormDef
To import a PageDef or FormDef from an existing alternate database:
1.

Pull down the File menu, select the
Databasing sub-menu and select [Import
PageDef] or [Import FormDef].
The Select Database Path dialog box displays.
See the "Menu bars" chapter for more
information.

2.

Enter the directory path and click on [OK].
The Load PageDef or Load FormDef dialog box
displays the PageDefs or FormDefs in the
database.

3.

Select the PageDef or FormDef you want to
load and click on [OK].
A list of the PageDef or FormDef resources in
that database displays.

4.

Select the desired resource and click on [OK].
The resource is loaded into AppBuilder.
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Exporting a PageDef/FormDef
To export a PageDef or FormDef:
1.

Load the
AppBuilder.

PageDef

or

FormDef

into

2.

Pull down the File menu, select the
Databasing sub-menu and select [Export
PageDef] or [Export FormDef].
The Select Database Path dialog box displays.
See the "Menu bars" chapter for more
information.

3.

Enter the target directory and click on [OK].
If you have already created an existing alternate
database, the current resource is exported into
that database. If no database exists, AppBuilder
creates one for you and the current resource is
exported there.
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+C, 10-4
+F, 9-5
+P, 9-4
+R, 9-4
+S, 9-4, 10-5

A
Acrobat Reader, documentation, 1-10
Add Overlay dialog box,
4-15, 10-5
AFP overview, 2-1
AppBuilder
basics, 2-1
menu bar, 4-1
overview, 1-1, 2-2
Preferences, 4-29
starting, 1-25
Toolbar, 3-1
Toolbox, 3-7
window, 2-4
AppBuilder menu bar,
4-1
File menu, 4-1
Help, 4-10
System menu, 4-6
Window menu, 4-10

B
Basics, 2-1
Boilerplate, 2-3
Box tool, 3-13
Boxes
drawing, 6-2
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specifying boundaries, 7-4
Bubble Help, 1-9

C
Changing
font location, 7-12
line attributes, 5-5
line length, 5-3
shape attributes, 6-4
shape size, 6-3
text attributes, 7-10
Circle tool, 3-15
Circles, drawing, 6-2
Color, 2-9
Condition sub-menu,
4-13
Conditional Logic, 9-5
dialog box, 9-8
properties, 9-8
Context sensitive Help,
1-9
Conventions, 1-6
conventions
mouse, 1-7
Convert sub-menu, 4-4
Converted resources
saving, 11-2
Copy, 4-16
CopyGroup
adding to FormDef
tree, 10-15
editing, 3-7
properties, 10-6
show/hide, 3-7
viewing properties,
10-17
INDEX-1

INDEX

CopyGroup menu, 4-14,
10-3
CopyGroup submenu, 4-14
Edit menu, 10-3
New Overlay, 4-15
SubGroup submenu, 4-15
Suppression submenu, 4-15
View menu, 10-3
CopyGroup PostProcessing Options dialog box, 10-10
CopyGroup Properties
dialog box, 10-6
CopyGroup sub-menu,
4-14
Copying
elements, 5-6
images, 8-3
lines, 5-6
shapes, 6-5
text, 7-16
Create new Overlay dialog box, 10-16
Creating
FormDefs, 2-21
forms, 2-4
overlays, 10-16
PageDefs, 2-20
PPFA source code,
11-3
Current object - Coordinates, 3-1
Current object - Dimensions, 3-2
Current object - Shape,
3-1
Customer support, 1-3
training, 1-4
customer support, 1-3
Cut, 4-16

D
Data Mapping, 3-40,
3-41
INDEX-2

Data Tags, 3-20
inserting, 7-10
Databasing, 11-12
Databasing sub-menu,
4-5
default installation
first time, 1-22
Defining form groups,
2-12
Delete, 4-17
Delete All, 4-17
Delete Form dialog box,
4-2
Delete FormDef dialog
box, 4-4
Delete PageDef dialog
box, 4-3
Deleting
elements, 5-8
forms, 2-14
images, 8-4
lines, 5-8
shapes, 6-7
text, 7-17
Desktop
installation, 1-21
dialog box
Find Text, 4-17
Replace text, 4-18
Template Options,
4-45
Dialog box Help, 1-10
Dialog boxes
Add Overlay, 4-15,
10-5
Conditional Logic,
9-8
CopyGroup PostProcessing Options,
10-10
CopyGroup Properties, 10-6
Create new Overlay,
10-16
Delete Form, 4-2
Delete FormDef, 4-4
Delete PageDef, 4-3
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Export Options, 4-4,
11-6
Field Properties,
3-39
Filing Options, 4-7
Floating Overlay,
4-13
Floating Segment,
4-12
Font List, 3-34
FormDef PostProcessing Options,
4-24
FormDef Properties,
4-3
Grid Setting, 3-3
Import Options, 4-4,
11-3
Import Text, 4-5
Line Data Overlays,
4-12
Load Condition,
4-13
Load CopyGroup,
4-14
Load Form, 4-1
Load Form Group,
4-2
Load Form Template, 4-2
Load FormDef, 4-4
Load Image, 8-1
Load PageDef, 4-3
Load PageFormat,
4-11
Load Record, 4-12
Load SubGroup,
4-15
Overlay Properties,
10-13
Overlays for Basic
N_Up, 4-26
Page Databasing,
4-35
Page Properties,
4-33
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Page Segments,
3-29, 4-11, 9-7
PageDef Properties,
4-3
PageFormat Properties, 3-24
Preferences, 4-29
Print, 2-15
Proofing Properties,
4-28
Record Properties,
3-32
Rename/Move
Form, 4-2
Ruler Options, 3-2
Save Form As, 4-2
Save Form Group,
4-2
Save FormDef As,
4-4
Save PageDef As,
4-3
Select Active CopyGroup, 4-14
Select Active SubGroup, 4-15
Select Database
Path, 4-5
Select Font, 4-31
Select Overlay, 9-6,
10-5
Select Page Segment, 9-5
Set Active PageFormat, 4-11
Spell Check Options, 4-43
SubGroup Properties, 10-12
Text, 3-36
Text and Font Options, 4-37
TRC Reference Table, 3-27, 4-11
Usage Switches, 4-6
Digital ruler, 3-1
documentation
INDEX-3

INDEX

accessing, 1-11
Acrobat Reader,
1-10
directory, 1-11
navigating, 1-12
printing, 1-13
scrolling, 1-12
using, 1-10
word find, 1-12
zoom in/out, 1-13
DocuMerge, 7-10
DocuTag, 7-10
Drawing
boxes, 6-2
circles, 6-2
lines, 5-2
paths, 6-1
shapes, 6-1

E
Edit CopyGroup, 3-7
Edit menu, 4-16
Copy, 4-16
Cut, 4-16
Delete, 4-17
Delete All, 4-17
Find, 4-17
Find Next, 4-17
Find Previous, 4-17
Paste, 4-16
Redo, 4-16
Replace, 4-18
Select All, 4-17
Undo, 4-16
Unselect All, 4-17
Edit PageFormat, 3-7
Editing
elements, 2-11
images, 8-2
lines, 5-3
shapes, 6-3
text, 7-10
Elements
adding, 2-9
copying, 5-6
deleting, 5-8
INDEX-4

editing, 2-11
excluding, 2-13
grouping, 2-12
moving, 5-7
shifting, 2-11
viewing properties,
9-16, 10-17
Elixir applications
conventions, 1-6
Help, 1-9
Elixir HP print driver,
2-18
Elixir Web site support,
1-4
ElixirForm overview, 2-3
Entering text from the
keyboard, 7-1
Exiting, 1-26, 4-6
Export Options dialog
box, 4-4, 11-6
Exporting
FormDefs, 11-3,
11-13
PageDefs, 11-3,
11-13
PPFA, 11-3

F
Field
locating, 9-16
properties, 3-39,
9-13
tool, 3-39
viewing properties,
9-16
Field Properties dialog
box, 3-39
File menu, 4-1
Convert sub-menu,
4-4
Databasing submenu, 4-5
Exit, 4-6
Form Group submenu, 4-2
Form sub-menu, 4-1
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FormDef sub-menu,
4-3
Import Text, 4-5
PageDef sub-menu,
4-3
Print, 4-5
Filing Options, 4-7
Filing Options dialog
box, 4-7
Find Text dialog box,
4-17
Floating Overlay, 9-6
Floating Overlay dialog
box, 4-13
Floating Page Segment,
9-5
Floating Segment dialog
box, 4-12
Font
adding multiple
fonts, 7-12
changing, 7-11
changing location,
7-12
loading, 2-17
loading a Font List,
7-7
merging font lists,
7-7
replacing, 7-13
saving custom lists,
7-8
selection, 7-6
Font List, 3-34, 7-6
adding a font, 7-7
deleting a font, 7-7
properties, 9-7
Font List dialog box,
3-34
Form, 4-10
adding elements,
2-9
color, 2-9
creating, 2-4
deleting, 2-14
design, 2-4
editing elements,
2-11
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excluding elements,
2-13
grouping elements,
2-12
loading new form,
2-5
loading saved
forms, 2-6
modifying, 2-11
moving, 2-14
new form, 2-4
printing, 2-15
renaming, 2-14
reproducing, 2-5
saving, 2-10
shifting elements,
2-11
template, 2-7
form
template defaults,
2-8
Form Databasing, 4-35
Form Group sub-menu,
4-2
Form groups
defining, 2-12
merging, 2-7
saving, 2-13
Form Properties, 4-33
Form sub-menu, 4-1
FormDef, 4-10
creating, 2-21
exporting, 11-3,
11-13
hierarchical breakdown, 10-14
importing, 11-12
menu bar, 10-3
properties, 10-6
Toolbar, 10-4
viewing properties,
10-17
window, 10-1
FormDef menu bar, 10-3
CopyGroup menu,
10-3
Delete, 10-14
INDEX-5

INDEX

Properties, 10-6
FormDef PostProcessing Options dialog box,
4-24
FormDef Properties dialog box, 4-3
FormDef sub-menu, 4-3
FormDef Toolbar, 10-4
+C, 10-4
+S, 10-5
Overlays, 10-5
FormDef tree, 10-6,
10-14
adding CopyGroups,
10-15
adding Overlays,
10-15
adding SubGroups,
10-15
FormDef window, 10-1
Free text, 7-5

G
GEM forms, 2-6, 4-31
Graphic ruler, 3-2
Grid, 3-3
Grid Setting dialog box,
3-3
Group filter options, 3-9
Grouping form elements, 2-12

H
Hardware requirements,
1-5
Help, 4-10
Help, on-line, 1-9
Help hypergraphics,
1-10
Help menu, 1-9, 4-10
Help pop-ups and
jumps, 1-10
Hide
CopyGroup, 3-7
PageFormat, 3-7
Toolbox, 3-6
INDEX-6

I
Image tool, 3-22
Images, 8-1
copying, 8-3
deleting, 8-4
editing, 8-2
loading, 8-1
moving, 8-2
Import Options dialog
box, 4-4, 11-3
Import Text dialog box,
4-5
Importing
FormDefs, 11-12
PageDefs, 11-12
PPFA, 11-1
Importing text, 4-5, 7-2
into a box, 7-4
Inserting
data tags, 7-10
text, 7-1
Installation
before installing,
1-15
installation
custom, 1-23
default, 1-22, 1-23
first time installation,
1-21

J
Joining text, 7-14

K
Keyboard shortcuts,
7-24

L
licensing software, 1-15
Line Data Overlays dialog box, 4-12
Line tool, 3-10
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Lines, 5-1
applying color to,
5-2
changing attributes,
5-5
changing length, 5-3
copying, 5-6
deleting, 5-8
displaying, 5-1
drawing, 5-2
editing, 5-3
moving, 5-7
selecting, 5-3
Load Condition dialog
box, 4-13
Load CopyGroup dialog
box, 4-14
Load Form dialog box,
4-1
Load Form Group dialog
box, 4-2
Load Form Template
dialog box, 4-2
Load FormDef dialog
box, 4-4
Load Image dialog box,
8-1
Load PageDef dialog
box, 4-3
Load PageFormat dialog
box, 4-11
Load Record dialog box,
4-12
Load SubGroup dialog
box, 4-15
Loading
Font List, 7-7
fonts, 2-17
form template, 2-7
forms, 2-5
GEM forms, 2-6
images, 8-1
Locating
selected fields, 9-16
selected records,
9-16
Long Crosshair, 3-5
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M
Menu bar
AppBuilder, 4-1
PageDef, 9-2
Merging
font lists, 7-7
Merging form groups,
2-7
Modifying a form, 2-11
mouse, 1-7
Moving
elements, 5-7
forms, 2-14
images, 8-2
lines, 5-7
shapes, 6-6
text, 7-15

N
New Overlay, 4-15
New Subpage, 4-12

O
on-line documentation
accessing, 1-11
Acrobat Reader,
1-10
directory, 1-11
navigating, 1-12
printing, 1-13
scrolling, 1-12
using, 1-10
zoom in/out, 1-13
Options menu, 4-18
AppBuilder Preferences, 4-29
Form Databasing,
4-35
Form Properties,
4-33
GEM Forms Load
Defaults, 4-31
Snap to Grid, 4-19
INDEX-7

INDEX

Spell Check Options, 4-43
Template Options,
4-45
Text/Font Options,
4-37
Overlay
adding to FormDef
tree, 10-15
creating, 10-16
floating, 9-6
properties, 10-13
viewing properties,
10-17
Overlay List
properties, 9-7
Overlay Properties dialog box, 10-13
Overlays for Basic
N_UP dialog box, 4-26
Overview
AFP, 2-1
AppBuilder, 2-2
ElixirForm, 2-3
FormDef window,
10-2
PageDef window,
9-2

P
Page Databasing dialog
box, 4-35
Page Properties dialog
box, 4-33
Page Segment, floating,
9-5
Page Segments dialog
box, 3-29, 4-11, 9-7
PageDef, 4-10
creating, 2-20
exporting, 11-3,
11-13
hierarchical breakdown, 9-13
importing, 11-12
menu bar, 9-2
properties, 9-7
INDEX-8

Toolbar, 9-4
viewing properties,
9-16
window, 9-1
PageDef menu bar
Conditional Logic,
9-5
Delete, 9-13
Edit, 9-3
Floating Overlay,
9-6
Floating Page Segment, 9-5
Pgfmt, 9-2
Properties, 9-6
View, 9-3
PageDef Properties dialog box, 4-3
PageDef sub-menu, 4-3
PageDef Toolbar, 9-4
+F, 9-5
+P, 9-4
+R, 9-4
+S, 9-4
PageDef tree, 9-13
adding Fields, 9-15
adding PageFormats, 9-14
adding Records,
9-15
viewing element
properties, 9-16
PageDef window, 9-1
PageFormat
editing, 3-7
properties, 3-24, 9-7
show/hide, 3-7
viewing properties,
9-16
PageFormat Properties
dialog box, 3-24
PageFormat sub-menu,
4-11
PageFormat tool, 3-23
Paste, 4-16
Path tool, 3-11
Paths, drawing, 6-1
Pgfmt menu, 4-11
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Condition submenu, 4-13
New SubPage, 4-12
PageFormat submenu, 4-11
Record sub-menu,
4-12
PPFA
creating source
code, 11-3
exporting, 11-3
importing, 11-1
Preferences dialog box,
4-29
Print, 4-5
Print dialog box, 2-15,
2-18
Printing, 2-15
disk print file, 2-17
fonts as graphics,
2-17
to disk file, 2-16
printing
documentation, 1-13
Proofing Properties dialog box, 4-28
Properties, 9-6, 10-6
Conditional Logic,
9-8
CopyGroup, 10-6
Field, 9-13
Font List, 9-7
FormDef, 10-6
Overlay, 10-13
Overlay List, 9-7
PageDef, 9-7
PageFormat, 9-7
Record, 9-8
Segment List, 9-7
SubGroup, 10-12
viewing, 9-16, 10-17

Q
Quick Help, 1-9
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R
Record
locating, 9-16
properties, 3-32, 9-8
viewing properties,
9-16
Record Properties dialog
box, 3-32
Record sub-menu, 4-12
Record tool, 3-32
Redo, 3-6, 4-16
registering software,
1-15
Rename/Move Form
dialog box, 4-2
Renaming forms, 2-14
Replace Text dialog box,
4-18
Replacing fonts, 7-13
Requirements
hardware, 1-5
requirements
software, 1-5
Reset to Defaults, 4-9
Ruler Options dialog
box, 3-2

S
Save Configuration, 4-9
Save Form As dialog
box, 4-2
Save Form Group dialog
box, 4-2
Save FormDef As dialog
box, 4-4
Save PageDef As dialog
box, 4-3
Saving
converted resources, 11-2
custom Font Lists,
7-8
form groups, 2-13
forms, 2-10
Screen display, 5-1
INDEX-9

INDEX

Screen refresh, 5-1
Segment List
properties, 9-7
Select Active CopyGroup dialog box, 4-14
Select Active SubGroup
dialog box, 4-15
Select All, 4-17
Select Database Path
dialog, 4-5
Select Font dialog box,
4-31
Select Overlay dialog
box, 9-6, 10-5
Select Page Segment
dialog box, 9-5
Select tool, 3-8
group filter options,
3-9
Selecting
fonts, 7-6
lines, 5-3
shapes, 6-3
Set Active PageFormat
dialog box, 4-11
Shapes
changing attributes,
6-4
changing size, 6-3
copying, 6-5
deleting, 6-7
drawing, 6-1
editing, 6-3
moving, 6-6
selecting, 6-3
shapes
moving changing dimension coordinates, 6-6
moving manually,
6-6
Shifting elements, 2-11
Show CopyGroup, 3-7
Show PageFormat, 3-7
Show Toolbox, 3-6
Snap to Grid, 3-5, 4-19
Soft keyboard, 7-9

INDEX-10

typing extended
characters, 7-9
software registration,
1-15
Specifying box boundaries, 7-4
Spell Check Options dialog box, 4-43
Spell checking, 3-6,
4-43, 7-20
setting defaults,
7-20
using, 7-23
Splitting text, 7-14
Starting AppBuilder,
1-25
Static data, 2-3
Sticky lines, 5-4, 5-8
SubGroup
adding to FormDef
tree, 10-15
properties, 10-12
viewing properties,
10-17
SubGroup Properties
dialog box, 10-12
SubGroup sub-menu,
4-15
support, customer, 1-3
Support, Web site, 1-4
Suppression sub-menu,
4-15
System menu, 4-6
Filing Options, 4-7
Reset to Defaults,
4-9
Save Configuration,
4-9
Usage Switches, 4-6

T
template defaults, 2-8
Template Options dialog
box, 4-45
Text
adding multiple
fonts, 7-12
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boxed, 7-4, 7-5
changing attributes,
7-10
changing fonts, 7-11
copying, 7-16
deleting, 7-17
editing, 7-10
entering from keyboard, 7-1
free, 7-5
importing, 7-2
importing into a box,
7-4
inserting, 7-1
joining, 7-14
keyboard shortcuts,
7-24
moving, 7-15
soft keyboard, 7-9
splitting, 7-14
Text/Font Options, 4-37
Text/Sample Data, 3-36
Text and Font Options
dialog box, 4-37
Text dialog box, 3-36
text import mapping,
4-41
Text tool, 3-17
data tags, 3-20
Tile, 4-10
Toolbar, 3-1
current object - coordinates, 3-1
current object - dimensions, 3-2
current object shape, 3-1
digital ruler, 3-1
edit CopyGroup, 3-7
edit PageFormat,
3-7
FormDef, 10-4
graphic ruler, 3-2
grid, 3-3
long crosshair, 3-5
PageDef, 9-4
redo, 3-6
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show/hide CopyGroup, 3-7
show/hide PageFormat, 3-7
show/hide Toolbox,
3-6
snap to grid, 3-5
spell check, 3-6
undo, 3-6
zoom in/out, 3-6
Toolbox, 3-7, 4-10
Box tool, 3-13
Circle tool, 3-15
Field tool, 3-39
Image tool, 3-22
Line tool, 3-10
PageFormat tool,
3-23
Path tool, 3-11
Record tool, 3-32
Select tool, 3-8
Text tool, 3-17
Tools menu, 4-18
Training, 1-4
TRC Reference Table
dialog box, 3-27, 4-11
Typing extended characters, 7-9

U
Undo, 3-6, 4-16
Unselect All, 4-17
Usage Switches dialog
box, 4-6

V
View menu, 4-18
Collapse All, 9-3,
10-4
CopyGroups, 10-3
Expand All, 9-3,
10-4
Fields, 9-3
None, 9-3, 10-4
Overlays, 10-3
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PageFormats, 9-3
Records, 9-3
SubGroups, 10-3
Window on Top,
9-4, 10-4
Viewing element properties, 9-16, 10-17

W
Window menu, 4-10
Form, 4-10
FormDef, 4-10
PageDef, 4-10
Tile, 4-10
Toolbox, 4-10
Window on Top, 9-4
word find, 1-12
Work area menu bar,
4-11
CopyGroup menu,
4-14
Edit menu, 4-16
Options menu, 4-18
Pgfmt menu, 4-11
Tools menu, 4-18
View menu, 4-18

X
XWIN.log
installation, 1-21

Z
Zoom in/out, 3-6
zoom in/out, 1-13
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